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Welcome to the Vista

What is different about the Vista?

Welcome to the Vista
Welcome to the User Guide for the Jands Vista lighting console. This guide
is intended to give you the information you need to get your Vista up and
running as quickly as possible.
Note that this guide will be regularly updated as enhancements are made
to the Vista. A current version of the manual is available at
www.jandsvista.com.

What is different about the Vista?
You’ll have noticed that the Vista is a bit different to most other consoles
you’ve used. Instead of a keypad, it uses a pen; instead of relying on you
entering hundreds of key combinations, the Vista lets you do everything
visually; instead of representing your show as numbers, the Vista
represents it as events happening over time.
If you’ve seen any of the digital editing software packages for sound and
video that are available these days, the most different aspect of the Vista,
the timeline, will be instantly familiar to you. If not, don’t worry, once you
start using it you’ll pick it up very quickly.
The Vista is different, but that’s what makes it so much easier to use. Once
you’ve read this guide you’ll have enough of an idea of how this console
works to create your first lightshow.

What things are the same as on other consoles?
Apart from the pen and the timeline concept, the Vista contains all the basic
elements of live lighting that you’re familiar with. You’ll find controls for
intensity, colour, beam, gobos and so on; you’ll find libraries of all the
manufacturers’ most popular fixtures to choose from; you’ll find a console
that has the usual faders, buttons and LCD displays.
So don’t worry, the Vista has a lot in common with other consoles – we’ve
taken all the best elements of existing consoles and added a whole new
dimension to them. You’ll soon be right at home with the Vista.

About the generic fixture model
One thing about the Vista that’s not immediately obvious is the ‘generic
fixture model’. What is it? It’s a part of the software that works in the
background and enables all fixtures, no matter what type or manufacturer
to be treated the same way.

Vista User Guide, Version 1.13a

1

Need more information?

Welcome to the Vista

Let’s say you’ve programmed a show using one brand of fixture but need
to replace some of them with a different kind. Normally this would be a
major hassle because you’d have to find a similar fixture then re-program
each and every cue.
With the Vista, you can replace a fixture and you don’t have to do any reprogramming. Why? Because everything you’ve programmed is stored in
generic form rather than as specific DMX channel values. For instance if
you’ve programmed the lights to be Red, the Vista can send that
information to any light and achieve the same colour.
Sure, if you replace a fixture that has colour mixing with a fixture that has a
fixed colour wheel, you won’t expect to get the exact same result, but even
in this case, the Vista will adapt and provide as near a match as the
replacement fixture is capable of.

Need more information?
If you have questions about the Vista or you’d like more information, go to
our website at www.jandsvista.com, or call us on +61-2-9582-0909.
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Setting up the console

Getting started
Setting up the console
Power

Connect the Vista T, I or S series console to any mains supply between 100
and 240vAC. The Vista M series obtains power via the USB port
External displays

You can attach two external displays to the Vista T series consoles using
standard VGA connectors. The screen resolution is 1024x768
Vista I series consoles have connections for one DVI and one VGA
monitor. A DVI – VGA cable can be used if you prefer to use two VGA
monitors. Maximum screen resolution is 2048 x 1536
For Vista S series consoles, monitor configuration will depend on the
configuration of the computer you are using.
Desk Lights

You can attach two Littlelite or equivalent desklights to the Vista T series
console and one to the I and S series consoles.

Switching on
When you switch the console power on or launch the application on your
PC, Vista starts up and displays the opening splash screen:
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Switching on

Getting started

Once it finishes loading the program, Vista displays the main screen:

This screen is a blank canvas, waiting for you to create a new show. To get
started you use the buttons on the toolbar at the bottom of the screen:
This button…

does this…

VISTA

displays the Vista menu where you can load and save
shows, set user preferences, import and export shows
and close down or restart the console.

Patch

displays the Patch window so you can configure your
DMX settings

Console

displays the Console hardware simulation window

Programmer

displays the Programmer window in either Live or
Clip edit mode. The two icons select the programmer
mode as follows:
displays the Programmer Timeline view, which is only
available if you’re editing a clip. If you’re in Live
mode, click the Store button or choose Save from the
File menu to enable this mode.
displays the Fixtures window so you can set up your
lights and make selections for Live control or
Programming.

4

Playback
Control

When you have one or more clips running, this button
displays the Playback control window so you can see
them all at a glance. You can also use this window to
control playback.

Components

Once you’ve saved some Groups, Presets clips, etc this
button displays the Components window where you
can select, modify, duplicate and organize these
components.

Screens

With this button you can select one of the following
overlay screens - normally for display on the external
monitors:

- DMX

Displays the Output window that shows DMX output
values channel by channel

- Output

Displays the Output window that shows you what
each fixture is doing
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Creating and loading shows

This button…

does this…

History

Displays the Programmer History where you can
undo changes and edit clips you’ve been working on

Snapshots

You can record, update and activate snapshots using
the Snapshot selector. Each snapshot stores the exact
state of the playback controls at the time it is created.

Release all

Clicking this button at any time releases all the fixtures
from their current settings as determined by the clips
that are running and returns them to their default
state.

Creating and loading shows
Creating a show
To create a new show at any time, choose the New option from the Vista
menu.

Loading existing shows
To load a show you’ve already created, choose the Load option from the
Vista menu. Vista displays the Open window:

To load a show you’ve previously saved (or loaded into the console using
the import function), find the directory containing it, then click on the
filename to select it and hit the Open button to load it.

Saving shows
To save a show at any time, choose the Save option from the Vista menu.
As with any computer, it’s a good idea to save regularly in case of power
failure.
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Creating and loading shows

Getting started

The first time you save a new show, Vista displays the Save As window:

Type a name for the file and choose the directory in which you want to
save it, then click the Save button. Once you’ve named the file, each time
you choose the Save option from then on, Vista overwrites that file with the
new details without displaying this window.

Automatic backups
Every time you save a show Vista automatically generates a backup file.
Backups have the same name but begin with a tilde (~). You can open
backups in the same way as other files and use them as show files.

Saving copies of shows
To save a separate version of a show with a different name, choose the
Save As… option from the Vista menu. You can then give the file another
name and save it in another directory if you like.

Password-protecting your show file
To protect your show from changes choose the Lock/Unlock… option from
the Vista menu. Once you’ve assigned a password to the show you have to
enter the password to over-write that file.

Importing shows
You can load shows you’ve created on a PC or another console onto the
Vista. The shows must be on a CD or any kind of storage device that
connects to the Universal Serial Bus (USB) port (such as a memory stick).
To load a show, attach the USB device or put the CD in the CD drive (if
available) and choose the Import option from the Show menu. Choose
either the CD or USB option from the pop-up menu to display an Open
screen, then choose the show file you want to load.
Once you’ve loaded the show you should use the Save option from the
Show menu to save it onto the Vista hard drive immediately.

6
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Exporting shows (backing up)
It’s extremely important to make backup copies of your shows. Like any
other computer, the Vista stores your shows on a hard drive, and although
it’s extremely unlikely, if this drive were to fail (e.g. if the console was
dropped) you could lose all the show files stored on it.
For this reason we recommend that you make regular backups of your
work, either onto CD or onto a storage device that you can connect via a
USB port. The Vista T series consoles include a CD burner so you can burn
backup copies of your show files onto CD at any time. On S series consoles
backup options will depend on the computer being used.
T Series

To copy shows onto CD or an external storage device:
1.

Put a blank CD into the CD drive or connect the device to the USB
port.

2.

Choose the Export option from the Show menu.

3.

Choose either the CD or USB option from the pop-up menu to display
the Save As… window.

4.

Name the file, choose a directory on the CD or storage device and hit
the Save button.

I Series

To copy shows onto an external storage device:
1.

Connect a USB Flash drive or external disk to the USB port.

2.

Choose the Export option from the Show menu.

3.

Choose the USB option from the pop-up menu to display the Save
As… window.

4.

Name the file, choose a directory on the storage device and hit the
Save button.

M and S Series

To copy shows onto CD or an external storage device:
1.

Choose the Export option from the Show menu.

2.

Select the show file to copy (Vista automatically selects the show you
are working on).

3.

Name the file, choose a directory on the computer or storage device
and hit the Save button.

4.

If your computer includes a CD burner and software you can burn this
file to a CD.
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Creating and loading shows

Getting started

Deleting shows
To delete a show, choose the Load… option from the Vista menu, then
right-click on the show name and choose ‘Delete’ from the popup menu.

8
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Creating and loading shows

Patching your rig
Once you’ve got everything connected to the console you can patch all the
fixtures the way you want them using Patch screen.
When you click the Patch button on the toolbar for the first time, Vista
displays the Connect Universes screen:

You use this screen to connect external Ethernet-DMX interface boxes see
Configuring external Ethernet-DMX interfaces - Page 27 for details). If you
aren’t using any external DMX boxes, you don’t need to adjust any of these
settings, just click Close to display the Patch screen.
Tip:

You can also display the Connect Universes screen at any time while on the
Patch screen by pressing the Connect Universes button on the toolbar at the
top of the screen.
When you close the Universe Setup screen, Vista displays the Patch screen:
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Adding fixtures to the patch

Patching your rig

This is where you set up all the fixtures in your rig. You tell the Vista which
DMX channels each fixture is assigned to, and in which universe, and can
set a range of parameters to control how each fixture operates.

Adding fixtures to the patch
The Fixture Type box in the top-left corner of the screen gives you a few
ways to add fixtures to the patch. You can:

•

choose a fixture from the ‘New’ list, which includes the most up to date
fixtures in the Vista library.

•

choose a fixture from the ‘All fixtures’ list, which includes all original
fixtures and lists them in alphabetical order

•

choose a fixture from the ‘By manufacturer’ list, which lists all original
fixtures by manufacturer and then in alphabetical order

•

choose a fixture from the ‘Recent’ list, which lists the last 10 fixtures
types that you’ve patched.

Choosing a fixture from the New list
To add a fixture from the New list, click the ‘+’ symbol beside ‘New’ in the
Fixture Type box. Vista displays an ‘All’ folder and a list of manufacturer’s
folders.

Choosing a fixture from the complete list
To add a fixture from the complete list, click the ‘+’ symbol beside ‘All
fixtures’ in the Fixture Type box. Vista displays the complete list of fixtures
available:

Scroll down the list until you find the fixture you want.

Choosing a fixture by manufacturer
If you click ‘By manufacturer’ instead, Vista displays the list of
manufacturers:

10

1.

Click the ‘+’ symbol beside the name of the manufacturer you want to
display the list of fixtures they offer.

2.

Scroll down the list until you find the fixture you want.
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Adding the fixture to the patch panel
Once you’ve selected the fixture you want, there are three ways to add it to
the patch panel:

•

you can drag and drop one fixture at a time onto a specific DMX
location on the panel, or

•

you can use the Patch tab to place multiple copes of the fixture onto the
patch panel ,or

•

you can use the on-screen keypad to place multiple copes of the fixture
onto the patch panel.

Dragging and dropping individual fixtures

To patch fixtures one at a time, just click on the name of the fixture in the
Fixture type box, and drag the fixture over to the spot on the patch panel
where you want it.
When you ‘drop’ the fixture, Vista fills the required number of DMX
channels with that fixture’s details. This example shows a Martin Mac550
fixture that uses 21 DMX channels, dropped onto channel 164:

Once you’ve dropped a fixture onto the patch panel you can move it
around to any channel by clicking on it and dragging it to a new location.
Vista represents the fixture as a dark blue bar with a black border and two
numbers after the name. The bar covers as many DMX channels as the
fixture needs, and some fixtures will take up more channels than others.
The dark blue colour shows that this fixture is currently selected. If you
click anywhere else in the patch panel, Vista de-selects the fixture and
changes the colour to light blue to show that it’s no longer selected.
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Adding fixtures to the patch

Patching your rig

In our example above the fixture is called ‘Mac550 (basic).1 <1>’. This title
consists of three components:

•

a name (Mac550 (basic)), which you can change if you want to using the
Edit:Rename option (also available in the pen pop-up menu)

•

a type ID number (.1), that Vista assigns automatically. This number
identifies this fixture of this particular type.

•

a unique ID number (<1>), that Vista also assigns automatically. This
number identifies the fixture uniquely within the whole system, across
all the universes (i.e. no two fixtures will ever have the same unique ID
number).

Patching multiple fixtures with the Patch box

Adding fixtures one at a time could be very time consuming, so if you’re
working with a big rig, the faster way to patch your fixtures is with the
Patch box.
You use this feature to add multiple instances of a fixture at once. To do
this:

12

1.

Select the fixture you want from the ‘All fixtures’ or ‘By manufacturer’
lists in the Fixture Type box.

2.

If not already selected, click the Patch tab to display the Patch box:

3.

If you want to give the fixture a name, type it in the Name field. If you
leave this blank, Vista gives the fixture the name used in the Fixture
Type box.

4.

If you want to assign a specific set of unique ID numbers to this group
of fixtures, click in the Number from field and set the unique ID
number (e.g. <20>) you want for the first fixture in the group. If you
don’t set this, Vista assigns the next valid number.
Vista User Guide, Version 1.13a
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Adding fixtures to the patch
5.

In the Copies field, enter the number of instances of this type of fixture
you want to add.

6.

Click the ‘Treat as a single fixture’ checkbox if you want all copies to be
patched as one fixture. Use this option, for example, when patching
multiple dimmers as a single fixture.

7.

In the DMX Universe field, Vista automatically displays the number of
the currently selected universe. If you want to add these fixtures to
another universe, enter the universe number.

8.

In the DMX Start address field, set the number of the DMX channel
where you want this group of fixtures to start. If you’ve already added
any fixtures to this universe, Vista displays the next channel number in
sequence.

9.

In the Spacing field, Vista displays the number of channels each
instance of the fixture you’ve selected will take up. If you want to leave
empty channels between each fixture you can increase this number.
For example, if a fixture normally uses twelve channels and you
increase this number to 14, Vista leaves a gap of two channels between
each fixture in the group.

10.

Click the ‘Create in Fixture Pool’ checkbox if you don’t want Vista to
patch the fixtures automatically. If this box is checked, Vista creates the
fixtures in the pool area and you can manually drag them to the
required address. This option is useful when patching multiple
dimmers that are not on sequential DMX addresses as a single fixture.

11.

When you’ve set all the fields the way you want them, click the Patch
button. Vista adds the group of fixtures to the patch panel.

In this example we’ve added four Mac500s, followed by ten MiniMac
Washes, with a spacing of two channels between each MiniMac:

Vista User Guide, Version 1.13a

13

Adding fixtures to the patch

Tip:

Patching your rig

If you’ve already added a bunch of fixtures between say, channel 10 and
channel 50, and you add another batch starting at channel 1, Vista fits as
many of them as it can into channels 1 to 9, then ‘flows’ the rest over to
channel 51.
Patching multiple fixtures with the virtual keypad

Another way to patch multiple fixtures is by using the on screen keypad.
To add multiple instances of a fixture, using the keypad:
1.

Select the fixture you want from the ‘All fixtures’ or ‘By manufacturer’
lists in the Fixture Type box.

2.

In the DMX Universe field, Vista automatically displays the number of
the currently selected universe. If you want to add these fixtures to
another universe, enter the universe number.

3.

If not already selected, click the Keypad button to display the onscreen keypad:

4.

Use the keypad to type the Fixture/Unit number(s) and the DMX
channel where you want this group of fixtures to start.

For example:

•

1 Thru 5 @ 20 patches the current fixture type as unit numbers 1, 2, 3, 4,
5 starting at DMX channel 20 on the current universe.

•

1 Thru 10 – 3 Thru 7 @ 200 patches the current type as unit numbers 1,
2, 8, 9, 10 starting at DMX channel 200 on the current universe.

•

100 @ 101 + 113 + 125 patches the current type as unit 100 to DMX
channels 113, 125 and 200 on the current universe.

Hardware Keypad

When the on-screen keypad is open you can also use the console or PC
keyboard or a separate keypad to enter patch information. The ‘Num lock’
key should be on and in addition to the 1-9, decimal point, +, - and Enter
keys, you can use the following keys:
14
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This button…

does this…

/

Thru

*

@ - At

F

Full

Backspace

<- Backspace (Clear)

The Recent fixtures list
Vista keeps track of the last 10 fixtures that you’ve patched and stores these
entries in the ‘Recent’ folder. This list is stored with the Vista application
and does not transfer with your show file.

Changing universes
Each universe can only handle a certain number of fixtures, depending on
the number of DMX channels each fixture needs. To add fixtures to another
universe, click the Universe tab at the top of the patch panel to display the
next set of DMX channels.

Re-arranging fixtures on the patch panel
Moving fixtures around the patch panel
Once you’ve added fixtures to the panel you can re-arrange them however
you want. Just select the fixtures you want and drag them to a new
channel; when you take the pen off the screen, Vista re-arranges them all
from that channel.
Note that you can’t place them in such a way that any of the channels will
‘fall off’ the end of the universe. For instance, in our example the fixtures
we’ve added take up channels 1 to 177, so we can’t place that batch of
fixtures any closer to the bottom of the universe than channel 379:
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Re-arranging fixtures on the patch panel

Patching your rig

Displaying fixture short names
Vista has a standard abbreviated name for every fixture. To display these
short names instead of the full-length names, choose the Short Names
option from the View menu.
Here’s an example of the Patch screen showing the full-length names:

And here’s the same screen with the Short Names option selected:

If you have short names selected and want to display the full-length names,
select the Short Names option from the View menu again to restore the full
names.

Renaming fixtures
To rename one or more fixtures, select them with the pen and choose the
Rename option from the Edit menu. This command is also available from
the pen pop-up menu in both the Patch and Programmer (fixture view)
windows.
Choosing the Rename option displays the Rename fixtures window:

Enter the name you want to give the selected fixtures and click OK. Vista
renames all the fixtures you had selected.

16
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Renumbering fixtures
To change the unique system-wide ID number (e.g. <12>) of one or more
fixtures:
1.

Select the fixtures with the pen.

2.

Choose the Renumber option from the Edit menu (this command is
also available from the pen pop-up menu). Vista displays the
Renumber fixtures window:

3.

In the Starting From field, enter the new ID number. If you are renumbering multiple fixtures, Vista assigns this number to the first
fixture in the sequence.

4.

If you want the change to apply to all the fixtures of this type in the
current universe, instead of just the fixtures you selected, click the ‘All
Fixtures of this type’ button. If you want to renumber the fixtures in
the order in which you selected them, choose the ‘In Selection order’
button (this can be useful if you want to match the fixture numbers to a
specific design layout).

5.

Click OK to renumber the fixtures.

Adding fixtures with the same ID
Often with fixtures such as dimmers you need to multi-patch or add extra
copies of the same fixture at different DMX addresses. To do this:
1.

In the Patch window, select the fixture you want to add to.

2.

Choose the Multiple patch option from the Edit menu (this command
is also available from the pen pop-up menu). Vista displays the Multipatch window:

3.

Enter the number of extra locations to patch. Vista creates the extra
fixtures in the Fixture pool with the same ID as the original.

4.

Drag the extra fixtures to the required DMX channel.
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Swapping fixture types
One of the best features of the Vista is the ability to swap fixtures after
you’ve patched them and programmed them to clips. This is particularly
useful if you have to exchange one fixture for another (e.g. because of a
breakage) because you can do so without having to re-program anything –
Vista automatically adapts to the change.
To swap fixtures you must first put them into the pool.

Putting fixtures into the pool
To do this, you drag and drop the fixtures you want to swap from the patch
panel into the white area at the bottom of the patch panel, known as the
‘pool’:

Tip:

You can also put a fixture in the pool by choosing the ‘Unpatch’ option
from the pen pop-up menu.
The pool is also a handy place to store fixtures that you’re going to want
later but don’t need right now. When you need them you can just drop
them back into the patch panel without having to select them all over again
from the Fixture type lists.

18
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This example shows two of the fixtures we added above that have been
dragged and dropped into the pool:

They’ll just sit there until you pick them up and drop them back onto a
channel.

Swapping a fixture type
While a fixture is sitting in the pool, you can change its type. To do this:
1.

Select the fixture or fixtures in the pool you want to change. You’ll
notice that the Type drop-down list in the Properties box is now
available.

2.

Click the

3.

Or click the arrows beside the fixture name in the Type field to display
the list of fixtures in alphabetical order:
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Choose the type of fixture you want from the list. Note that you can
type the first letter of the fixture’s name on the keyboard to jump to
that place in the list (e.g. pressing the letter ‘A’ takes you to the Acrobat
250 FE at the top of the list).

Deleting fixtures
You can delete fixtures from the patch panel at any time To do this, select
the fixtures you want to delete and either press the Delete key or choose
Edit:Delete.

Setting fixture properties
Once you’ve added the fixtures to the patch panel and placed them where
you want them, you can set a number of properties for each fixture using
the Properties box.
To view and set the properties for one or more fixtures, use the pen to
select the fixtures you want on the patch panel. Vista displays the details of
those fixtures in the Properties box:

Tip:

If you select multiple types of fixture, Vista displays the details of the first
type you selected. If the Patch box is currently displayed, press the
Properties tab to display the Properties box.
This box has four sections that show you various properties of the fixtures
you’ve selected.

20
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Fixture

Name

The name you entered or Vista assigned to this fixture
when you dropped it onto to the patch panel. You can edit
this here if you want to.

Type

This field is only active when the selected fixture is in the
pool at the bottom of the patch panel. You use it to change
the type of fixture without having to remove it (see
Swapping a fixture type).

Id

The unique system-wide ID number assigned to this
fixture when you dropped it onto the patch panel. You can
change this number here if you want to, but note that Vista
won’t allow you to use a number that’s already assigned
to another fixture.

Intensity

Preheat

A percentage value that sets the voltage the fixture lamp
will sit at until you switch it on. This is useful for lamps
such as Par 64s that take time to switch on from a cold
start.

Limit

A percentage value that determines the maximum
intensity the fixture will ever reach. This is useful if you
want to prolong lamp life or prevent fixtures from ever
reaching full intensity.

Orientation

Invert pan

Selecting this checkbox reverses the sweep of the pan for
this fixture. This is useful when you’re coordinating the
sweep directions of fixtures hung in different directions.

Invert tilt

Selecting this checkbox reverses the sweep of the tilt for
this fixture. This is useful when you’re coordinating the
sweep directions of fixtures hung in different directions.

Swap
pan/tilt

Selecting this checkbox swaps the pan and tilt controls, so
the fixture will pan when given a tilt command and viceversa. This is useful for coordinating the movements of
fixtures hung on vertical trusses or pipes.

Channels

This is a list of the features of the fixture and which DMX channel is
controlling each feature.
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Advanced properties
The advanced button provides access to a number of Fixture ‘Transformers’
that allow you to further customize fixtures. For example the Pan and Tilt
Offset parameters allow you to correct the home position for fixtures that
are hung at an angle.
To add a transform click the Advanced button to open the transform
window then click the Add button to choose a transformer.

Some of the transformers are also available from the Properties tab as
described above. To choose one of the advanced transformers click on Pan
offset or Tilt Offset.
This option…

does this…

Offset

Sets the offset angle. For example setting a
Pan offset of 45 would move the fixtures
Home position by 45 degrees

Symmetrical

Determines whether the fixture has equal
movement from both sides of the Offset
position.
For example a Fixture with a Pan range of 360
degree and an Offset of 45% would move 135
degrees in one direction and 225 degrees in
the opposite direction. Since this might
produce unexpected results with effects and
other programming it’s possible to set
Symmetrical On, but this will limit the
fixture’s movement.
In this example it would mean the fixture
would only move 135 degrees, in each
direction, from the Home position.
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Adding a fixed colour or gobo to a conventional fixture
You can add a colour or gobo or both to a conventional fixture (par, leko
etc) so that it shows up in the fixture chooser when you bring up the
Intensity of that fixture. To do this:
1.

Right-click on the fixture icon in the programmer window and select
‘Set fixed Colour / Gobo’ from the popup menu. Vista opens the Set
Colour Gobo window.

2.

Double click on a colour and / or a gobo

3.

Click on the Close button.

Controlling the fixtures
The Patch screen has five buttons at the top that give you control over
whatever fixtures are currently selected on the Patch panel:

Note that only some fixture types support these functions; refer to the user
guide for your fixture types.
This button…

Tip:

does this…

Strike

Ignites the lamps in the selected fixtures.

Douse

Switches off the lamps in the selected fixtures off.

Reset

Resets the selected fixtures to their factory default
settings. This is useful if a fixture has a control
problem and you need to get it ‘back to normal’.

Home

Puts the fixture back to its home position.

Park

Parks the fixture permanently in whatever setting
it’s currently in. Useful for providing permanent
lighting for backstage and so on. Once you’ve
parked a fixture it will ignore any further
instructions.

These five commands are also available through the Control menu and by
right-clicking on the fixture icons in the Programmer.
There are four other buttons on the toolbar at the top of the screen:
This button…

does this…
De-selects whatever is selected and Selects the
next fixture in this universe.
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Selects the previous fixture in this universe.
Switches the selected fixture on. This is a toggle
switch – while it’s selected, Vista switches on
fixtures as you select them.
Displays the Connect Universes screen so you
can attach external Ethernet-DMX interface
boxes. See Configuring external Ethernet-DMX
interfaces.

Viewing the patch in different ways
Vista gives you two different views of your patch so you can get different
types of information about your patching configuration. To change the
view, click the drop-down menu in the top-right corner of the Patch screen:

There are two options: Table and List and view.

Table view
The Patch screen defaults to the Table view, as shown earlier in this section.
This is the view you will use most of the time: here you can drag and drop
fixtures into the patch panel for each universe and arrange them the way
you want them.

List view
If you choose the List option from the drop-down list, Vista displays the
List view screen. To select fixtures in this view click on the Unit ID
number(s):

This screen lists all the fixtures you’ve patched in global ID number order.
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If you click on the ‘+’ symbol beside a fixture’s name, it displays the
universe and DMX channel that each aspect of that particular fixture is
using:

The Transforms column displays any advanced properties (transformers)
that have been added to the fixture.
Tip:

This column is only meaningful when you have a fixture that consists of
two components (such as a colour changer in front of a Par). In this case the
colour changer will show ‘Control’ in this column, and the dimmer will
show ‘Intensity’.
The Patch Part column shows one of two entries: Control or Intensity.
‘Control’ is all aspects of the fixture other than intensity.

Cloning fixtures
Cloning is a special way to add fixtures to your patch. This method is
useful if you’ve already programmed your show and want to include some
new fixtures automatically in any Clips, Groups and Presets that you’ve
created.
To clone one or more fixtures:
1.

Select the type of fixture you want to add from the ‘All fixtures’ or ‘By
manufacturer’ lists in the Fixture Type box.

2.

Select the fixture(s) you want to clone from the Patch table or list view.

3.

Click the Clone button. Vista displays the Clone Selected fixtures
window:

4.

Click OK to confirm and the new fixtures are added to the patch.
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Note: The Clone button may be greyed out when you first select a fixture.
Selecting a second fixture will make the button active.

Importing and exporting patch information
To save time, you can import and export patch information from commaseparated value (.csv) files.
Exporting the patch

To export a patch to a .csv file, choose the Export Patch option from the edit
menu. Vista displays the Save As window so you can name the file and
choose a directory for it.
Importing the patch

You can also import a .csv file containing your patch information. The
easiest way to do this is to create a spreadsheet laid out as follows and save
it as a .csv file using the Save as function.
ID
1
2
3
13
13
14
15
25
26
35

Univ:Adrs
1:1
1:16
1:31
1:401
1:332
1:402
1:403
2:1+3:1
2:11+3:2
3:21

Fixture Type
Vari-lite_2000E Wash
Vari-lite_2000E Wash
Vari-lite_2000E Wash
GenericDimmer
GenericDimmer
GenericDimmer
GenericDimmer
VL5 Mode3
VL5 Mode3
Not Sure

Fixture Name
Vari-lite_2000E Wash.1
Vari-lite_2000E Wash.2
Vari-lite_2000E Wash.3
GenericDimmer.1
GenericDimmer.1
GenericDimmer.2
GenericDimmer.3
VL5 Mode3.1
VL5 Mode3.2

In this example the spreadsheet has a header row, which is optional, but
shown here for explanation. The columns are laid out like this:

•

an ID (1), which determines the fixture’s unique ID

•

a Universe : DMX address number (1:1), that sets the Universe and
DMX start address for this fixture

•

a Fixture Type (<Vari-lite_2000E Wash >), that sets the type of fixture
that will be patched

•

a Fixture Name (<Vari-lite_2000E Wash.1>), that sets the fixture name
(this is optional)

For two-part fixtures (i.e. fixtures with an external dimmer that is patched
separately) you need to include both parts of the patch included in the
Universe/Address column. The format for the two parts is
Control+Intensity.
In the example above, Fixture ID 25 is a Varilite VL5 with the control part
patched to Universe 2 Channel 1 and the Intensity part patched to Universe
3 channel 1.
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The ID, Universe:DMX Address information and Fixture Type must be in
the .csv file. If you don’t specify a valid Vista Fixture name, Vista prompts
you to choose the correct fixture name from a list when you import the file.
If you don’t specify a Fixture name, Vista uses a default name.

Configuring external Ethernet & USB to DMX interfaces
Vista consoles provide four internal 512-channel DMX outputs (or
universes). You can add up to twelve more by connecting your own
external ArtNet or PathPort boxes to the Ethernet port. You can also add
DMX outputs to a console or to the Vista App running on a computer using
the Vista USB-DMX interface boxes.
To configure these connections, press the Connect Universes button on the
Patch screen toolbar.
This screen shows any nodes connected via Ethernet or USB to the console
or PC , and the connection details of the universe. You use it to set up the
DMX connections for each of your universes and to check that they are
working correctly.
Tip:

If you’re only using four Vista’s internal universes you don’t need to use
this screen.

Connecting USB & Ethernet-DMX interfaces and ArtNetcompatible devices
The Output Devices box on this screen lists all the USB-DMX, Ethernet-DMX
connection boxes and ArtNet compatible devices attached and visible to the
Vista:

In this example you can see four entries: one is the Vista logo, representing
the internal universe connection; the others are Ether-Lynx (Art-net)
‘Pathport’ and USBDMX port, which are the external interface boxes
attached via Ethernet and USB.
Tip:

If you can’t see a device that you’ve attached to the Vista it may still be
possible to connect to it by using the ‘ArtNet Broadcasting’ mode.
To connect an external interface box:
1.

Select the universe you want to run through a particular box from the
Universes list in the left hand side of the screen.
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Tip:
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Click on the box title in the Output Devices list to select it, then click
the Connect button. Depending on the type of interface box you are
using Vista will either connect automatically, or display the Enter
External DMX source window:

For Pathport devices click on the ‘Pathport’ line rather than on the ‘DMX
Node’ lines.
3.

Click on the arrows beside the Source field and choose the number of
the universe for the box you’ve connected to. For example, if you’ve set
up a PathPort box to handle universes 7 and 8, you’d choose one of
those numbers in this window.

4.

If you are using Pathprt ‘Quick Universes’ click on the arrows beside
the Quick Universe field and choose the number of the universe for the
box you’ve connected to.

Pathport nodes are shipped with a default Quick patch By default, all A
ports are patched to Quick 1 and all B ports are patched to Quick 2.
Vista polls the box to check that the connection is working, and displays the
details of the connection in the Connected Universes box. It also greys-out
the number of the universe you’ve connected to in the Universes list. You
can check this connection at any time by clicking the Re-Poll button.
This example shows a Vista with an Artistic Licence Ether-Lynx Hub with
one port connected, a PathPort device with one port connected and a USBDMX device with one ports connected:

Note that in this example, universes 1 to 4 have been left as Vista internal
universes, and the external boxes have been connected to universes 5 , 8
and 10.
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Disconnecting an interface box
To disconnect an interface box:

Tip:

1.

Click on the title of the interface box in the ArtNet nodes section of the
screen.

2.

In the Connected Universes section of the screen, click on the
connection you want to remove.

3.

Click the Disconnect button. Note that when you disconnect an
interface, the universe it was connected to becomes available once
more in the Universes list.

To change the settings of an interface box you have to disconnect it and reconnect it with the new settings.

ArtNet Broadcast Mode
Some ArtNet-compatible devices may not appear in the Connect Universes
dialogue box. In this case you can set Vista to broadcast ArtNet information
without first establishing communication with the device. To do this:
1.

Open the Connect Universes dialogue box.

2.

Disconnect the universe(s) to be broadcast from any existing
connection.

3.

Tick the ArtNet Broadcasting checkbox. Vista now broadcasts Artnet
for all universes that are not connected to any other output.
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Setting up your fixtures
Once you’ve patched your fixtures you’re ready to fire them up and start
setting intensity, colour, position and so on.

The Programmer – about the Live and Clip Tabs
Vista lets you control fixtures live from the programmer and also edit one
or more clips at the same time. Whenever you open the Programmer you’ll
see a ‘Live’ tab at the top of the window: if you choose a Clip to edit it will
open in its own tab. To switch between tabs just click on the tab you want
to work on. For more information about editing clips and working with the
Programmer tabs see Working with clips on page 59.

The Programmer - Fixtures screen
To get all your fixtures up and running you tap the Programmer button on
the toolbar at the bottom of the screen. If this is the first time you’ve opened
this window you should be in the Live tab, otherwise click on the Live tab
to make it active.
Vista displays the Fixtures screen. This example shows a rig of ten Vari-lite
Spot and ten Wash fixtures:

This screen consists of three main elements:
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•

the Top view panel, where you can display and arrange the fixtures to
match the plan view of your lighting rig. This panel can also display
the Timeline when editing a Clip.

•

the Bottom view panel, where you can assign fixtures into meaningful
groups

•

the Intensity, Colour and Beam palettes, where you adjust the settings
for each fixture.
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You can also set the Bottom View panel to give you access to other
components such as Presets, Effects, Clips and so on (this view is called the
Quick Picker).

Arranging fixtures in a layout
Vista displays all of the fixtures you added on the Patch screen as icons on
the Programmer Fixture screen. When you first view this screen, the
fixtures are arranged in numerical order by Unique ID as a bank of icons, as
shown in the example above.
If you want to, you can drag and drop the fixture icons around to new
locations on the screen so that they match the layout of your lighting plan,
as in this example:

Tip:

You can undo a fixture move by right-clicking in the fixture window and
selecting the ‘Undo’ option from the popup menu.
You can choose how Vista represents the fixtures from the Fixtures
Arrangements option in the View menu:
This option…

does this…

Show Table

Displays the fixtures as ‘cells’ in numerical
order in groups of 300.

Show Icons

Displays the Fixtures as icons.

You can choose these options in the Fixture Layouts window. See the next
section for more information:

Using different layout views
You can create as many different views of your fixtures as you like, each
sorted and arranged in its own away. To create or modify a view:
1.

Click the Layout view selector on the toolbar and select the Layouts…
option:
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Vista opens the Fixture layouts window. You can also open this
window by right clicking in the fixture window and selecting the ‘Layout
Properties’ option:

2.

Click the New button to create a new layout or click the Duplicate
button to create a copy of an existing layout:

3.

Click in the Name field and type a name for the view.

4.

Set the way the fixtures are represented in the layout:

This option…

does this…

Icons

Displays each fixture as an icon that displays
Intensity, Colour, Position, etc (this is the default
setting).

Table

Displays the fixtures as ‘cells’ in numerical order
in groups of 300. Note that in this view you can’t
re-arrange the order or position of the fixtures,
you can only assign attributes to them using the
Palettes.

5.
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Set the options to determine how Vista displays and arranges the
fixture icons:
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This option…

does this…

Auto

Vista arranges the icons in numerical order by
Unique ID number. This is the default setting.

Free

With this setting selected you can drag and drop
icons anywhere on the Fixture panel.

Grid

With this setting selected you can drag and drop
icons anywhere on the Fixture panel but when
you let go, Vista automatically ‘snaps’ the icon
to the nearest line of the layout grid.

Lock

Once you’ve got icons where you want them,
choose this option to lock them in place so you
don’t move them by accident.

User ID

Sort the fixtures by ID number

Name

Sort the fixtures alphabetically by name

Type / User ID

Sort the fixtures by type name then ID number

Selection Order

Sort the fixtures into the order they have been
selected

Show Grid

Tick this checkbox to display the layout grid.

Horizontal
Spacing

Sets the amount of horizontal space (or
padding) between fixture icons and the grid.
Measured in pixels.

Vertical Spacing

Sets the amount of vertical space (or padding)
between fixture icons and the grid. Measured in
pixels.

Subdivisions

Sets the number of divisions within each cell of
the main grid. Icons will snap to main or
subdivision grid lines.

Zoom

Sets the zoom level of icons for this layout. 10% 150%.

Names

Displays the Fixture name (type and number)
below the icon.

IDs

Displays the Fixture unique ID below the icon.

Restore Defaults

Click this button to restore the icon settings to
their default values.
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Hiding and ‘un-hiding’ fixtures
You can hide any fixtures or fixture types in a layout. This removes them
from the display, but not from the patch.
To hide a fixture:
1.

Click the + symbol beside the All Fixtures heading in the Visible
Fixtures column to show all the Fixtures types that you’ve patched.

2.

To hide all Fixtures of a type, un-tick the checkbox beside that fixture
type, or click the + symbol beside a fixture type to show all the
individual Fixtures of that type.

3.

To hide individual Fixtures of a type un-tick the checkbox beside the
fixture(s) you want to hide.

To reveal (unhide) hidden fixtures, tick the checkbox beside the fixtures
you want to reveal.

Duplicating, deleting arranging and activating layout views
To duplicate a layout view, choose the Layout name from the list and click
the Duplicate button.
To Delete a layout view, choose the Layout name form the list and click the
Delete button.
To arrange the order that layouts appear in the list, choose the Layout
name from the list and click the Up, Down, Top or Bottom button.
To activate a layout view, click the Layout View selector on the toolbar and
select the layout name you want to display.

Selecting what to display in the Bottom pane of a layout
The Fixture Layout window is divided into a Top and Bottom pane.
To set what Vista displays in the bottom pane, select the Groups or Quick
Picker checkbox:
This option…

does this…

Groups

Vista displays Fixture Groups in the bottom
pane. This is the default setting.

Quick Picker

With this setting selected, Vista divides the
lower pane into columns that you can set to
display Groups, Presets and other components.

To adjust the amount of space allocated to each pane, click on the divider
bar and drag it up or down.
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Adding labels to the layout window
You can add text boxes to the fixture window to help identify different
fixture types or areas. To do this:
4.

Right-click in the fixture window and select ‘Add annotation’ from the
popup menu. Vista opens the Add annotation window.

5.

Type a label and click the OK button.

To move an annotation click on the text and drag it to a new location. To
edit or delete an annotation by right-clicking on the text and selecting an
option from the popup menu.

Arranging fixtures in a grid
You can arrange fixtures in rows and columns. To do this:
1.

Select the fixtures you want to arrange into a grid

2.

Right-click in the fixture window and select ‘Arrange in grid…’ from
the popup menu. Vista opens the Arrange in Grid window:

This option…

does this…

Rows

Specify the number of rows you want in the
grid.

Columns

Specify the number of columns you want in the
grid.

User ID

Sort the fixtures by ID number

Name

Sort the fixtures alphabetically by name

Type / User ID

Sort the fixtures by type name then ID number
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This option…

does this…

Selection Order

Sort the fixtures into the order they have been
selected

3.

Click the OK button to arrange the fixtures.

Using the intensity, colour and beam palettes
The Programmer screen usually has three ‘palette’ windows down the
right-hand side. These palettes give you control of the main aspects of
lighting fixtures: intensity & position, colour gobo and beam. All the
palettes work in much the same way, so once you’ve mastered one of them,
the others will be easy.
To set attributes for one or more fixtures, select the fixtures you want in the
Fixture panel, then click on the Palette you want to use.

Common features of the palettes
This example shows the Intensity palette with a number of fixtures selected
in the Fixture panel and the intensity set to 100%:

All three palettes have a few things in common:
This button…

does this…
Tabs along the top that display the different control
sets available in each palette. The arrow symbols to
the right of the tabs indicate that there are more
tabs available. Click the arrows to display them.
While each Palette has different tabs, they all have a
‘Raw DMX’ tab that you can use to program
attributes outside the control of the generic fixture
model (see About the generic fixture model on page 1).
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does this…
Stop effects. Select a fixture(s) and click this icon to
stop the effect. Only effects of the same type as the
current panel (i.e. intensity or position) are affected
The ‘Home’ button. Clicking this resets the selected
fixtures to their default parameters for that tab. For
instance, clicking this on the Intensity tab resets the
fixtures’ intensities to zero.
The Components or ‘favourites’ button. Clicking
this displays the Components window where you
can select Presets, Extracts, etc. See Creating presets
on page 52 for details.
The Clear Fixture button. Clicking this removes all
attributes for that tab that have been set for the
selected fixtures.
Close palette button. Clicking this removes the
palette from the screen. To re-display a palette
you’ve closed, choose it from the View:Control
Panels menu.
Slider bar, usually showing a percentage setting.
This is a quick and easy way to set a non-precise
value.
To adjust it, either:
•

click the double-arrows at the top or bottom to
go to 100% and 0% respectively

•

click and drag the blue bar to set the value you
want

•

click above or below the top of the blue bar to
increase or decrease it in small increments.

Slider bar with editable value field. The value field
provides a way to set precise values using the
keyboard.
To use the value field:
•

click in the value box and type a value using
the keyboard.

To hide or show the value field set the ‘Display
values above controls’ option in Vista’s User
Preferences – Programmer tab.
Or right-click on the slider and select ‘Display
editable value’ from the popup menu.
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Checking that everything is working
One of the first things you’ll probably want to do after setting up your rig
and patching it all in on the Patch screen, is check that everything’s
working. The quickest way to do this is to select the fixtures, one-by-one or
in groups on the Fixture panel, and crank the intensity and colour up a bit.
To do this:
1.

Select one or more fixtures in the Fixture panel.

2.

Click anywhere in the colour rainbow on the colour palette.

3.

Click the double-arrow icon at the top of the Intensity slider on the
intensity palette. Vista instructs all the selected fixtures to show that
colour at full intensity.

Tip:

You can also use the encoder wheels to set Intensity, Position, Colour and
any other parameter. See The Programmer hardware controls on page 48.

Tip:

If you can’t see any output from your fixtures check that the Grand Master
is turned fully clockwise and that the faders on the Superplayback panel
are up.

Highlight and Lowlight
When you are focusing or testing your fixtures you can use Highlight to
bring up the intensity of each fixture automatically when you select it.
To do this, click the Highlight icon. The icon background changes to
magenta to indicate that highlight is on.
You can alter how highlight works by updating the highlight and lowlight
presets. See The Highlight and Lowlight presets on page 55.

Setting intensity and position
The Intensity palette controls fixture intensity and position. It has four tabs
along the top:
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•

Intensity

•

Position

•

Intensity %

•

Raw DMX.
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Intensity

The default setting for the Intensity palette is the slider tab:

On this tab:

•

the Intensity slider controls the intensity of the selected fixtures in a
percentile range

•

if the selected fixtures have a strobe capability, the Strobe slider
controls the speed of the strobe

•

if the selected fixtures have blackout shutters, the Opened and Closed
buttons set the shutter position.

You’ll notice that as you change the intensity settings, the icons on the
Fixture panel change to reflect this.
Position

The Position tab gives you control of the direction in which the selected
fixtures are aimed:

To adjust the position, either:

•

click on the round target symbol and drag it to the spot you want

•

use the slider bars along the X and Y axes to set a more precise
position.

You’ll notice that as you change the position settings, the icons on the
Fixture panel change to reflect this, as these examples show:
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Before…

After…

Intensity by percentage

A more precise way to set intensity is with the second Intensity tab. This
provides percentile bands in 5% increments:

Just click on the level you want to set it. To increase or decrease it in 10%
increments, click the + or – 10% buttons. To set it to full or zero, click the
Full or Off buttons respectively.
Setting raw DMX intensity and position values

The Raw DMX tab gives you fine control of all of the intensity and position
attributes, but remember that any settings you make here are not recorded
by the generic fixture model, so if you change the fixture you’ll also have to
re-program all these details.
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Click the Percent button to set the sliders to a percentage, or the Raw DMX
button to set the sliders to adjust actual DMX values from 1 to 255.

Setting colour
The Colour palette provides four tabs so you can choose the way you want
to set your colours:

•

HSV – hue and saturation values

•

Lee – manufacturer gels swatchbook

•

CMY – Cyan, Magenta, Yellow or Red, Green, Blue sliders

•

Colour wheel – for fixtures that have colour wheels.

The Colour Palette also has a ‘Preferred mode’ drop down list at the bottom
that contains three options:

•

Automatic – when you pick a colour for a fixture that has both a colour
wheel and a colour mixer, Vista uses the Colour Wheel for the Lee and
Wheel Tabs and uses the Colour Mixer for the HSV and CMY tabs

•

Prefer Fixed – select this when you want the HSV and CMY tabs to use
the colour wheel – this may result in a near match colour.

•

Prefer Mixer - select this when you want the Lee and Wheel tabs to use
the Colour Mixer.

Hue and Saturation values

The HSV tab provides a colour spectrum and a saturation slider:

To pick a hue and its saturation, just click on the shade you want in the
spectrum area, and drag the slider bar on the right hand side to set the
saturation level.
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Manufacturer gels

This tab provides the actual gel colours, numbers and names from the Lee
swatchbook so you can pick the exact shade you want:

Click in the Colour, Lee or Name column headings to sort the list by name
number or colour.
Cyan, Magenta and Yellow/Red, Green Blue

This tab gives you the option of setting your colour using either CMY or
RGB values:

Click the relevant button to choose the method you want, then adjust the
sliders to set the colour.
Colour wheel

When using fixtures with colour wheels, you can use this tab to set the
precise colour on the wheel that you want this fixture to use:

Just click on the colour swatch to select it.
42
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You can also select by frame Number and set wheel spin by choosing from
the drop down at the bottom of this tab:

Raw DMX colour

The raw DMX tab gives you control of the colour as actual DMX values
from 1 to 255. Remember that any settings you make here are not recorded
by the generic fixture model, so if you change the fixture you’ll also have to
re-program all these details:

You can display Raw values as a Percentage (0-100) by setting the ‘Display
raw channels in percent’ preference to On.

Setting beams and gobos
The Beam palette has six tabs for controlling beam and gobo attributes:

•

Beam

•

Gobo

•

Gobo Wheels

•

Rotation (< >)

•

Framing

•

Raw DMX.
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Beam

The Beam tab controls the focus, zoom, frost, iris and prism settings,
including index and rotate, of the selected fixtures:

Use the sliders to adjust these values.
Gobos

The Gobo tab displays icons of the gobos available on the selected fixtures:

If you have only one type of fixture selected, the icons Vista displays
represent all the gobo types of that fixture.
To choose a gobo, click on the icon representing the gobo shape you want.
To display all the gobos, whether they are available on your fixtures or not,
check the ‘Show all gobos’ checkbox.
If you have more than one type of fixture selected, Vista displays all the
gobo types offered by all the fixtures. Note that just because the gobos are
displayed doesn’t mean they are available to all the fixtures.
Some fixtures have two gobo wheels. You use the Main and Aux buttons to
set a gobo from one wheel and a second gobo from the other wheel. You
can select any gobo as the main gobo and any gobo that is not on the same
wheel as the Aux gobo.
If you select the Main button and choose a gobo, Vista updates the icons on
the Fixture panel to reflect your choice. Now if you select the Aux button
the gobos that are not available, because they are on the same wheel, have a
white border around them, If you select one of the available icons Vista
updates the icons on the Fixture panel to reflect your combined choice.
44
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With some fixtures you can rotate the gobo you have selected. If your
fixtures allow this you can use the slider to index (set a position) or rotate
(continuously spin) one or both of the gobos. The options are:

Tip:

•

Index – move the slider to rotate the gobo wheel to the preferred gobo
position

•

Rotate – move the slider to rotate the gobo at different speeds.

Gobo information stored using the Main – Aux method is stored
generically, so it is the better option if you are likely to swap fixture types.
You can’t set half-frame gobo positions or spin the wheel using this
method.
Gobo Wheels

The Gobo Wheels tab provides a direct control method for fixtures that
have up to four gobo wheels. You can use this tab to make gobo selections
by their position on the wheel:

Choose the method you want to use to control the gobos from the dropdown menus at the bottom of each slider. The options are:

•

Open – sets the gobo wheel to the open position

•

Frame – set the frame number of the gobo on the fixture’s gobo wheel
(position 1 is usually ‘open’)

•

Index – choose by moving the slider to rotate the gobo wheel to the
preferred gobo position

•

Spin – set the gobo wheel to rotate through its frames.

•

Gobo – set the gobo by choosing from the images shown in wheel
order.

If you choose the ‘Spin’ option, Vista sets the slider to halfway,
representing ‘zero’. Increasing the slider to a positive value starts the gobo
wheel spinning in the direction from frame 1 upwards. The further you
push the slider the faster it spins.
Dragging the slider down starts the gobo wheel spinning backwards from
its highest frame number to its lowest. Again, the further you drag the
slider, the faster the gobo wheel spins.
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If you have set a rotation speed that you like but want to reverse the
direction you can right-click on the slider and select ‘Invert’ from the poup
menu.
Rotation (< >)

The Rotation tab controls the angle or rotation of rotating gobos:

You can set these values by Index or Rotation. The Rotation slider works in
the same way as on the Spin slider on the Gobo Wheels tab.
Tip:

If you have set a rotation speed that you like but want to reverse the
direction you can right-click on the slider and select ‘Invert’ from the poup
menu.
Framing

The Framing tab is specifically for fixtures that have beam shaping frames,
so you can shutter-off parts of the beam:

To set the positions you want the frames to be in on the selected fixtures,
click and drag each frame to the position you want, as shown in this
example:
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You can also set the rotation angle of the shape or continuously rotate the
whole shape using the slider.
Choose the method you want to use to control the framing from the dropdown menus at the bottom of the slider. The options are:

•

Index – choose by moving the slider to rotate the framing shutters to
the preferred angle

•

Spin – set the whole shutter assembly to rotate.

Raw DMX

The Raw DMX tab gives you control of the gobo settings either as
percentage CMY values or as actual DMX values from 1 to 255. Remember
that any settings you make here are not recorded by the generic fixture
model, so if you change the fixture you’ll also have to re-program all these
details:

Using transparent raw parameters
The Vista’s generic fixture model provides many benefits including the
ability to swap fixtures without having to re-programme. A consequence of
this is that parameters are always stored in logical groups (position, colour,
gobo, beam etc) and it is not possible to store individual parameters from
within these groups. On occasions this can be inconvenient, especially for
devices with large channel counts such as media servers.
For this situation, Vista provides a method to store just a single parameter
or a number of parameters from within a group. To store parameters this
way:
1.

Click on any of the raw-dmx tabs.

2.

Set the individual parameter as required.

3.

Right-click on the slider for that parameter to open a popup menu:
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This option…

does this…

Home

Sets the parameter to its default value.

Ignore …

Sets the channel so it will not be stored.

Don’t ignore …

Sets the channel so it will be stored.

… only

Sets the channel so it will be stored and all
others so they won’t be stored.

Don’t ignore any

Sets all channels to be stored.

Clear …

Clears any value set for the selected channel.

You can use these options in combination; for example, to store say two
parameters of many you would set the first parameter to … only and the
following one to Don’t ignore…
Note that as with any Raw-DMX settings this programming is not
transferable to another fixture type.

Fine Mode
Some parameters, such as position, can be difficult to control when the
palette is in normal mode. To switch to fine mode right-click on the palette
and select ‘Toggle Fine Mode’ from the popup menu. Repeat this to turn
fine mode off. When the palettes are in fine mode a Red background shows
behind the palette icon, as shown below.

:

The Programmer hardware controls
With the encoder wheels and associated LCD and buttons on the Vista
consoles you can make more exact adjustments than the on-screen palettes.
During programming you can use them to adjust setting for Intensity,
Position, Colour, Gobo and Miscellaneous parameters
Programmer intensity

The overall intensity from the Programmer is controlled by the fader
located, on the left side, below the encoder wheels.
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Programmer mode

If the controls are not already in Programming mode press the button
labelled ‘Playback’ to toggle the controls from Playback to programmer
mode:

This button…

does this…

I+P

Press this button to put the encoders and lower 6
buttons in Intensity plus Position mode. Pressing it
again cycles the controls through any available
parameters or alternate modes (Angular position and
Strobe & Shutter). Hold the red modifier (or the shift
key) and click to cycle the controls in reverse.

Col

Press this button to put the encoders and lower 6
buttons in Colour mode (HSV). Pressing it again cycles
the controls through any available parameters or
alternate modes (CMY, RGB, Frame / Index and
Colour swatch). Hold the red modifier (or the shift
key) and click to cycle the controls in reverse.

Gobo

Press this button to put the encoders and lower 6
buttons in Gobo mode. Pressing it again cycles the
controls through any available parameters or alternate
modes. Hold the red modifier (or the shift key) and
click to cycle the controls in reverse.

Beam

Press this button to put the encoders and lower 6
buttons in Beam mode. Pressing it again cycles the
controls through any available parameters or alternate
modes. Hold the red modifier (or the shift key) and
click to cycle the controls in reverse.

Vista User Guide, Version 1.13a

49

Assigning fixtures to groups

Tip:

Setting up your fixtures

This button…

does this…

X

Press this button to put the encoders and lower 6
buttons in Miscellaneous mode. Pressing it again
cycles the controls through any available parameters
or alternate modes. Hold the red modifier (or the shift
key) and click to cycle the controls in reverse.

Min

Sets the associated parameter to it’s minimum values.
I.E. would set Intensity to 0. Press Min and Max
together to set the parameter to it’s mid value. See tip

Max

Sets the associated parameter to it’s maximum values.
I.E. would set Intensity to 100

Encoders

Rotate to set the associated parameter to the required
value.

<- Left arrow

Selects the previous Fixture

-> Right arrow

Selects the next fixture

In the console window, if you hold any modifier (Ctrl, Shift Alt) and press a
max or min button it will toggle on for 2 seconds. When working on a
computer this allows you to then press the associated button to set a mid
value.

Assigning fixtures to groups
If you have a big rig, the last thing you want to do is manipulate dozens of
individual fixtures. To make it easy to control all the fixtures in your rig
you can assign them to groups.
A group can consist of any number of any type of fixtures; it’s entirely up
to you what you put in a group. Some typical groups might be all the
fixtures of one type, all the fixtures on the back truss, or all the fixtures
you’re using on one particular part of the stage.

Creating groups
When you are first creating groups it’s easier to be in a layout that shows
the Groups panel at the bottom of the screen. If you’re seeing the Quick
Picker instead of the Groups panel at the bottom of the screen, right-click in
the Fixture pane and select ‘Layout Properties’, then in the Fixture Layouts
window select the Groups option for the bottom view.
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To create a group:
1.

Select the fixtures you want in the group:

2.

Click the Add Group button on the left hand side of the Group panel:

Vista opens the Create New Group window:

3.

Type a name for the Group and click OK or press Enter. If you don’t
want to name the Group right away you can accept the suggested
name and rename it later.

There are two mode buttons on the left side of the Group pane. In Apply
mode when you click this group icon, Vista automatically selects all the
fixtures in it. You can then assign attributes to all the fixtures in that group
using the palettes. You use the Edit mode when organizing groups as
described below.
You can create as many groups as you want, and you can also create any
number of ‘groups of groups’.

Organising groups
At the top of the Group panel there is a tab called ‘All Groups’ that contains
all the groups you have created.
To add another tab, right-click in the area to the right of the existing tab
and choose the Add tab option. This creates a new tab along the top of the
Group panel. To rename the tab, click on it and enter a title.
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In Edit mode you can drag and drop groups from the All groups tab to
other tabs so you can arrange your groups in a meaningful way. You can
also drag groups into different columns or positions.

Fanning
To fan a selection of fixtures:
1.

Select the fixtures in the Programmer Fixture window.

2.

Select the palette whose attribute you want to fan (e.g. colour,
position).

3.

Hold down the yellow modifier button on the console (Ctrl key on the
PC version).

4.

Click and drag on the attribute window or roll any of the encoder-sets
on the console to fan the selected fixtures.

Creating presets
Presets are the ‘building blocks’ that you use to create clips. They represent
common sets of attributes that you know you’re going to want to use over
and over again, such as a particular position (e.g. on the drummer).
You use the Components button on each of the palettes to create preset
values for the main fixture attributes of intensity, position, colour, gobo
and beam. This is a useful way to create pre-defined values that you can
assign quickly to any number of fixtures without having to adjust the
settings individually for each one.
To create a preset:
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1.

Set the values on the palette the way you want them.

2.

Click the component button on that palette:
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Vista displays the Components window:

Tip:

3.

Click the New button to display the Preset mode window:

4.

Enter a name for the preset in the Name: box

5.

Use the filter bar (as described below) to select or deselect the features
you want to include in the preset.

6.

Click one of the buttons to choose whether you want this preset to
apply to all the fixtures in your rig, all the fixtures of the type you’ve
currently selected, or only those fixtures currently selected.

7.

Click the Continue button. Vista creates a new Preset icon in the
window that contains all the attributes you defined on that palette.

Presets are normally per-palette, i.e. you create separate presets for intensity,
colour, gobo and beam (and miscellaneous parameters). The filters on the
palette screen determine which types of presets Vista displays at any time:
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Each button represents a type of preset parameter:
Intensity
Position
Colour
Gobo
Beam
Miscellaneous (i.e. parameters that don’t fit in the
above groups).

Note that the filters apply when storing and when recalling a preset. This
means that whatever attributes are masked when you store the preset are
excluded from it, and whatever attributes are masked when you recall it
are not applied.

Updating presets
You can use the Programmer to update the information stored in a preset.
To do this:

Tip:

1.

While a editing the clip, select the fixtures you want to change or add
to the preset.

2.

Make the adjustments you want using the palettes.

3.

Open the Components window, select the preset and click the Update
button. You can also Right-Click the preset in the Quick Picker and
select Update from the popup menu.

4.

Vista displays the Preset Record/Update options.

You can also update Presets when you Update a clip, that’s being played
back. See Update Presets and Clips during playback on page 97

Editing presets
You can use the Programmer to add, remove or change information stored
in a preset. There are two ways to open a preset for editing:
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•

in the Components window you can select the Preset and click on the
Edit button

•

in the Components window you can right-click on the Preset and select
Edit from the pop-up menu.
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Once the Preset is open in the Programmer you can make changes in the
same way as you do when editing a Clip:

•

select fixtures in the Fixture Chooser window and add, remove or
change settings using the palettes or encoders, or

•

select fixtures or Event bars in the Timeline window add, remove or
change settings using the palettes or encoders.

To save changes to a Preset, choose the Save Clip option from the Clip
menu.
Tip:

When you are editing a Preset you can switch between the Fixture view
and Timeline view by either clicking on the Programmer button icons or
selecting Timeline or Fixture chooser from the View menu.

The Highlight and Lowlight presets
There are two special presets, Highlight and Lowlight, that set the
behaviour of fixtures when Highlight mode is on.

•

when you select a fixture it goes to the Highlight preset

•

when you deselect a fixture it goes to the Lowlight preset.

To edit either of these presets you do this:
1.

Set the fixture(s) Intensity, Position, Colour, beam etc.

2.

Select the ‘Highlight…’ option from the Tools menu.

3.

Select Update Highlight or Lowlight preset to save the settings.

Organising Components
At the top of the Components window there are several tabs called ‘All,
Intensity, Position, Colour etc’. The All tab contains all the presets you have
created. Vista also automatically adds Presets to any tab that corresponds
to the parameters stored in the preset. For example, if you create a Position
preset it appears in the All and Position tabs.
To add another tab, right-click in the area to the right of the existing tab
and choose the Add tab option. This creates a new tab along the top of the
Components window. To rename the tab, click on it and enter a title.
There are two mode buttons on the left side of the Components window. In
Apply mode, clicking on a preset or other component immediately selects
and activates it. In Edit mode you can click on a component, to rename or
move it, without it activating.
In Edit mode you can drag and drop components from the All tab to other
tabs so you can arrange your components in a meaningful way. You can
also drag items into different columns or positions.
You use this same screen when working with extracts. See Creating and
applying extracts on page 91 for details.
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Using the Programmer Quick Picker
You can set the lower panel of the Programmer to show either Groups or
the Quick Picker. The Quick Picker provides an easy way to select any of
the following items you’ve created:

•

Presets

•

Groups

•

Extracts

•

SmartFX (Canned FX)

To use the Quick Picker, switch to a Layout that has the Quick Picker
option selected:

This screen has five columns whose contents you can set by choosing an
option from the drop-down menu at the top of each column. Once you’ve
chosen the type of information you want the column to display, you can
also select what page you want to display within that column using the
second drop-down menu.

Arranging the Quicker Picker
When you first open the Programmer you’ll see the items in each section of
the Quickpicker, are laid out in a list. You can re-arrange the items into a
tiled, column layout by:
4.

Right-clicking in a section and selecting ‘Arrange in Grid’ from the
popup menu or

5.

Holding down the Green modifier (Alt on Windows, Option on Mac)
and dragging the items to a new position.

Presets labels
When you select some fixtures, the preset labels change to indicate which
are available:
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indicates this…
A light grey background indicates that this preset
does not have any settings stored for the selected
fixtures.
A dark grey background with a broken border
indicates that this preset has settings for some of
the selected fixtures.
A dark grey background with a solid border
indicates that this preset has settings for all of the
selected fixtures.

Using fade times in the Live Programmer
If you are working live you can quickly set a fade time that will apply to
any selections you make from the programmer panels or presets. The ‘Live
Time’ box, is located in the menu bar of the Programmer (when in the Live
tab):
Pic
You can set the fade time by clicking in the Live Time box and entering a
time in seconds. Vista remembers the fade times that are used and these
can be selected by clicking on the up/down arrow and choosing from the
drop down list.
Tip:

If you prefer to use the keyboard to set fade times press ‘Ctrl+T’ to
highlight the Live Time box and then enter a new time.

The Live Time Selector
If you are working live with Presets or the programmer panels the ‘Live
Time Selector’ panel can be used to control crossfade time:
When you are applying a presets or simply selecting a (non-linear) value in
the programmer palettes you can set a time for the Preset or selected value
to fade in. For example you might be working in the Live programmer tab
and want to fade some lights into a colour or position over several seconds.
To do you use the Fade time For Presets panel:
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This button…

does this…

0–9&.

The numeric and decimal point keypad buttons. i.e.
press 2 .5 for a time of 2.5 seconds.

->

Moves the time to the selector column. You can store a
list of favourite times this way.

Clr

Clears the entry box.

Del

Deletes the last number entered.

One-touch
mode

If this check box is ticked the numeric keypad changes
mode. This mode is useful for quickly activating
different presets in different times. Each time you
press a number it replaces the previous value. This
way you can press 5 then a preset to activate it over 5
secs. Then 2 followed by another preset to activate it
over 2 secs and so on. Two new buttons +10 and +50
are enabled in this mode.

/2

Designed for use in one touch mode. Halves the time.
i.e. 1 /2 gives a 0.5 second fade time.

*2

Designed for use in one touch mode. Doubles the time.
i.e. 6 *2 gives a 12 second fade time.

+10

Designed for use in one touch mode. Adds 10 secs to
the time. i.e. 1 +10 +10gives an 21 second fade time.

+50

Designed for use in one touch mode. Adds 50 secs to
the time. i.e. 1 +50 gives an 51 second fade time.

Clear list

Clears all times from the preset times list.
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Working with clips
Once you’ve set up your patch, arranged your fixtures, assigned them to
groups, and created the presets you want, you’re ready to create a clip.
This is where the Vista differs in a big way from traditional keypadcontrolled lighting consoles, because instead of telling it what you want by
entering strings of numbers, you do it all visually, on a large screen using
the pen or mouse and the hardware controls.

About the timeline
The Vista uses a ‘timeline’ concept that will be familiar to you if you’ve
seen the sound or video editing software now available for computers. A
group of events strung together along the timeline is called a clip.
The idea is simple: you create a series of lighting ‘events’ that occur in
sequence when you hit the ‘Play’ button. With the Vista you can move back
and forth through this piece of time and edit any aspect of the events that
occur, in much the same way as you could drag a tape back and forth
across the play head of an analogue tape deck.
If you have the Programmer open and you are working in the Live tab
you’ve probably already selected some lights, given them Intensity, Colour
and so on. To create a Clip using this look as a starting point you do one of
the following:

Tip:

•

choose the Export to New Clip option from the Live menu.

•

hold down the Yellow (Ctrl on a keyboard) modifier button on the
console and press the Select button on an empty playback.

•

if you want to start a new clip from scratch, choose the New Blank Clip
option from the Live menu or click on the mini-tab at the right hand
end of the tab bar.

you can also choose the ‘Store live’ option from the Live menu (or use the
keyboard shortcut Shift + Enter) to open the ‘Store Live’ window. With this
method you can append, merge or insert new information to an existing
clip and offers several advanced options Storing from the Live tab to another
Clip on page 75 for details).
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Whichever method you choose, Vista creates a new Clip tab and displays
the Programmer window:

This screen is where you create the events that make up the components of
your lightshow.
Tip:

Once you are editing a Clip you can switch between the Fixture view and
Timeline view by either clicking on the Programmer button icons or
selecting Timeline or Fixture chooser from the View menu.

Clip tabs
When you first open the Programmer you’ll see the Live tab and a mini-tab
above the timeline window. If you export to a clip or open a blank clip,
Vista adds a new tab labelled with the clip name.
Click on the tab for the Clip you want to work on. When you select a Clip
tab any fixture settings coming from the Live tab are turned off (made
blind). This way it’s easier to see what’s in a Clip without settings from the
Live tab being combined and shown on stage.
If you prefer not to turn off the Live tab output automatically, select the
User Preferences option from the Vista menu and set the Programmer,
Auto-Blind Live tab preference to Off. You can also turn on the Live tab
output, while you working on a Clip by clicking on the [L] icon beside the
Update icon.
To close a Clip tab, choose ‘Close Clip’ from the Clip menu or click the
close icon (X) on the clip tab.
Tip:
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When there is information in the Live programmer that is affecting the
output the text in the Live tab changes to bold and the Clear icon becomes
active.
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The clip tab popup menu

You can open, close and blind clips using the tab popup window. To do
this, right-click on the clip tab and the action you want from the popup
menu.

Tip:

This option…

does this…

New Clip

Opens a new clip tab

Save

Saves the clip

Save as

Saves a copy of the clip with a new name

Close

Closes the clip

Close (don’t
release)

Closes the clip without releasing it.

Close all other
clips

Closes all other clips

Blind

Blinds (hides) the output from the clip

Blind other clips

Blinds all other clips

Assert

If a clip has been over-ridden use this button to
re-assert it

Auto-Assert

Automatically re-assert a clip when it is the
selected tab.

If you hover the cursor over a clip tab, Vista displays a tooltip showing the
modification state of the clip and the playback mode.

Event bars
The horizontal bars represent events. These are the commands Vista is
sending to the fixtures you’ve connected on your Patch screen and
configured on the Fixture screen.
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The event bars represent the activities of those fixtures over time. As you
can see in this example, the bars go from the ‘0s’ point on the timeline scale
to the ‘2s’ point. This means that these fixtures are moving to a new setting
over two seconds:

The settings you’ve applied to these fixtures on the palettes (e.g. intensity,
colour and position) control the fixtures themselves. The timeline simply
tells those fixtures to accept those commands, and the event bar represents the
length of time it will take those fixtures to get to the desired state.
Once the fixtures get to that state they will stay like that until they receive
another command telling them to do something else (e.g. switch off).
In short, by placing the event bars where you want them on the timeline
you’re giving commands to those fixtures that tell them how long a
parameter will take to fade in. The parameter is determined by the palettes; the
timeline only controls when the fade starts and ends.

Using the summary views
You can view the details of the fixtures in the clip in several ways:

•

summarised by feature, i.e. intensity, position and colour

•

summarised by fixture type

•

all events

•

filtered events – Intensity, Position, Colour etc

You choose these views from the Summary View drop-down menu in the
top-left corner of the screen. You can also switch between the
minimised/maximized setting of each summary view using the + and –
buttons beside the drop-down menu.
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Summary by feature

This view shows a set of fixtures by their attributes:

By default, the view shows each bar minimised. To expand each attribute
and see the details, click the ‘+’ symbol beside the attribute name (e.g.
‘colour’). Vista displays the details of that attribute:
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Summary by fixture type

The fixture type view shows the same information but sorted by fixture
rather than attribute:

All Events

The All Events view shows all the details of each fixture:

This view is useful when you want to know exactly what you have in your
clip, but it shows so much information that you will usually have to use the
scroll bar on the right-hand side of the window to view it all.
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Filtering the All Events view
As well as displaying All Events, you can also choose to filter out different
classes of information on the timeline. To do this, choose an option from the
list below the line in the View drop-down menu:

When you choose a filter, Vista displays only those types of events.
You can also create your own filters to show only those combinations of
events you want to see. To create a filter:
6.

Choose the ‘Custom Filter’ option from the menu. Vista displays the
Define Filter window:

7.

Click the ‘New’ button.

8.

Check the buttons for the classes or types of events you want Vista to
display.

9.

Type a name for the filter.

10.

Click the ‘Close’ button. Vista adds this filter to the drop-down filter
list.

If you want to delete a filter, select it from the list on the Define Filter
window and click the Delete button.
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Playing and moving around a clip
At the bottom of the timeline screen there is a set of controls and a
navigator bar that shows where you are in time within a clip:

The buttons on the left work just like the controls on a CD or DVD player:
This button…

does this...
Jumps to the start of the timeline.
Steps backwards to the previous Step on the timeline.
Pauses playback.
Starts playback of the clip.
Steps forwards to the next Step on the timeline.
Jumps to the end of the timeline.
Cuts the DMX output so that you can make changes
on the console without triggering any fixtures on the
stage. In Blind mode the fixture icons don’t show the
changes you make.
With Auto selected, the Clip automatically goes blind
when you select any tab other than the Clip tab.
With the Free button selected you can make changes
to an event anywhere on the timeline without
playback automatically jumping to that position.
This mode is automatically selected if you open and
edit a Clip that is currently active (being played
back) and is useful if you want to make changes to
something that is about to be played back. In free
mode the fixture icons don’t show the changes you
make.
In normal mode the programmer output follows
event selections. So if you open a Clip and click on an
event in step 2 you’ll see the Green playhead line
jump to that point and the lights will change
accordingly. This is the normal mode while
programming.
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The progress indicator

When you hit Play, the yellow line on the navigator bar starts moving from
left to right across the timeline. This line shows where you are up to in this
clip. If you hit Pause, the line stops wherever it is on the timeline; if you hit
Play it starts from the same spot.
The yellow indicator line has a green line attached to it that runs across the
event bars in the timeline itself to show you where you’re up to. The green
line is there so you can make precise timing adjustments:

Depending on the level of zoom you have selected, the green indicator bar
may appear to be ‘out of sync’ with the yellow progress bar.
Zooming in and out

The red focus box in the timeline navigator bar (beneath the timescale)
shows the current zoom level:

To focus on a particular section of the timeline, put the cursor on this area
and drag over the section you want. Vista re-draws the red box to show the
area you selected, and updates the information on the timeline to show that
area.
You can also adjust the focus box using the icons on the horizontal scroll
bar just above the progress indicator:

This icon…

does this…
zooms in on the area selected by the focus box.
zooms out, increasing the length of the focus box.
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This icon…

does this…
zooms to fit the selected objects.

A

Zooms to the ‘Active’ region of the current step. This
region shows all event in the step but excludes blank
areas at the start or end of the step
zooms to fit the entire clip in the window.

Tip:

On the View menu you can also choose Fit-to-step, which re-sizes the
screen to the width of the current step.

Creating clips
You can create any number of clips, each of which can consist of any
number of individual lighting events. You can then combine these clips and
‘play’ them interactively to produce your overall lightshow.
For instance, you might create a clip that includes a peel off from the edges
of the stage with all the fixtures changing colour as they peel and ending
up focused on the centre of the stage. The whole thing might take five
seconds from start to finish. You’d achieve this by creating a series of
events, each of which handles one element of the overall effect.
When you trigger this clip from the console, the Vista plays through all of
the events in the sequence you’ve arranged them in on the timeline. If you
decide that part of the peel goes too quickly, you can go straight into the
timeline and extend the time allocated to that event. All aspects of the clip
can be changed, adjusted, manipulated on the timeline until you have it all
the way you want it. Each time you make a change you can either play the
clip again to see the result, or just drag the progress indicator bar from left
to right to ‘step’ through the events.
Note that the timeline shows events as a passage of time, and the fixtures
will only achieve their final state at the point represented by end of the
event bar. For example, if your event is a fade-in from 0% to 100%, the
fixtures will only reach 100% intensity at the end of the event bar.

Adding events to the timeline
To add one or more fixtures to the timeline:
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1.

Click the
icon on the toolbar Programmer button to display the
Fixtures window.

2.

Choose the fixtures you want (or select a group of fixtures from the
Group box).
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3.

On the Intensity palette, turn up their intensity to a level above zero.
You can also set any of the other attributes on the other palettes at this
point if you like.

4.

Tap the Timeline
icon on the Programmer button on the toolbar
at the bottom of the screen. Vista displays the timeline window with
the fixtures you just chose selected.

These fixtures are now part of an event on the timeline.

Moving events around
Each event has three attributes: a start point, duration and a finish point.
The event bars on the timeline show you where each event starts and
finishes and how long it will take to reach its end point:

To adjust the start or end point of an event, select the event and drag it
along the timeline to the left or right. Note that the grid has an automatic
‘snap-to’ feature that makes it easy to align start and end points.
To change the duration of an event, select the black square on the righthand end and drag it left to shorten the event, or right to lengthen it.
Note that in the example shown above three separate attributes of the event
have different timings:

•

the Intensity event starts at 0s and is complete at 2.2s

•

the Position event starts at 0s and is complete by 1.2s

•

the Colour event starts at 0.2s and is complete at 2.2s.

Using the modifiers to move events and step markers
Normally you can only move events within the bounds of the step they are
in (see Working with steps on Page 78 )
To move an event across a Step marker, hold down the Green modifier key
(Alt on a PC).
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If you drag an event across the last step of a clip Vista automatically creates
a new last step to accommodate the event. You can also reduce or increase
the size of a step and scale all events within it by holding the Yellow
modifier (Ctrl on a PC) while moving the Step marker.

Working with selection handles
A quick and easy way to create dynamic lighting effects is to ‘skew’ the
events on the timeline. When you select a group of events, Vista displays a
dashed selection box around them with black squares on the corners and
sides known as ‘handles’:

You use these handles to change the duration of the selected events. In this
example, the Intensity events of a set of fixtures are selected. By selecting a
handle and dragging it you can change the start or finish point of the
selected events as shown below.
The fixtures will now fade in over 400ms:

In the example below, we’ve selected the top right handle of the selection
and dragged it right to step the end fade times over the 2 seconds. This has
offset the end fade time so the first fixture takes the full 2 seconds to fade in
and the last fixture takes the original time of 400 milliseconds:
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In the next example, we’ve selected the lower right handle of the selection
and dragged it right to step the events over 2 seconds. This has offset the
end fade time so the first fixture takes the original time of 400 milliseconds
to fade in and the last fixture takes the full 2 seconds:

In the next example, we’ve selected the middle handle on the lower edge of
the selection and dragged it right to step the events over 2 seconds,
offsetting start and end fade times while retaining the 400 millisecond fade
duration:

If we now open up the Position event summary bar, we can select and skew
the position events too, completely separately from the intensity events:

This is an easy way to create the same effects over more than one parameter
(intensity and position for example), as you can change both
simultaneously.
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Starting with intensity and position events at a fade time of 400
milliseconds, we drag the middle handle on the lower edge to the right:

This creates the following effect:

The Intensity and Position events have the same offset start and fade times
as well as duration in one easy action.
If we wanted that same effect but over 1 second and not 2 seconds, we’d
select the middle handle on the right-hand side and drag it to the left until
its duration is 1 second:

Using the selection handles in this way you can utterly transform the
attributes of the selected events with just a few quick strokes of the pen.
You can also adjust any of the intensity, colour and beam attributes at any
time while adjusting the timeline events.

Making precise timing adjustments
If you want to set the start and end times and durations of events to a
precise point on the timeline you can either zoom right in and line them up
visually, or enter the actual time values.
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On the toolbar of the timeline screen, there is a time field and three
associated buttons:

With these three buttons you can select the start, duration or end of an
event. Once you’ve made a selection you can either type values directly
into the field or use the + and – buttons on the end to adjust the values. You
can enter times in hours, minutes and seconds, or as decimal units. For
example, 1.1m or 1m6s or 66s would all result in the same time. If you don’t
enter units Vista assumes you mean seconds.
You‘ll notice that when you drag events around the timeline Vista updates
these fields automatically.
Using the set timing window

You can also set event timing and adjust step duration using the ‘set
timing’ window. To do this select the event(s), right-click and select ‘set
timing’ from the popup menu.
Vista displays this screen:

This option…
[

Select to set the start time of an event

|

Select to set the mid point of an event

]

Select to set the end time of an event.

Start / Mid / End
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Enter a time to set the start mid or end of an
event to that position on the timeline. If you
enter a number with no units Vista assumes
seconds. Use h for hours, m for minutes, e.g.
1h2m3.5s
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This option…

does this…

Duration

Enter a time to set the duration (or length) of an
event(s). If you enter a number with no units
Vista assumes seconds. Use h for hours, m for
minutes, e.g. 1m2s.

Scale Events

Select this option if you want all selected events
to be scaled when the duration is increased or
decreased. Scaling is based on the longest event.
If this box is not ticked all events will be set to
the same duration

Stretch step

Select this option if you want the step containing
the selected events to be automatically stretched
or reduced in size .

Constrain to Step

Select this option if you want the events to be
fitted within the step. Events that are longer
than the step will be reduced to the step length.

Aligning start and end points

You can also align the start and end times of selected events. To do this,
select the events and click the alignment icons on the toolbar:

These two icons respectively align the start and end times of the selected
events.
Chaining events

You can also use the chain command to align the end point of one event
with the start point of another event. To do this, select the events and
choose the chain option from the Tools menu. You can chain two or more
events this way.

Setting the fade path
Vista provides a set of pre-defined fade path shapes so you can quickly set
how an event will progress. Click the drop-down box on the toolbar beside
the timing fields to display the fade path options:
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The shapes in this menu depict the fade paths you can choose:
This shape…

means this…
Automatic. Uses the default path for the event type.
i.e. Intensity events fade, colour/gobo wheels snap
Standard linear fade, going to the final state over the
duration of the event.
Snap at start - go to state very quickly.
Snap at end - go to state at the end of the event.
Delay, then slide up to the state.
Reach the final state approximately halfway through
the event.
Fast start and end with slow fade time in between
Slow start and end with quick fade time in between
Displayed when you have multiple fixtures with
different fade paths selected.

Tip:

Instead of making an event very short, just set it to Snap at Start. If an event
is set to 0s duration it will automatically be adjusted to 100ms and the fade
path will be set to ‘Snap at start’.

Converting events to Raw
Occasionally it can be useful to convert normal (generic) events to raw
settings. You can do this by selecting the events in the timeline, rightclicking and selecting the ‘Convert to Raw’ option from the popup menu.

Storing from the Live tab to another Clip
Sometimes you’ll just want to create some programming and store it
somewhere, rather than creating a clip and building it from the bottom up.
If you’ve created information in the Live tab of the Programmer, you can
add it or merge it into an existing clip, or used it to replace a step in another
clip. You can even start a new clip using the Store-to-Clip window.
To do this click on the Red store button, press Shift+Return on the
keyboard or select the ‘Store Live’ option on the Live menu. Vista displays
this screen:
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Selecting the Clip to Store to
You can choose to Store to an existing clip or a new clip. To do this:

Tip:

1.

Click the Clips drop-down box to show either All clips, All clips that
are active or just the Clips on the current pages.

2.

Click on the New clip… button if you want to store to a new clip.

You can also display the Store Live dialogue at any time while in the
Programmer Live screen by pressing Shift + Enter on the keyboard.

Selecting the Step and store options
You can store a new step, merge to or replace the contents of an existing
step. To do this:

76

1.

To create a new step, select the New Step button; to merge to an
existing step, select the Merge button; select the Replace radio button if
you want to replace the contents of a step.

2.

If you are creating a new step you can either type a number in the Step
Number box or click before or after any step in the step list to set the
insert location.

3.

If you are Merging or Replacing you can either type a number in the
Step Number box or click on any step in the step list to choose that
step.

4.

For a new step enter the step name, duration and end of step action.

5.

Select the fixtures to include when storing:

This option…

does this…

All Programmed
Fixtures

Stores to all fixtures that have had settings
changed in the programmer.

Vista User Guide, Version 1.13a

Working with clips

Storing from the Live tab to another Clip

This option…

does this…

Selected Fixtures

Stores to the fixtures that are selected in the Live
tab.

All Fixtures

Selects all patched fixtures.

Relevant fixtures
only

Tick this checkbox to exclude any fixtures that
are not already in the Clip.

6.

Select the parameters to store using the filter bar. Click on any of the
Intensity, Position, Colour, Gobo, Beam or Miscellaneous icons to mask
or un-mask that parameter.

7.

Select the tracking and store options

This option…

does this…

Don’t track
forward (step
only)

Click this checkbox to undo any changes in the
following step. Not available if storing to the last
step

Programmer state

Select this button to only store information
coming from the programmer.

Changes only

Select this button to store just the changes that
have been made in the programmer.

Active state

Select this button to store all information, from
both the programmer and any active playbacks.

Whole Fixtures

Select this button to store all parameters, even if
they have not been modified in the programmer.

8.

Select the ‘Clear stored data’ checkbox if you want to clear any stored
information from the Live programmer.

Store or Store & Edit
When you are ready to store there are two options. You can either:

•

click Store to save changes to the Clip

•

click Store & Edit to save changes to the Clip and switch to the timeline
view of that clip to make further changes. The Clip will be set to ‘Free’
mode and the playhead will be at 0.

Tick the ‘Lock options’ checkbox to remember the settings in the Fixture
and Options section.
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When merging information from the Store Live dialogue Vista uses the step
active region (the time from the start of the first event in the step to the end
of the last event) as the default time.

Working with steps
Events on the timeline are contained within a ‘step’, and each clip can have
any number of steps. The steps occur in sequence along the timeline and
the end of each step is marked with a diamond shape, as shown in this
example:

The diamond marker represents the end of the step and determines what
happens when playback reaches this point.
Vista displays green diamonds marking the end points of each step in the
progress bar at the bottom of the screen so you can quickly see the main
points of your clip.
Tip:

Tip:
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Normally a step marker can only be moved to the right – to lengthen the
step. This does not change the length of any events in the step. You can use
the coloured modifier buttons to change this action as follows:
Holding this modifier when
moving a Step marker

does this…

Yellow (Ctrl)

Moves events to the left and right of
the Step marker with the marker

Green (Alt)

Gives you free control of the Step
marker

If you have a lot of events the step markers can scroll off the bottom of the
screen. To show step markers, above the events, right-click in the timeline
ruler and select ‘Show Steps’ from the popup menu.
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Setting the end of step instructions
Each step lasts for a duration defined by the start point of the first event in
it and the end point of the last event. In this example we can see a label on
the timeline ‘Sweeps 1 - Follow’:

Each step needs an instruction telling it what to do when it reaches its end
point. To set this you can either click on the diamond marker, or select the
event and choose an option from the drop-down menu beside the Step
field:

There are three options:
This option…

does this…

Follow

When Vista reaches the end of this step it
automatically goes straight on to the next step in
the clip.

Halt

When Vista reaches the end of this step it stops
playing.

Repeat

When Vista reaches the end of this step it will
replay the step you specify in the ‘repeat’ step
down list. This step and any intervening steps will
be replayed for the number of times you specify in
the ‘times’ box.

You can focus in on the Steps in a clip one at a time using the left and right
arrow keys on the toolbar:

You can add a new step, before the first step or after the last step by
selecting the first step and clicking the Left arrow icon or selecting the last
step and clicking the right arrow icon. You can also name new steps or
rename existing steps in this field.
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Pre-determining event lengths
You can pre-determine the starting point, duration and end point of an
event using the two yellow Event Length triangles on the time ‘ruler’ at the
top of the timeline:

Tap and drag these triangles to define the start and end points of a step.
When you next add events to the timeline Vista automatically places the
events between these two points in time.

Managing steps in the Step list view
Step List View

You can switch the area at the bottom of the timeline screen to show each
step as a tab. To swap between the navigator view and the step list view
press the back quote (`) key or select the ‘Show step list’ option from the
View menu. Vista displays the Step list view:

In this area:

•

each step tab shows the name, duration and end of step action

•

the current step shows with a green outline

•

the selected steps show as a blue tab with white text. Click on a tab to
select it, shift-click or ctrl-click to select a range or group of steps.

You can right-click on a selected step or in the blank area to the right of the
step list to open a popup menu with the following options:
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With these options you can:

•

append a blank step to the end of the clip

•

insert a blank step before the selected step

•

copy the selected steps

•

paste the copied steps

•

modify the step name, duration, and end of step action

•

renumber steps

•

set the step start time

•

delete the step

•

view the step

•

add a mark step. See Inserting a ‘Mark’ step on Page 88

Modifying step name, duration, and end of step action

To change step name, duration, and end of step action of one or more steps:
1.

Select the step with the pen or mouse. Shift-click or ctrl-click to extend
the selection.

2.

Right-click to open the pop-up menu and select the ‘Modify step…
option. Vista displays the Modify steps window:

3.

In the Name field, enter a new name for the step. Leave this field blank
if you want to leave the name as it is.

4.

In the Duration field, enter a new time for the step (i.e. 1.5s or 1m2s).
Leave this field blank if you want to leave the step duration as it is.

5.

In the Action field, select the end-of-step action from the dropdown
menu. Leave this field blank if you want to leave the action as it is.

6.

Click OK to complete the changes.

Modifying the step start time

To change step start time:
1.

Select the step with the pen or mouse.

2.

Right-click to open the pop-up menu and select the ‘Set Step Start time’
option. Vista displays the Start time window:
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3.

In the Start time field, enter the time at which you want the step to
start. You can enter times in hours minutes and seconds or as decimal
units. If you are using Timecode the start time can be entered as hours
minutes seconds and frames. Use a semi-colon between units. I.E. to
enter 1 second and 12 frames - 0:0:1:12.

4.

Select the action for steps that will become shorter if the changes are
not rippled forward:

This option…

does this…

Retain timing

If a step is made shorter events in the step are
not changed. Events may then be longer than
the step. (i.e. span the next step)

Truncate events

If a step is made shorter events in the step are
shortened, if necessary, to fit into the step.

Keep scale

If a step is made shorter all events are scaled
accordingly.

5.

Tick the Ripple forward box if you want the changes to flow through to
following steps. When the box is ticked if a step is made longer all
steps to the right of it will be moved accordingly.

6.

Click OK to complete the changes.

Moving and copying steps to another Clip
Often you’ll have an effect in one of more steps of a clip that you’d like to
use in another clip. You can do this using the navigator pane step list view.
To switch to this view, open a clip in the programmer and press the `
(single quote) key or select ‘Show Step List’ from the View menu.
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Vista switches the navigator pane to show step list view:

In this view Vista shows each step as a small box containing the Step name,
step duration and end of step action. The current step is represented with a
green border and when you click on a step, or steps, the dark blue colour
shows that this step(s) is currently selected.
The step list view provides two ways to move or copy steps. You can:

•

select the step(s), then drag and drop those steps to a new location in
the same clip or to another clip

•

select the steps and use the right-click (popup) menu to select the
required action.

Using drag and drop to copy steps
To do this:

Tip:

1.

Click on a step box to select that step, then either Shift-click on another
step to select a range of steps or Control-click on another step to add it
to the selection.

2.

Click on the selected steps and drag them to a new position in the step
list. As you drag you’ll see a grey position marker appear between the
step boxes. Lift the pen or release the mouse button to drop the steps in
the new position.

3.

To copy the steps to another clip, select the steps as above then drag
them to the other Clip tab. That Clip will pop open and you can
position the steps in its step list.

When you drag and drop steps this way the default action is to maintain
the state of the source steps. For example you might copy from a clip that
has position in step 1, intensity in step 2 and colour in step 3. If you select
and drag step 3, Vista pastes intensity, position and colour (the state of step
3) to the destination step.
Likewise Vista will discard any redundant state information at the
destination. For example if the source step had intensity information that
was already the same in the destination clip it would be discarded.

Tip:

You can also open the Copy/Move step options window by holding down
the Control key when dropping the steps. For more information see below.
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Using the popup menu to move or copy steps
To do this:
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1.

Select one or more steps as described above.

2.

Right-click in the step list and select copy from the popup menu

3.

Click in the location you want to move or copy to

4.

Right-click to open the popup menu.

This option…

does this…

Copy Steps

Makes a copy of the source steps

Move Steps

Moves the source steps to the destination clip
(deleting the steps from the source).

All Programmed
Fixtures

Copies information for all fixtures in the source
step.

Selected Fixtures

Copies information for all selected fixtures.

All Fixtures

Copies information for all patched fixtures (even
if not in the source clip). This option is useful if
you want to recreate the exact look of the source
step. The Whole fixture option is auto-selected.

Parameter Filter

Use the filter bar to select or de-select the
features you want to copy to the destination.
You cannot filter when moving a step - this is to
prevent accidental loss of programming.

Don’t track
forward (step
only)

Click this checkbox to undo any changes in the
following step. Not available if storing to the last
step.

Events only

Stores contents of the source step only,
excluding any tracked state.
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This option…

does this…

Maintain state

Stores contents of the source step, including any
tracked state.

Active state

Stores contents of the source step, including any
tracked state plus relevant active state from
playbacks

Whole Fixtures

Stores contents of the source step, plus full
parameter information for affected fixtures..

Splitting steps
You can split a step into two steps to give you more detailed control of the
events within it. To split a step, either:

•

click on the timescale at the top of the timeline at the point where you
want to split the step, then choose ‘Split at cursor’ option from the Step
menu, or

•

position the green Playhead line at the point where you want to split
the step, then choose ‘Split at Playhead’ option from the Step menu.

Vista splits the step into two at that point. This example shows the ‘before’
and ‘after’ effect of using this function:
Before splitting

After splitting
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Adding markers to the timeline
You can denote significant points on the timeline with markers and use
them as moveable ‘snap-to’ points. This is useful when working with
SMPTE timecode because the markers are independent of the standard
‘snap-to’ points of the timeline grid, so you can place them anywhere you
like within time.
To add a marker:

Tip:

1.

Tap on the timescale ‘ruler’ at the top of the timeline and right-click to
display the pop-up menu.

2.

Choose the ‘Add marker @ cursor option’. Vista adds a green arrow at
that point.

You can also add a marker at the playhead position using the keyboard
shortcut Alt-M.
This example shows three markers on the timescale:

Removing Markers
To remove one or more markers from the timeline, select the step that
contains them, then choose the Remove markers option from the Tools
menu (also available by right-clicking in the timeline).

Converting Markers to Steps
Markers created in an empty step can be converted to steps. This feature is
useful if you want to listen to an audio track and set up step markers
corresponding to particular moments in the track.
To do this:
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1.

Open a new clip and either insert an audio track or set the end-of-step
marker to the duration (or a little longer) of the audio track

2.

Play the clip and simultaneously start the audio if it’s not in the clip.

3.

Press Alt-M on the keyboard whenever you want to insert a marker.
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4.

When you’ve finished placing markers select the ‘markers to steps’
option on the Tools menu. Vista converts all markers to steps and
renumbers the steps.

Learn timing
You can programme a Clip then use the ‘learn timing’ window to adjust the
index points automatically based on your actions. This is useful if you want
to fine-tune step timing to an audio or video track.
To use Learn timing:
1.

Open the Clip you want to use.

2.

Select the ‘Learn timing…’ option from the Tools menu. Vista opens
the Learn Timing window:

3.

If you want to learn timing for all steps make sure the Clip is not
already running. The Current time box should be showing 0s. If it’s not
you can click the Reset button.

4.

Use the radio buttons to select the Options and Actions:

This option…

does this…

Ignore follow-ons

Tick this option to treat all steps as halts while
learning timing.

Use LTC input
time

Uses the SMPTE timecode at the time you press
Go as the Step start time.

Ripple forward

If a step is made longer all steps to the right of it
will be moved accordingly.

Retain timing

If a step is made shorter events in the step are
not changed. Events may then be longer than
the step. (i.e. span the next step)
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This option…

does this…

Truncate events

If a step is made shorter events in the step are
shortened, if necessary, to fit into the step.

Keep scale

If a step is made shorter all events are scaled
accordingly.

5.

Once you have set the options and are ready to go, either press the Clip
Go button on the console or click the Go button in the window.

6.

Continue to press the Go button again whenever you want the next
step to start. Vista displays the learned start times at the bottom of the
window.

7.

If the new step times are correct click OK. Vista adjusts the step
markers.

You can also add a marker at the playhead position using the keyboard
shortcut Alt-M.

Inserting a ‘Mark’ step
Sometimes you will want fixtures to move to a position, change to a colour,
add a gobo or get set up in some other way while their intensities are at
zero. You could do this by programming the necessary events, but you can
also do it quickly using the ‘Insert Mark Step’ option on the Tools menu in
the Programmer window.
When you create Mark step events your original programming is not
altered in any way. Instead special events are created that duplicate the
programmed events. Because of this, if you change the original
programming the associated mark events are automatically updated to
match.
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Tip:

If you delete an event that has an associated mark event, the mark event is
not automatically deleted. Instead it becomes associated with the next
event of that type.

Tip:

You can also open the ‘Insert mark step’ window by right-clicking on an
event bar and selecting ‘Insert mark events/step’ from the popup menu.
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To use this option, switch to the Summarise by Fixture view, select the
fixtures you want to mark, and choose the Insert Mark Step option. Vista
displays this screen:

This screen shows the options available; you use it to set the way Vista
stores the Mark Step events.
You can either insert a new step to accommodate the mark events or , if it’s
possible, you can put the mark events in the previous step:
This option…

does this…

Filter bar

Use the filter bar to select or deselect the
features you want to mark. You cannot filter
when moving a step - this is to prevent
accidental loss of programming.

Insert a mark step

Inserts a new step before the current step.

Name

Sets the name for the new step that will be
created.

Step Duration

Sets the duration for the new step

Adjust existing step
durations

If you insert a new mark step this option
allows you to subtract time from the step
before or after the new step. This way the
overall length of the clip will not be changed
by the addition of the mark step.
With these buttons you can:
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leave the step lengths
unchanged

•

shorten the next step - by
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This option…

does this…
the same amount of time as
set in ‘Step duration’.
•

shorten the previous step by the same amount of time
as set in ‘Step duration’.

Set preceding step as
follow on

This option changes the step before the new
mark step to ‘follow’. That way, at the end of
the previous step the mark events run
automatically.

Place mark events into
preceding step

This option is only available if it’s possible to
place some of the mark events in the
previous step. The message below this option
shows whether all, some or no events can be
placed. If the option is selected but only
some events can be placed then the other
events will not be marked.

Set mark events to snap
at start

This option changes the mark events to ‘snap
at start’. This option is useful if you want the
mark to take place as quickly as possible.

Making changes to a step without affecting the next step
It’s often useful to make changes to step without those changes tracking
through to the following step. For example, you might have a clip where
the lights change to colour blue in step 1 and stay that way until they
change to red in step 10. If you then decide you want them to be yellow in
just step 5 you could make that change but since there are no colour events
in steps 6-9 the lights will stay yellow when you really want them to revert
back to blue in step 6.
For this situation Vista provides a method to make changes to a step only,
some consoles refer to this as making changes cue-only. To do this:
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1.

Edit a clip and make the changes.

2.

In the timeline select the events – they will normally be highlighted
already.

3.

Click on the ‘Untrack’ button on the toolbar or select the ‘Un-track
events (step only)’ option from the Tools menu. Vista inserts events in
the following step to set the lights back to the state they were in before
the change. If there were no events of that type originally, Vista inserts
release events instead.
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Trimming unwanted events
If you want to get rid of all but a few events in a step Vista provides a quick
method:
1.

Select just the events you want to keep.

2.

Click on the ‘Trim’ button on the toolbar or select the ‘Trim’ option
from the Tools menu. Vista deletes all but the selected events.

Blocking a step
Vista is a tracking console, which means that only changed information is
stored in any step and that any information in a step tracks forward until it
is replaced by a new event or cleared. Sometimes it’s useful to ‘block’ a step
so that any changes that are subsequently made to previous steps will not
affect the final look of the chosen step.
To do this:
1.

Select the step you want to keep exactly as it is. You can select the step
by clicking on the end-of-step diamond or by using the previous/next
step icons.

2.

Click on the ‘Block’ button on the toolbar or select the ‘Block’ option
from the Tools menu. Vista duplicates all tracked information into the
selected step.

Creating and applying extracts
Extracts are like programming templates and can contain any of the
attributes you define on the palettes: intensity, colour, beam, position, and
so on. They also store the timing associated with the events.
An extract is a section of a clip (or range of events) that you can save and
re-apply in other clips. By re-using existing material to build new clips you
can save yourself a lot of time re-creating your favourite lighting effects.

Creating extracts
To create an extract:
1.

Select the part of the clip or events on the timeline that you want to
extract.
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Click the Components button on the relevant palette, then click the
Extracts button. Vista displays the Components Extracts screen with
the filters set to filter out all the other attributes of the events you
selected:

In this example we clicked the Components icon on the Colour palette, so
Vista has filtered out all the other attributes. The masks that are on show as
‘crossed-out’ icons below the buttons in the top-left of the screen. If you
want to include other attributes in this extract, click the relevant mask
buttons to switch the masks off.
3.

Click the New button. Vista stores the extract with a default name.

4.

Right-click on the new extract icon and choose the Rename option from
the pop-up menu. Type a meaningful name for the extract.

Applying extracts
To apply an extract:
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1.

Select one or more fixtures in the Programmer Fixture window.

2.

Click the Components button on the relevant palette.

3.

Click on the Extracts button in the Components window.

4.

Find the extract you want and click on it to select it.

5.

Set the mask buttons so that the attributes you want are applied. Any
attribute that is masked, even if it is part of the extract, will not be
applied.

6.

Click the Close button.
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Arranging extracts
You’ll probably end up with a lot of extracts of all different kinds fairly
quickly. The ‘All’ tab always show every extract you’ve created, whatever
type it is. To enable you to find the one you want easily Vista automatically
sorts your extracts into a number of separate tabs for Intensity extracts,
Position extracts, etc. You can also add other tabs to enable you to arrange
extracts in any way you choose.
To do this:
1.

Click the Components buttons on one of the palettes to open the
Components window.

2.

Click on the Extracts button in the Components window.

3.

Right-click on or to the right of the tab labelled ‘All’ at the top of the
window, and choose the ‘Add Page’ option. Vista adds a new tab
labelled ‘Page #’.

4.

Double-click the tab name to highlight it and type in a more
meaningful name that describes the types of extracts you’re going to
keep in this folder, (e.g. ‘Flyouts’).

5.

Select the extracts you want to move to this folder, then drag and drop
them onto the new tab. Vista copies them from the ‘All presets’ folder
into this folder. Now when you click on the new tab, you’ll see your
extracts in there.

Editing extracts
You can use the Programmer to add, remove or change information stored
in an extract, there are two ways to open an extract for editing:

•

in the Components window you can select the Extract and click on the
Edit button, or

•

select the Extract in the Quick Picker and select Edit from the pen popup (right click).

Once the Extract is open in the Programmer you can make changes in the
same way as you do when editing a Clip:

•

select fixtures in the Fixture Chooser window and add, remove or
change settings using the palettes or encoders

•

select fixtures or Event bars in the Timeline window add, remove or
change settings using the palettes or encoders.

To save changes to an extract, choose the Save Clip option from the Clip
menu.
Tip:

When you are editing an extract you can switch between the Fixture view
and Timeline view by either clicking on the Programmer button icons or
selecting Timeline or Fixture chooser from the View menu.
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Using commands within clips
Commands let you use a Clip to control the playback of one or more other
clips.
To insert commands within a clip:
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1.

Open a clip in the programmer and choose the Insert Commands...
option from the Tools menu. Vista opens the Insert Command
window:

2.

Select the command to insert from the Action column:

This option…

does this…

Go, Back, Halt,
Assert, Skip Fwd,
Skip Back,
Release,

Acts on the clip as if you had pressed the
corresponding button on the playback controls
for that clip.

Flash

Equivalent to pressing the flash button on a
clip’s playback controls. You must also enter
either ‘on’ to flash or ‘’off’ to flash in the
Parameter box.

Inhibit

Inhibits (blinds) or un-inhibits the clip. You
must enter either ‘on’ or ‘off’ in the Parameter
box.

Rate

The Parameter field is a text field and only
allows valid input (e.g. numerical BPM value).

Release All

Releases All active clips. No other options are
available when this command is selected.

Timecode reset

Resets the timecode to 00:00:00:00.

Timecode enable

Sets a clip to be activated by Timecode.

Jump

Allows you to Jump to a specific step within a
clip.
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This option…

does this…

Snapshot

Activates the snapshot selected in the parameter
field.

3.

Select the Clip to be triggered from the Clip column or click on the
‘Browse’ button to open the mini components window. Open this
window to select a clip, from the components window clips layout,
and click OK.

4.

Enter an on or off command or step number, if applicable, in the
Parameter field. You can also click on a spot in the timeline ruler and
tick the ‘Insert at cursor’ box to put the command at that position.

5.

The command will normally be placed in the clip at the current
playhead position. If you want to put it at a different position enter a
time in the At field.

6.

Enter a descriptive label in the Label/Description field if required. This
text will appear alongside the command, in the timeline.

7.

Normally Vista creates a new end step if you place the command
beyond the end of the clip. If you prefer to extend the last step of the
clip tick the 'Expand existing step' checkbox.

8.

Click ‘Insert’ to insert the command and close the window.

Learning actions

The 'At' field updates continuously if the clip is playing back. This means
you can select the 'go' action and the target clip, then play back the
command clip and press the 'insert' button at the desired times to advance
the target clip, capturing and inserting the commands at the relevant
positions within the command clip.
Blind

If a clip is in Blind mode, all commands in the clip will be ignored in the
programmer.

Grabbing the console output
Sometimes you’ll want to capture whatever output the console is
producing at a given moment and bring it into a clip. This is called
’grabbing’, and it’s particularly useful as a way of building a Clip from a
look you’ve built on stage.
To grab the console output at any time when one or more clips are playing:
1.

Open a new Clip or a Clip you want to add to.

2.

In the Fixtures view, select the fixtures you want to grab. If you don’t
select any fixtures the Vista assumes and selects All fixtures
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3.

Switch to the Timeline view and click the Grab icon on the toolbar:

4.

Choose the Grab Active or Grab Full option from the pop-up menu.
Grab Active grabs whatever attributes are playing right now (e.g.
intensity, colour), and pastes them into the timeline as a new event.
Grab Full captures the full state of the fixtures (e.g. if there is No colour
event a Colour White event will be created). If you’ve made any
changes to the events since you loaded the clips, Vista grabs these
changes too.

Selecting events by attribute
If you want to select all the events that have a similar attribute (e.g. all the
instructions to use red), choose the Active Filter option from the Fixtures
menu on the Programmer screen. Vista displays the Active Filter screen:

Use the three drop-down lists and the filter buttons to choose the attributes
you want, then click OK to select all the fixtures with those attributes. To
add more lines so you can narrow the definition of the fixtures you want to
select, click the More button.
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Each time you click it, Vista adds a row of fields so you can define multiple
attributes, as in this example:

Here we are selecting all fixtures that have the following attributes:

•

a position other than Pan 59% and Tilt 69%

•

a ‘Pinwheel’ gobo

•

intensity at 95%

•

not zoomed near.

Update Presets and Clips during playback
When you make changes in the Programmer Live tab while a clip is being
played back, you can make those changes apply to the presets from which
you constructed the clip, or just make the changes to the clip itself.
Tip:

Update is designed to change settings that are already in a Clip and does
not automatically add new events or fixtures to a Clip, but you can open a
Clip and add new information in the programmer window on the Update
window.
Existing information

To update existing information:
1.

While a clip is playing, go to the Live tab in the Programmer window
and select the fixtures you want to change.

2.

Make the adjustments you want using the palettes or hardware
controls.

3.

Click the Update icon
menu.
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Vista displays the Update window:

Here you can choose whether to apply the changes to Clips or Presets if
they are in use. You can also filter the changes by fixtures and parameter.
By default, Vista selects the presets.
5.

To apply the changes to presets, click the checkboxes beside the preset
names in the Presets pane or, click the checkboxes beside the clip
names in the Clips pane to apply the changes to one or more clip rather
than to the presets.

6.

To make the changes to all Fixtures in the Clip or Preset, click the
‘Programmed fixtures’ checkbox in the Filter pane. To make the
changes to just the selected fixtures click ‘Selected fixtures’ checkbox.

7.

You can use the parameter filter icons to select or de-select the features
you want to include in the preset - Intensity, Position, Colour, Gobo,
Beam and Misc. For more information about the parameter filter bar
refer to Creating presets on page 52.

8.

When you’ve defined how you want to apply your changes, click the
OK button to return to the Programmer screen.

New fixtures

To add new fixtures or information, click the ‘Store…’ button beside the
Clip name in the Clips pane. Vista opens the Store Live windows where
you can choose the step to change and options to store ‘step only’ etc. See
Storing from the Live tab to another Clip on page 75. When you Store the
changes to the clip and close the Store Live window, Vista closes the
update window.
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Using the keypad in the programmer window
In some situations it is convenient to select fixtures and set intensities using
a keypad. To use the Vista keypad choose the Control panels > Show
virtual keypad from the View menu:

Hardware Keypad

You can use the keyboard number keys or a separate keypad when the onscreen keypad is showing. The ‘Num lock’ key should be on and in
addition to the number keys the following special keys are available:
This button…

does this…

/

Thru

*

At

F

Full

Backspace

<- Backspace (Clear)

Selecting fixtures with the virtual keypad

Use the keypad to select Fixture by their ID number(s). For example:

•

1 + 5 + 10 Enter selects fixtures 1, 5 and 10

•

1>10 - 4>6 Enter selects fixtures 1, 2, 3, 7, 8, 9 and 10

Selecting fixtures and setting levels with the virtual keypad

You can also set levels with the keypad. For example:

•

1 > 10 @ 50 Enter selects fixtures 1 through 10 and sets them to 50%

•

1 > 10 @ Full selects fixtures 1 through 10 and sets them to 100%

•

1 > @ 1 Enter selects all fixtures and sets them to 10%.
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Clearing the programmer with the virtual keypad

Press the decimal point (dot) button twice, followed by enter, to clear the
Live programmer:

Using effects
There are several ways to use effects. You can:

•

apply a single stored (‘canned’) effect

•

swing between two of your presets

•

create your own effects from scratch

•

modify existing effects.

Applying a single stored (canned) effect
To apply an effect:
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1.

In the Programmer Fixture window, select the fixtures you want.

2.

Click the SmartFX button on the toolbar. Vista displays the SmartFX
window:

3.

Click the New button to display the Add New Effect window:

4.

Click the Stored (Canned) FX tab. Vista displays the list of available
stored (canned) effects:
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The first few letters of each effect title tells you which parameters are in this
effect (e.g. I-Intensity, P-Position, C-Colour, etc).
5.

To apply an effect, click on the effect you want and click the OK
button. Vista displays the Smart Effects window showing the effect
you’ve chosen.

6.

To add a second effect that is synchronized with the first one, click the
Settings tab to display the SmartFX Control Panel:

7.

Click the Add button, choose another effect and click OK. Vista adds
this effect to the list in the Settings/Parameters box.

8.

To adjust the parameters of an effect, click on it in the
Settings/Parameters box and use the controls to adjust it (see Effect
controls on page 106).

9.

To see the effect, click the green Run button. To stop it, click the red
Stop button – a swing effect has two stop buttons.

Stored (Canned) effects that modulate or swing

Stored (Canned) effects are pre-set to either swing or modulate. Swinging
means the fixtures move between two sets of attributes determined by the
effect (e.g. moving from to left to right). Effects that are preset to modulate
will apply their own varying attributes about a particular setting (e.g.
creating a circle around a position).

Swinging between two of your own presets
Once you’ve created a couple of presets (see Creating presets on page 52)
you can use the Effects window to swing between them.
To swing between two presets:
1.

In the Programmer Fixture window, select the fixtures you want.

2.

Click the SmartFX button on the toolbar. Vista displays the Smart
Effects window.
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3.

Click the New button to display the Add New Effect window and click
the Presets tab:

You can use the buttons along the top of the window to filter out the
various types of preset (e.g. to display only the colour presets). To do this
click the ‘X’ button to turn off all of them, then click the icon for the preset
type you want to display.
4.

Select a preset from the list on the left (the ‘A’ preset), then choose one
from the list on the right (the ‘B’ preset) and click OK to start swinging
between the two presets. You can then adjust the settings of the overall
effect using the controls (e.g. speed it up, spread it across, etc). See
Effect controls on page 106 for details.

Creating an effect from scratch
To create your own effect:
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1.

In the Programmer Fixture window, select the fixtures you want.

2.

Click the SmartFX button on the toolbar. Vista displays the Smart
Effects window.

3.

Click the New button to display the Add New Effect window and click
the Settings tab:
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4.

Choose the parameter you want to put an effect on (e.g. position) and
click either the Modulated or Swinging button at the top of the
window to determine the type of effect you are going to create.
‘Swing’ creates an effect that transitions from one setting to another,
while ‘Modulate’ varies the attributes of one setting (e.g. creating a
circle or figure of eight around a single position).

5.

Click OK display the selected parameter in the Settings/Parameters
box:

6.

Click on the parameter and adjust the controls to apply the effects you
want (see Effect controls on page 106).

Making your effect swing

If you chose the ‘Swing’ button in the Settings tab, you have to define the
end points of the effect (i.e. where it starts and where it finishes).
In this case, when you click OK, Vista adds ‘Stop A’ and ‘Stop B’ buttons at
the top of the Settings/Parameters box.
To define the two end points:
1.

Click the ‘Stop A’ button.

2.

Use either the palettes or the controls to define a setting.

3.

Click the ‘Stop B’ button and define its settings in the same way.

4.

Click the ‘Run’ button to start the effect swinging.

Copying the swing start or end setting

When you’re making a swing effect it’s often useful to copy the start setting
so that you can use that as the basis for the end point. For example if you
want to make some lights swing between two positions that are close
together it will be quicker to set the A position then copy it to the B position
then adjust that position.
To do this:
1.

Click the ‘Stop A’ button.

2.

Use either the palettes or the controls to define a setting.
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3.

Select the Parameter from the Settings list.

4.

Click the ‘Copy A-> B’ button. Vista copies the A setting to the B
position:

5.

Click the ‘Stop B’ button and adjust the setting as required.

Saving your effect

To save an effect you’ve created:
1.

Click the Store Button. Vista displays a small window asking for a
name for the effect.

2.

Type a name for the effect and hit the Enter key on the keyboard. Vista
adds your effect to the list of stored (canned) effects. Next time you
click the Stored (Canned) FX tab on the Effects window, your effect
will be in the list.

Modifying effects
To add or change the features of an effect, click the Add button below the
Settings/Parameters box and choose the additional effect you want from
the list. Vista adds it to the list of attributes in the Settings/Parameters box.
You can then select any of these and adjust them using the controls (see
Effect controls on page 106).

Splitting out effects
Once you’ve added several effects you may want to take or more of them
out and make them separate effects in their own right. To do this, click on
the effect you want in the list in the Settings/Parameters box and click the
Split button. Vista removes that effect from the Settings/Parameters box
and adds it to the effects list on the left-hand side of the screen. It’s now a
separate effect that applies to the same set of fixtures.

Merging effects
Once you have two or more effects applied to a clip you can merge them
into one. You might want to do this to combine a set of ‘building block‘
effects and save them all as one effect. Note that you can only merge effects
within a single step.
To merge two or more effects together:
1.

104

In the Effects list, choose an effect you want to merge and click the
Merge… button. Vista displays the Merge Effect window:
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2.

From the list in the Merge Effects window, choose the effect you want
to merge your selected effect with, then click the Merge button. Vista
combines the first effect you selected with the second.

Reviewing effects
The FX Control Panel has three panes: the effects list, active effects and
selected fixtures:

The effects list displays all the effects you’ve applied to the entire clip.
When you click on an effect in this list, Vista displays the fixtures this effect
is applied to in the Active Effects list in the centre. The Selected Fixtures list
on the right always shows whatever fixtures are currently selected in the
Fixtures window.
To see which effects are applied to a particular step of a clip, click the
‘Current step only’ checkbox at the top of the Effects window. With this
box checked, Vista displays only the effects that are applied to the current
step of the clip. This is a quick way to work out what effects are happening
at any given moment in a clip.

Vista User Guide, Version 1.13a

105

Using effects

Working with clips

Effect controls
The SmartFX Control Panel contains the following controls:
This option…

does this…

Amplitude

For modulated SmartFX each setting parameter
can be assigned its own values for Amplitude.
For swing effects then there is only a single set
of parameter controls (since there is only one
waveform being generated):

Rate

Rhythmic

•

For modulated - affects how
much of the waveform is
added to the relevant
parameter.

•

For swing - affects the extent
of the swing centred between
the A & B endpoints, i.e. only
a value of 100% would reach
the endpoints.

This is the base rate at which the effect runs,
expressed in beats-per-minute (BPM). The
resultant rate achieved over the targeted
fixtures depends on the Rhythmic control
(below).
This control affects whether the Rate is based
on cycles-per-minute or fixtures-per-minute:
•

Per-cycle - if the effect is an
intensity chase at a Rate of
20BPM Per-cycle, then the
whole sequence will repeat 20
times each minute.

•

Per-fixture - if the chase is at a
Rate of 80BPM Per-fixture, then
the chase will cover 80 fixtures
each minute. The loop time of
a Per-fixture effect varies with
the quantity of fixtures used,
and is slower with more
fixtures.

Note that the fixture-to-fixture rate (e.g. a flash
rate) will be constant no matter now many
fixtures are used.
Direction
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Mainly useful for chasing effects, this controls
whether fixtures are sequenced in ascending
(down), ascending (up) or both directions
(bounce).
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This option…

does this…

Ordering

Controls how fixtures are ordered when
calculating waveforms and can either be or:

Overlap

•

Original - fixtures are treated
in selection order.

•

Random -the order of fixtures
is re-shuffled each time the
effect loops

•

Alternate - fixtures are in
original order but alternating
fixtures have inverted
modulation – e.g. can can

This is one of the fundamental SmartFX
controls and affects how much each fixture
overlaps the next when executing the effect:
•

Overlap = 0% Each fixture
executes the effect sequentially

•

Overlap = 100%) Each fixture
executes the effect
simultaneously.

This control works in conjunction with Spread
to achieve synchronized chases & wave effects
(see below).
Spread

SmartFX dynamically calculate a waveform
offset value for each fixture depending upon
this control:
•

Spread = 0% - all fixtures have
a uniform offset

•

Spread = 100% each fixture
has a unique offset ranging
from 0% to 100%.

•

Normally this control would
be left at 100% if the Overlap
control is anything except
100%, otherwise there will be
periods where all fixtures will
appear to be ‘at rest’.

Spread can be set to >100% allowing the
waveform to repeat within a fixture selection.
See below for a simple SmartFX tutorial using
Overlap & Spread.
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This option…

does this…

Blocking

This control affects how the set of fixtures is
grouped together. Normally this would be left
at 1 to indicate that each fixture is calculated
individually.
This control either represents a fixed number of
fixtures that are ganged together or it
represents a proportion of the total fixtures for
the block size.
For example:

Rate Multiplier

•

when set to 2, pairs of fixtures
are ganged together (whatever
the total number of fixtures
used)

•

when set to 25% the total
number of fixtures is divided
into 4 groups (each block is
25% of the total count) – for a
set of 12 fixtures then they’d
be ganged in threes.

To maintain synchronization between the
parameters of a modulated effect, instead of
specifying independent Rate values you can
scale each parameters rate as a multiple of the
base rate.
If you need slower rates then set the base rate
to lower value (e.g. ½ or ¼ of required rate)
then set each parameter’s rate multiplier
accordingly.
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This option…
Waveshape

does this…
There are six basic waveshapes available that
can be combined with the Polarity and Phase
offset controls to achieve many different
waveforms.
The six basic waveshapes are:
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•

Sinusoidal
Use a Phase offset of 0% to get
an actual sine wave or a Phase
offset of 25% to achieve a
cosine wave.

•

Ramp
The output value linearly
ramps up to the end value
then snaps back down to the
start value.

•

Pyramid
The output value linearly
ramps from the start value to
the end value and back down
to the start value.

•

Ramp-remain
Similar to Ramp, but the
output value remains at the
end value until the waveshape
restarts (i.e. only effective for
non-overlapped SmartFX).

•

Rhomboid
This is a special-case
waveshape that involves a
couple of extra waveshape
controls: Mark/space ratio and
Slope, explained below.

•

Ballyhoo
This is an extra-special
waveshape that is dedicated to
the production of ballyhoo
position effects. It is designed
to achieve a pseudo-random
movement on two parameters
while similarly ensuring that
at least one of the parameters
moves by a significant degree
(since purely random
waveforms can easily move
between two very similar
values and not appear to
move).
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There are two common controls that affect all waveshapes:
This option…
Polarity

Phase Offset

does this…
Affects whether the resultant waveform is
normal or inverted (e.g. a normal Ramp would
ramp up & an inverted Ramp would ramp
down).
This, in effect, ‘rolls’ the waveshape within its
own window – e.g. a 0% Phase offset for a
sinsusoidal waveshape would start and end at
the midpoint while a 25% Phase offset would
have the sinusoid start & end at the high point.

The following two controls only affect the Rhomboid waveshape and can
vary it between a rhombus, a square and a pyramid:
This option…

does this…

Mark/Space

This controls how much of the waveshape is
spent on (high) versus off (low). Useful for
strobe chases to affect the duration of each
flash.

Rhomboid
waveshape only
Slope
Rhomboid
waveshape only

This controls the slope between the off and on
levels. A slope of 0% results in a snap change
between low & high and a slope of 100% results
in a linear change.
Note that the duration of the linear change is
limited by the mark/space ratio: if this ratio is not
50% then the linear slope is shortened (e.g.
above 50% means more time is spend on than
off and there will always be a resting period at
the high level).

SmartFX Quick-start tutorials
Setup a small show with at least 10 fixtures and configure the Fixture or
Tracking window so you can see all 10 fixtures at the same time.

Using Stored (Canned) Effects
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1.

Edit a new clip in the programmer.

2.

Select the 10 fixtures open up the SmartFX Control Panel (SmartFX
toolbutton).
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3.

Click New to open the SmartFX: Add New Effect dialog. The selected
fixtures are shown on the right hand side (to confirm what will be
affected).

4.

Click the Stored (Canned) FX tab to display the library of stored
(canned) effects.

5.

Select an effect from the list and hit OK to insert the effect.

6.

Repeat steps 3-5 to add effects for different features or to replace effects
on existing features.

Stopping an Effect
To stop an effect and have the fixtures revert to their original or default
values for the parameters that were running the effect you do this:
1.

Edit the clip in the programmer.

2.

Select the Step where you want to stop the effect, or create a new step

3.

Select the fixtures and open up the SmartFX Control Panel (SmartFX
toolbutton).
Note: Do not select the effect name in the ‘Active effects’ panel. Selecting the
effect name here will automatically select the effect in the timeline and relocate
the play head to that position.

4.

Click the Stop Effects button. The ‘Select Effects to Stop’ window
opens.

5.

Select the Effect(s) you want to stop. The selected fixtures are shown on
the right hand side (to confirm what will be affected).

6.

Click the Stop button. Stop RTFX events will be added to the timeline.

SmartFX programming & playback fundamentals
To edit a new clip in the programmer, select the 10 fixtures and open the
SmartFX Control Panel (SmartFX toolbutton), then:
1.

Click New to open the Add New Effect dialog.

2.

Click the Settings tab and select the Modulated button.

3.

Open the Intensity branch to show the Intensity and Shutter items.

4.

Select the Intensity item and hit OK to close the window. You should
now see all fixtures’ intensity modulating but only reaching about 25%.

5.

Using the programmer’s intensity panel set the intensity to 50%. You
should now see the fixtures modulating between 25% and 75%.
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6.

Using the SmartFX Control Panel, click the Settings tab to view the
SmartFX controls. If the controls appear disabled then click the new ‘Imodulate’ effect in the Active Effects pane on the left – the controls
should now be enabled and should show the currently set control
values.

7.

Set the Amplitude to 100% to get the fixtures modulating between 0%
& 100% intensity.

8.

Step forward and set the new step to 20s duration (using either the
duration controls on the toolbar or by dragging the step point out to
22s).

9.

Ensure the same fixtures are still selected and then use the intensity
control panel to track forward the programming into this step (hit the
50% intensity button on the percentage tab).

10.

A new effect will appear in the Active Effects pane of the SmartFX
dialog – click to select it on the controls.

11.

Slowly move the Spread control up to 100% whilst observing the
output (Tracking View/Wysiwyg etc.). Note how the effect changes to
a wave pattern.

12.

Leave the Spread control at 100% and then very slowly move the
Overlap control back from 100% observing the output (n.b. this control
is very sensitive so move slowly down to 90%). Note how the wave
gets shorter – when the control is down around 60% only a couple of
adjacent fixtures are on whilst all the remaining fixtures are ‘resting’.

13.

Move the Spread control back to 100% and leave Overlap at 100%.

14.

Step forward to a new step and again set it’s duration to 20s. Click the
50% button to track the programming forward again (ensure fixtures
are still selected). Click to select the new effect at the bottom of the
Active Effects list.

15.

Set Overlap to 0% and note that the effect is now chasing from one
fixture to the next.

16.

Click the middle effect in the Active Effects list. The timeline should
automatically select the relevant events in the middle step.

17.

Set the Rate to 40BPM.

18.

Press the SmartFX toolbutton to close the SmartFX control panel.

19.

Use the transport controls to rewind the playhead to the start of the
clip and play the first step to output the initial effect.

20.

Press play to play through the second step and observe the output. The
effect will smoothly transition from a ‘flat’ effect in to a wave and will
gradually double in speed.
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21.

Play through the last step and observe how the wave duration
gradually decreases together with the overall rate, until a single fixture
chase results at the end.

Selecting and sorting fixtures in the timeline
You’ll often want to select particular fixtures and sort them in a certain way
to achieve an effect (such as bringing lights up on each side of the stage and
successively across the stage towards the centre). To make these sorts of
effects you may need to sort or ‘gang’ your fixtures.
To select and sort fixtures:
1.

Select the fixtures you want in the Programmer Fixture window. Note
that if you want to sort them in particular order other than the obvious
ones (such as beginning and end), choose them in that order now.

2.

Press the Sort
window:

icon on the Timeline screen to open the Sort

Selecting subsets of fixtures
When you drag the pen across the Fixture window and select a bunch of
fixtures, you get a fairly broad selection. If you want to be more specific
you can use the Subset pane of the Sort window to select a specific set of
fixtures.
The subset selection controls are:
This button…

does this…

Next

Selects the next fixture in the list. If you have all the
fixtures selected, this de-selects all but the first one.

Prev

Steps back in the reverse direction, selecting the
previous fixture in the list.

Odd

Selects all the odd numbered fixtures (i.e. 1, 3, 5 etc). If
you click it a second time it selects 2-on-2 -off (i.e. 1&2,
then 5&6, 9&10). If you click it a third time it selects 4on-4-off (i.e. 1-4, then 9-12, and so on).
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This button…

does this…

Even

Selects all the even numbered fixtures (i.e. 2, 4, 6 etc). If
you click it a second time it selects 2-on-2-off (i.e. 3&4,
then 7&8, 12&13). If you click it a third time it selects 4on-4-off (i.e. 5-8, then 13-16, and so on).

Reset/All

Reverts the subset to the original selection (all the
fixtures you chose in the Fixture window).

Custom
(In/Out)

In this field you can define how many are selected and
how many are not. The first number is the number of
fixtures in the selection, and the second is the number
that are skipped.
For instance, if you set this to 1:2, Vista selects fixture 1,
de-selects 2&3, selects fixture 4, skips 5&6, selects 7,
skips 8&9, selects 10 and so on (i.e. a setting of 1:2 selects
fixtures 1, 4, 7 and 10, while a setting of 3:4 selects
fixtures 1, 2 &3, skips 4, 5, 6 and 7, and selects 8, 9 and
10 and so on).

Shift Right

Click this button to select the next logical grouping of a
Custom selection.
For example if you have 1:2, in the Custom field Vista
selects fixtures 1, 4, 7, skips 8&9, selects 10 and so on (i.e.
a setting of 1:2 selects fixtures 1, 4, 7, 10, etc.
If you press shift right vista selects fixtures 2, 5, 8, 11, etc

Shift Left

Click this button to select the previous logical grouping
of a Custom selection – as above.

Ganging

Groups a number of fixtures together so that any action
you take applies to them as a group, rather than
individual fixtures.
For example, it determines the number of fixtures
selected when you use the other subset buttons. For
instance, with Ganging set to 2, every time you click
Next, it selects pairs of fixtures. It also affects the way
changes you make on the timeline apply to the fixtures –
any change made to ganged fixtures applies to the
whole gang, not just one fixture.
This is useful to do things like make fixtures come on in
pairs.

Invert
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This button inverts whatever you have selected. For
instance if you have a custom selection of 5:2 it selects
2:5; if you have odd fixtures selected it selects evens.
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Sorting fixtures
You can sort fixtures in a number of ways. To do this, select the fixtures
then click the Sort. Vista displays the Sort window:
This option…

sorts the fixtures in…

ID

ID number order.

Name

alphabetical order.

Selection

the order in which you selected them on the Fixtures
screen.

Random

random order. The Re-Shuffle button re-sorts the
fixtures into another random order.

Custom

in any order you define. Clicking the Lock button
defines the current selection as the Custom selection.
Click the Set... button to displays the Set Custom Sort
Order window. Click the fixtures in the left –hand pane
in the order you want; the right-hand pane displays the
selected order.

The Mirror Selected Fixtures checkbox puts the selection into the mirror
image of whatever order you define. For instance if the fixtures are in the
order 1-10, this changes the order so that the selection sequence becomes 110, 2-9, 3-8, 4-7, 5-6 instead of 1, 2, 3, 4, etc
The Descending checkbox sorts the selection in descending order based on
the order you define.
Creating custom sort orders

The custom sort button displays the Set Custom Sort order window:

To sort fixtures in a particular order, select the fixtures in the order you
want in the left-hand pane of the window then click OK.
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Saving and re-applying sort configurations
When you’ve set up a sort order that you like, you can save it so you can
apply it to other groups of fixtures.
Saving sort methods

To save a sort method:
1.

Click in the Presets name field:

2.

Enter a name for the sort method.

3.

Click the Add button to add it to the list of sorting methods.

To delete a saved sort method, select it from the list and click the Delete
button.
Applying saved sort methods

To apply a sort method to a set of fixtures:
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1.

Select the fixtures then click the Sort button to display the Sort
window.

2.

Select the sort method you want from the Preset list.

3.

Vista applies the sort to your fixtures.
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Assigning audio to a clip
To assign audio to a clip:
1.

In the Console window, right click on the Clip name and select ‘Assign
audio’ option from the popup menu, or, with the Clip open, choose the
‘Assign audio’ option from the Tools menu in the Programmer. Vista
displays the Assign audio window:

2.

Click the Add track button . Vista displays a File:Open window.

3.

Open the folder containing your audio files (normally the Audio folder
inside the User-folder) and select a track. Repeat this step for each
track you want to add to the Clip. Vista displays the names and
attributes of the tracks.

4.

If you want the audio track to start at a point after the beginning of the
clip, click the Start field and enter the number of milliseconds delay
you want before the audio starts.

5.

Click OK to close the window. When you play this clip Vista plays the
selected audio tracks with it, in the sequence and at the times specified.
You can also move the audio track(s), in the Clip window, by holding
down the yellow modifier (Ctrl) and dragging the audio bar.

Moving Tracks to another Clip
Occasionally, Clips get so large that they are difficult to work with and may
affect the performance of the console. There is a limit of 30,000 events per
clip; if you approach this limit Vista will provide a warning and you can
choose to start a new Clip or re-locate some information to another clip.
To do this:
1.

In the timeline view, select a group of fixtures (say all of one type) and
right-click on the side Track tab.

2.

Select a Track – Vista creates one new track at the bottom of the list.

3.

The selected fixtures will be assigned to the selected track.

4.

Select the ‘Re-locate to a new clip’ command under the Clip menu. The
Re-locate Tracks window opens.
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Select the track to re-locate and click OK. Vista creates a new Clip and
imports the original clip programming for the selected track.

Ganging Clips to synchronise playback
If you’ve re-located tracks as described above it may be convenient to gang
the original and new clip together so that they are synchronized during
playback.
To do this:
1.

Choose the Clip Properties option from the Edit. Vista displays the
Clip properties window.

2.

Click on the ‘Ganging…’ button at the bottom of the window. Vista
displays the Ganging window:

3.

Select the original Clip from the left hand column and the Clip to gang
from the right hand column.

4.

Click OK. The two Clips will now play back together when either clip
is activated. It is not necessary to have both clips on a playback.

Changes history
Vista keeps track of changes you make, in the Programmer, using Store
Live or in the Playback control window, to Clips, Presets and Extracts. The
History window shows a list of items that have been modified and whether
or not those changes can be undone.
This makes it easy to identify and undo recent changes particularly if the
changes have been made using Store Live or in Playback control window
without opening the programmer. Whenever there are changes that can be
undone the History button changes to yellow.
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Changes history

Click on the ‘History’ button to display the ‘Change History’ window

To modify an item:
1.

Select the Clips, Presets or Extracts tab.

2.

Select the item you want to modify.

3.

Click the ‘Undo’, ‘Redo’ or Edit button.

You can’t undo changes after you save your show or save a clip, preset or
extract that is open in the programmer.
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The Playback Control Window
Control and Monitor Playback
When you’ve got a full show going it’s likely that you’ll have multiple clips
on the console and being played back.
To see what’s going on at any time, hit the Playback Control button on the
toolbar at the bottom of the screen. Vista displays the Playback Control
window:

This screen lists all the clips that are playing and gives you a handy point
from which to control and edit them. The window is made up of two panes
that can be resized by clicking on the vertical dividing line and dragging
the divider to the left or right.
Clip pane

The left side of the screen displays a list of all Clips and can display up to
twelve columns that show playback status and some clip properties.
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This column…

indicates…

Clip Name

The name of the Clip. Active clips are shown in
Blue text.

Current Step

Shows the current Step name and number.
Clips that have not been run show the first step
name.

Active

Shows if the Clip is playing or has been played.
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This column…

indicates…

HTP

Shows the ‘HTP Intensity’ property setting.

Active HTP

Shows the ‘Active HTP’ property setting. The
intensity, of an active HTP clip, activates as
soon as the playback fader is moved above 0.

On Playback

Shows if the Clip is on a playback control.

Priority

Shows the priority of the clip.

SMPTE

Shows if the clip is set to be triggered by
timecode.

Audio

Shows if the clip has any audio files assigned.

Release Time

Shows the clip’s release time.

Inhibited

Shows if a Clip has been inhibited (made
blind).

Notes

This column is for notes and comments. To add
a note click, first click to select the clip, then
click again on the notes cell.

You can sort the clip list by clicking on any of the column headings. For
example to show all the clips that are on playback controls, at the top of the
list, click on ‘On Playback’. Click the column heading again to reverse the
order.
You can resize columns by clicking between the headings and dragging the
column to suit. To show or hide columns right-click in the Clip pane and
select ‘Show/Hide fields’ from the popup menu.
Step pane

The right column shows the steps in the clip selected in the left column and
is divided into six columns that show step detail and progress:
This column…

indicates…

Step

Shows the step number.

Name

Shows the step name.

Progress

Provides a visual display of the step’s progress.
The colour at the end of the bar indicates what
will happen at the end of the step. Green
indicates that the next step will follow on. Red
indicates that the Clip will halt at the end of the
step.
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This column…

indicates…

Time

Shows the elapsed time, time remaining and
total fade time for the step. I.E.
1/5 [6]
Elapsed time is 1 second
Time remaining is 5 seconds
Total fade time is 6 seconds

At end

Shows what will happen at the end of the step.
Halt – the clip will pause until Go is pressed
Follow – the next step will play automatically

Notes

This column is for notes and comments. To add
a note click, first click to select the step, then
click again on the notes cell

If the ‘Dragable Playhead’ option is ticked you can control a Clip’s
playback by clicking on the step progress indicator bars.

Click on the > button on the left side, of the bar, to play the step, click on
the >> button to go to the end of the step or click anywhere in the step bar
to jump to that point.
To prevent accidental triggering of steps uncheck the ‘Dragable Playhead’
checkbox.
Options

You can set the playback control window to automatically follow the
selected clip and current step:

122

This option…

does this…

Show Active Clips only

Filter the left column to display only the clips
that are being played.

Follow Clips on Select

When you press a Clip’s ‘Select’ button that
clip will be displayed in the right hand pane.

Follow Clips on Go

Whenever you press Go that clip is displayed
in the right hand pane
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This option…

does this…

Follow default super
playback

If this option is ticked the clip on the
superplayback control is always shown in the
right hand column. If you have more than one
superplayback you can set the one to follow by
right-clicking on a LCD window (in the console
screen) and selected ‘Set as default’ from the
popup menu.

Follow steps

Tick this checkbox to make the Step list scroll
so that the current step is always visible.

Dragable playhead

If this option is ticked you can control playback
by clicking on the step bars in the left hand
pane

Control and Playback buttons

To take control of one or more clips, click on them to select them; you can
then:
This button…

does this…

Properties

Displays the selected clip’s properties.

Edit

Opens the selected clip in the programmer

Select

Equivalent to pressing the Select button for the
highlighted clip.
Jumps to the start of the clip
Steps backwards to the previous Step marker of the
selected clip
Pauses playback of the selected clip(s)

Commences (Go) Playback the selected clip(s)

Steps forwards to the next Step of the clip

Jumps to the end of the selected clip.
Release

Releases the selected clip – fixtures return to their
previous settings:

Inhibit

Turns the selected clip off so that fixtures return to the
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This button…

The Playback Control Window

does this…
settings defined by the previous event.

Editing in the Playback control window
There are two ways you change step names, times and end-of-step actions
from within the Playback control window. You can:

•

double-click on the Step Name, Time, At End setting or Notes field and
edit the field directly.

•

right-click on the Step Name, Time, At End setting or Notes field and
select the ‘Edit field of selected step(s)’ option from the popup
window.

To edit a field directly
1.

Double-click on the Step Name, Time, At End setting or Notes field.

2.

Enter a new name, time etc.

3.

Press the Enter key.

To use the Edit field window
1.

Select one or more steps. You can select a range of steps by using the
shift or control key.

2.

Right-click in the field that you want to change. Vista opens the Edit
field window.

3.

Enter a new name, time etc.

4.

Click the OK button.

Customising the Playback control window
You can change the colours and fonts used in either pane of the playback
control window to suit different conditions.
Changing colours
1.

Right-click anywhere in the clip or step pane and select ‘Change
colours’ from the popup menu.

2.

Select ‘Choose main background colour’ or ‘Choose other background
colour’ from the popup submenu to open the Select colour window.

3.

Choose a colour from the basic colours or colour picker.

Changing fonts
1.
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Right-click anywhere in the clip or step pane and select ‘Change font’
from the popup menu.
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2.

Select ‘Choose font’ from the popup submenu to open the Select font
window.

3.

Choose a font, style and size.
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Console layout
The Vista T series consoles and S series control surfaces provide the faders,
encoders, switches and displays you’ll need to control your lighting rig.
The layout of each product is slightly different and the quantity of playback
controls varies but they all provide the same control modules:

Pen tablet module
The Pen tablet module incorporates the main display, display controls,
keyboard and trackpad for the T series consoles. For S series consoles the
main display, keyboard etc are provided as part of the external computer.

Function keys
T series consoles provide twelve user-definable function buttons, located
above the main display. S series consoles provide five function buttons
located at the top centre of the unit. On the Vista PC version, the Function
keys ‘F1 – F5 or F1 – F12’ can be used in place of these buttons.
You can assign many commonly used commands to these buttons so you
have access to that function at the press of a button rather than having to
choose the option from a menu or icon.

126

Vista User Guide, Version 1.13a

Using the console hardware

Function keys

Examples of functions that you might find useful to assign to a function
key include:

•

save show

•

release all active clips

•

clear programmer

•

store the programmer clip.

To assign a function to one of the function keys:
1.

Click the Console button to display the Console screen. The function
keys are at the top of the Console screen.

2.

Click on the ‘Softkey Actions’ heading in the left hand pane.

3.

Click on the required function and drag it on top of the button you
want to use for that function. A tooltip will show what function you
have assigned to the button. Now when you press that hardware
button, Vista takes whatever action you’ve assigned to that key.

The following actions are available:
This action …

does this…

Blank (Button)

The button has no action.

Clear Programmer

Clears the current tab of the Programmer.
You will prompted to save any unsaved
changes.

Close window

Closes the current window.

Toggle SMPTE

Toggles timecode on or off. Clips will not
respond to timecode when disabled.

Extracts Browser

Opens the Components window with
Extracts selected.

Fixture Chooser

Opens the Programmer window in the
Fixture view.

Help

Displays the Vista help files.

Highlight fixtures

Toggles the Programmer’s Highlight fixtures
mode on or off.

Jump

Opens the Jump (to step) window.

Live Time Selector

Opens the Live Time Selector window.

Move to next display

Moves the current window to the next
display. For example move the DMX window
from the tablet display to an external monitor.
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This action …

does this…

Next window

Switches the main display between open
windows.

Preset browser

Stops the clip playback, Intensity is reduced
to 0 and all other parameters revert to their
previous setting. Press the button again to
enable or re-assert the clip.

Release all active clips

Releases all clips, fixtures return to their
default settings.

Save show

Saves the show to disk.

Show console view

Opens the Console window.

Show keypad

Opens the virtual kepad – in the Patch and
Programmer windows.

Store Programmer Clip

Opens the ‘Store to Clip’ window.

The modifier keys
The LR key

The LR button changes a pen tablet tap to a right tap. To ‘right-click’ hold
this button down then tap the pen.
The coloured modifier keys

The coloured (Red, Yellow, Green, Blue) modifier buttons provide alternate
functions while programming and during playback. You can also use
keyboard equivalents in place of the modifiers
When you hold a modifier the playback buttons (Select, Go, Flash) provide
alternate functions as shown below:
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Red
(Shift)

Yellow
(Ctrl)

Green
(Alt)

Blue
(Ctrl + Alt)

Select

Select

Edit

Release

Re-assert

Go (normal)

Pause

Skip Fwd

Skip Back

Jump

Go (split
p’back)

Select

Edit

Release

Flash

Select

Edit

Release

Jump
Inhibit
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Playbacks with faders
These controls are designed to be used when you need to be able to control
the intensity of a clip during playback. They consist of:

•

a Select button – normally used to select the playback

•

a display – used to display the name of the clip or other component
that’s being controlled

•

a Go button – normally used to play the the clip or other component

•

a fader – used to control the intensity of a clip

•

a flash button – normally used to momentarily flash the intensity of a
clip to full.

Playbacks without faders
These controls are designed for simple control of a clip or other component.
They consist of:

•

a Select button – normally used to select the playback

•

a display – used to display the name of the clip or other component
that’s being controlled

•

a Go button – normally used to play the clip or other component.

Page controls
Each playback module consists of 5 playbacks. Clips and other components
can be assigned to these controls as pages. To change pages:

•

press the Page Up button to advance to the next page number

•

press the Page Down button to go back to the previous page number.
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The Super Playbacks controls

These controls provide more extensive control for a single clip. They consist
of:

•

7 playback control buttons - skip to start, skip to end, back, forward,
Go, Pause / Back and Resume.

•

an intensity fader and associated flash button

•

a crossfader and associated enable button.

This button…

does this…
Jumps to the start of the clip
Steps backwards to the previous Step marker of the
selected clip
Steps forwards to the next Step of the clip
Jumps to the end of the selected clip.
Restarts playback on a paused clip
Pauses playback of the selected clip(s)
Commences (Go) Playback the selected clip(s)
Not used

Flash
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Flashes intensity of the super playback clip to the
maximum value.
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This button…

does this…

Crossfade
enable

Enables and disables the crossfader. The led inside the
switch will be red when the crossfader is enabled. In
this mode the crossfader can be used to manually fade
between steps.

Super Playback mode extended controls

These controls are used for both programming and playback. During
playback they are used to provide additional control over a Clip. If the
controls are in Programming mode press the button labeled ‘Playback’ to
switch them. They consist of:

•

twelve function buttons, described below

•

a display – used to display the name of the clip and label the function
button and encoders

•

three encoders

This button…

does this…

Chase on / off

Turns chase mode on or off for the clip currently on
the super playback.

Chs Fwd

Changes the chase mode to run forwards. If the clip is
already chasing forward pressing the button will turn
chase mode off.

Chase Bak

Changes the chase mode to run backwards. If the clip
is already chasing backward pressing the button will
turn chase mode off.

Chase Bnc

Changes the chase mode to bounce (i.e. run from first
to last step then last to first step). If the clip is already
bouncing pressing the button will turn chase mode off.

Chase Rnd

Changes the chase mode to random. If the clip is
already in random pressing the button will turn chase
mode off.

Playback

Press to toggle the controls between Playback and
Programmer mode. When Playback mode is selected
the label changes to be dark text on a white
background.

Load

Press Load and then any button on the playback to
load that Clip to the Super playback controls. If no
button is pressed within 10 seconds the Load button is
cancelled.
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This button…

does this…

Release

Releases the clip. Fixtures return to the previous
settings or to their defaults.

Rate

Press to enable the:
- left encoder for rate control of Effects
- middle encoder for rate control of playback.

Shuttle

Press to enable the middle encoder for manual control
of playback. Move the encoder clockwise to advance
and anti-clockwise to go backwards.

Clear

Press to clear the superplayback controls – the clip is
removed from the controls.

Jump

Used to jump from one step to another step out of
sequence. Press jump then use the third encoder wheel
to select the Step you want to jump to. Press Go to fade
to that step.

Using the keyboard to Jump
During playback you can use the keyboard and the jump window to
quickly select a step and fade it in.
To open the Jump window you can either:
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•

press the Jump button in the super playback, or

•

press and hold a Select button on any playback to bring that clip onto
the super playback (the jump window will open after you start typing
a number), or

•

hold the blue modifier and press the Go button on any playback, or

•

press Ctrl + J on the keyboard, or

•

press the ‘Jump’ function button (if you have assigned it to one of the
softkeys).
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Vista displays the Jump to Step window:

To find the step you want to jump to:

Tip:

•

type the step number or a part of the step name, or

•

use the up and down arrow keys, or

•

click on the step name.

You can also select a different Clip by clicking on the drop down box
To complete the Jump and fade in the selected step;

•

press the keyboard Enter key, or

•

use the Clip’s Go button, or

•

click the OK button.

If you don’t want to complete the Jump immediately click on the ‘Arm &
Close’ button. This closes the window and leaves the clip ready to jump
when you press Go.
Tip:

You can also close the Jump to Step window by pressing Ctrl + J or the
‘Jump’ soft key again.

Configuring the console for Playback
Once you’ve stored a number of Clips, Presets, Extracts, etc, you can assign
those components to the playback controls the way you want them using
Console screen.
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When you click the Console button on the toolbar Vista displays the
Console screen:

With the Component type and set dropdowns in the top-left corner of the
window you can display and filter the components you want to assign. You
can:

•

choose a component type (Clips, Groups, Presets, Extracts, Smart FX,
Snapshots) from the top dropdown

•

filter the list by selecting a set from the lower dropdown. The sets
correspond to any tabs you have created in the Components window.

Assigning a component to the playback controls
Once you’ve selected the component type you want you can drag and drop
it onto the label area corresponding to the console’s LCD windows:

Tip:

You can assign any combination of components to the playback controls –
Clips, Groups, Presets, Extract, Effects, Favourites and Snapshots.

Splitting playback controls
When a component is assigned to a playback it uses all the controls that are
available – the Go and Choose button plus the fader and flash button if
available, but you can split a playback set to increase the number of
components that can be placed on a page.
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To do this, move the cursor to the top of the white label area. When the
pointer changes to a split bar [=], click and drag down:

Playbacks with faders can be split three ways. To do this move the cursor to
the middle of the label area. When the pointer changes to a split bar [=]
click and drag down.
Tip:

You don’t have to split all the playbacks on a page the same way, you can
split on two ways, another three ways and so on.

Expanding playbacks
Playbacks can also be extended to provide more physical button controls
for playback of a clip. Up to five playbacks in the group can control a clip:

To expand a Playback move the cursor to the right side of the label area.
When the pointer changes to a split bar [||] click and drag to the right.
Tip:

You can expand a Playback before or after a Clip has been assigned, but
you can only expand into an area that is not occupied by another
component.

Configuring the playback buttons and faders
Normal, split and expanded playbacks have their buttons and faders set up
with the default configuration. To see how the buttons and faders are
configured press the Help key [!] on T series consoles or the F1 key on a PC.
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Vista displays the button and fader functions on the LCDs and in the
Console window:

You can assign different actions to these buttons and faders to suit your
requirements or playback style.
To assign an action:
1.

Click the Console button to display the Console screen.

2.

Click on the ‘Clip Actions’ heading in the left-hand pane.

3.

Click on the required button or fader action and drag it on top of the
button or fader you want to use for that function.

Some buttons and faders must be used together. For example if you make a
fader a ‘Cross fader’ you should also assign a ‘Toggle Xfader’ button to the
button below the fader. Likewise if you make a fader a ‘Rate fader’ you
should also assign a ‘Toggle rate fader’ button to the button below the
fader.
The following actions are available:
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This action (type) …

does this…

Blank (Button)

The button has no action.

Blank (Fader)

The fader has no action.

Chase Backward
(Button)

Sets the Chase direction to backwards (or
reverse). N.B. if the chase is already running
backwards the button will toggle between
chase off and chase backwards.

Chase Bounce (Button)

Sets the Chase direction to bounce. N.B. if the
chase is already bouncing the button will
toggle between chase off and chase bounce.

Chase Direction
(Button)

Cycles between the available chase directions
in this order: Forward, Backward, Bounce,
Random.
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This action (type) …

does this…

Chase Forward
(Button)

Sets the Chase direction to forwards (the
normal setting). N.B. if the chase is already
running forwards the button will toggle
between chase off and chase forwards.

Chase On/Off (Button)

Toggles between Chase on and Chase off.

Chase Random
(Button)

Sets the Chase direction to random. N.B. if the
chase is already set to random the button will
toggle between chase off and chase random.

Cross Fader (Fader)

Sets the fader to manually crossfade between
steps. Must be used in conjunction with a
‘Toggle Xfader’ button.

Edit (Button)

Opens a Clip, for editing, in the Programmer
window.

Fader (Fader

Sets the fader to control the Intensity of a clip.
This is the default assignment for all faders.

Flash (Button)

Sets the button to momentarily flash Intensity
to full. This is the default assignment for the
square buttons below the faders.

Inhibit (Button)

Stops the clip playback, Intensity is reduced
to 0 and all other parameters revert to their
previous setting. Press the button again to
enable or re-assert the clip.

Jump (Button)

Opens the Jump window. See Using the
keyboard to Jump on page 132.

Latch (Button)

Similar to a flash button but latches on
intensity or off. Press once to turn on press
again to turn off. N.B. Clip properties should
be set to Activate on flash and deactivate on
flash.

Pause (Button)

Pauses playback of a clip.

Play

Plays (starts playback of) a clip.

RateFader (Fader)

Adjusts the playback rate.

Re-assert (Button)

Re-asserts a clip that has been overridden.

Release (Button)

Releases a clip.

Select (Button)

Selects the clip. This is the default assignment
for all * buttons.

Vista User Guide, Version 1.13a

137

Playback status indication

Tip:

Using the console hardware

This action (type) …

does this…

Skip Back (Button

Steps backwards to the previous Step marker
of the selected clip.

Skip Forward (Button)

Steps forwards to the next Step of the clip.

Solo (Button)

Works in the same way as a flash button but
will also reduce the level of all other active
clips to zero.

Solo / Latch (Button)

Similar to a Solo button but latches intensity
on or off.

Toggle Rate Fader
(Button)

Must be used in conjunction with a Rate
fader. Used enables the fader.

Toggle Xfader

Must be used in conjunction with a Cross
fader. Used enables the fader.

You can save the button / fader configuration as a default to be used
whenever a clip is assigned to a playback. To do this right-click on a clip
and choose the ‘Save as default configuration for clips’ option.

Playback status indication
For Clips the LCD and LEDs inside the playback buttons indicate the
current status of each playback as follows:
Normal (2 Button Playback)

Split (1 Button
Playback)

Lower
Button

Button

Upper
Button

Current

LCD
Inverted

Active

Green

Paused

Green
Flashing

Green Flashing

Running

Green

Green

Completed

Red

Red

Overridden

Red
Flashing

Red Flashing

Playback popup menu
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You can make changes to Clips Pages and other components using the
Playback context menu. To open this menu right-click on the label area of
any playback control. Vista displays the context menu:

This option…

does this…

Save as default
configuration for clips

Sets the selected clip’s properties as the
defaults for all new clips.

Assign audio

Opens the Assign audio window see
Assigning audio to a clip on page 117.

Clip Properties

Opens the Clip properties window – see
below.

Rename clip

Opens the rename Clip window.

Edit clip

Opens the Clip in the Programmer window.

Set LCD contrast

Opens the LCD contrast window for the
selected display.

Unlock this control

Unlocks a component that has been locked in
the selected position.

Lock this control

Locks the selected component. Components
that have be locked will not be altered or
replaced when a new Page or Snapshot is
loaded.

Clear item

Clears the selected playback – the assigned
component is removed from the control.

Delete page

Deletes the current page.

Clear page

Clears all playbacks on the current page – the
assigned components are removed and a
blank page is left.
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This option…

does this…

Set default playback
configuration

Sets the selected button and fader
configuration as the default for new
assignments.

Setting clip properties
To set the clip properties, right click on the Clip name and the Properties
option from the popup menu. Vista displays the clip/Playback Properties
window with the General tab selected:
General tab
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This property…

does this…

Name

Sets the name of this clip

Priority

Sets the clip priority. A clip set to High priority
can’t be overridden by normal or low priority
clips.

HTP Intensity

Determines whether or not the intensity
overrides on the faders are calculated using
highest-takes-precedence.

Active HTP

Causes the intensities of a clip’s to activate as
soon as the playback fader is moved from 0.

Go on Fader up

Moving the fader above zero will activate (Go)
the clip

Release on Fader
down

Moving the fader to zero will release the clip
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This property…

does this…

Release all on activate

If on all other active clips will be released
when this clip is first played.

Ignore Release All

The clip will ignore the release all command.

Activate on flash

Activates (plays) a clip whenever you press the
flash button.

Deactivate on flash

Deactivates (releases) a clip whenever the flash
button is released.

Flash level

Scales the Clip intensity when using the clip’s
flash button

Fade all attributes

Allows a Playback fader to control all
attributes. Moving the fader up or down will
cause Intensity, Position Colour, etc to fade in
or out.

Auto-go when paged
in

Automatically activates the Clip when it is
loaded to a playback fader by Page change.

Skip state in jumps

When playback jumps forwards, any events
that lie fully between the old position and the
destination are ignored.

Maintain State

If on, programming tracks forward though
proceeding steps until it is either superceded
or released. If off events are released in the
following step unless they are repeated.

Release when
overridden

If on, clips that are not contributing to the
console’s output are released.

Ignore release in
snapshots

Turn on to prevent a clip from being released
when a snapshot is activated. This property is
turned on automatically when Active HTP is
set to on.

Playback mode

Determines what happens when using Jump.
Normal – restores the tracked state on Jump.
Build – fades direct to destination excluding
information in steps that are bypassed
Video – fades via all events.
.

Default Crossfade
Time

The default time for Jumps & Overrides.

Default Step Duration

The default duration for new steps.
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This property…

does this…

Default end-of-step
action

Sets the default action for steps – Halt or
Follow.

Fade-in time

The duration over which the clip fades-in
when it starts.

Release (Fade-out)
time

The duration over which the clip fades-out
when it is released.

Playback rate %

Playback rate for the clip.

F/X rate thrust %

Smart Effects rate for the clip

Keep non-intensity
static during release

During a release the intensity will fade out
before the other parameters are released.

Auto-lock in page

When on the clip will be locked on the
playback controls and will ignore oage
changes and snapshots, until released.

Chase tab

This property…

does this…

Chase mode

Turns chase mode on/off.

Chase direction

Sets the step order for chases. Can be set to
forward, backward, bounce or random.

Chase rate

Chase rate when in chase mode, expressed as
steps-per-minute.

Chase fade %

Proportion of time spent fading vs. time spent
at each step of a chase.

Timecode tab
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This property…

does this…

Start @ time

Sets the trigger time in Hours, minutes,
seconds or frames.

Sync to Time

Turns on timecode triggering for this playback.
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Group Masters
When a Group is assigned to a playback set, that includes a fader and flash
button, you can use these controls as Group Master intensity controls:

The intensity of the group can be controlled in three ways:
With this Group
master type

you can do this…

Scale ( - )

Reduce the intensity of fixtures in the group.
When a Scale(-) fader is pulled down, while a
clip is being played, the intensity of fixtures in
that group will be reduced.

also known as an
Inhibitive or
Subtractive group
master

Scale ( + )
also known as an
Additive group master

When a Scale(-) flash button is pressed the
intensity of fixtures in that group will go to the
level programmed in the active clip.

Increase the intensity of fixtures in the group.
When a Scale(+) fader is pushed up, while a
clip is being played, the intensity of fixtures in
that group will be increased.
When a Scale(+) flash button is pressed the
intensity of fixtures in that group will go to
100%.

HTP
Highest takes
precedence

Control the the intensity of fixtures in the
group on an HTP basis. If there’s no clip,
containing the fixtures in the group, being
played the fader will set the level of the fixtures
between 0 and 100%.
This is the default fader and flash button
setting for groups.

You can assign different actions to these buttons and faders to suit your
requirements or playback style.
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To assign an action:
1.

Click the Console button to display the Console screen.

2.

Click on the ‘Group Actions’ heading in the left hand pane.

3.

Click on the required button or fader action and drag it on top of the
button or fader you want to use for that function.

The following actions are available:
This action (type) …

does this…

Flash (-) (Button)

Flashes the intensity of the group to the
maximum level programmed in any active
clip.

Flash (+) (Button)

Flashes the intensity of the group to 100%.

Flash HTP (Button)

Flashes the intensity of the group to 100%.

Group Blackout
(Button)

Lowers the intensity of the group to 0% while
the button is held down.

HTP (Fader)

Increase the intensity of fixtures in the group.
on an HTP basis. If there’s no clip, containing
the fixtures in the group, being played the
fader will set the level of the fixtures between
0 and 100%.

Scale(-) (Fader)

Reduces the intensity of fixtures in the group.
When a Scale(-) fader is pulled down, while a
clip is being played, the intensity of fixtures
in that group will be reduced.

Scale(+) (Fader)

Increases the intensity of fixtures in the
group. When a Scale(+) fader is pushed up,
while a clip is being played, the intensity of
fixtures in that group will be increased.

Select (Button)

When the Programmer window is open, used
to select all fixtures in the group. When a
group is selected the Led in the Select button
will be red

Pages
Each Playback Group can be paged independently of the others, allowing
for a wide variety of console configurations. To change pages, press the Up
or Down arrow buttons located to the right of each playback group. On the
console screen you can also select a page from the popup page selector.
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Snapshots

The Page Up and Down buttons work in three ways:

•

press quickly to change the page immediately

•

press and hold, for less than two seconds to display the current page
number, without changing it

•

press and hold, for more than two seconds to scroll the number.

Locking a playback to prevent changing

Playbacks can be Locked to prevent whatever is assigned to that location
being changed when a new page or snapshot is selected.
Components can be locked or unlocked in the Console window. To do this
right-click on LCD, in the Console window, and choose the appropriate
command from the popup menu.

Snapshots
Snapshots allow you to store and recall the exact state of the console’s
output, buttons, faders and other controls. They can be used to quickly reconfigure the controls for playback, programming or a mixture of both. For
example, you may have a snapshot set up for each song or part of a show.
You might also have a snapshot for programming with the playback
buttons assigned to provide quick access to Groups, Presets Extracts and
Effects.
Snapshots can not only recall Page and Clip settings but also the state of the
Clip. For example if a Clip is active and in Step 3 when the snapshot is
recorded then the same state can be recalled.
To record, update or select a snapshot click the Snapshot selector at the
bottom right side of the screen. Vista displays the snapshot popup:

To record a snapshot
1.

Use the console window to assign components and configure the
controls and pages the way you want them to be.

2.

Tick the ‘Snapshot record enable’ checkbox(s) on the sections of the
console that you want included in the snapshot.

3.

The sections you can include or exclude are: the playback set(s), the
superplayback(s) and function buttons.

Vista User Guide, Version 1.13a

145

Snapshots

Using the console hardware
4.

Click on the snapshot selector and select ‘Record new snapshot’ from
the popup menu. Vista displays the ‘Record new snapshot’ window:

This option…

does this…

Name

Create a name for the snapshot

No playback state

The state of clips is not included in the
snapshot. For example a Clip active in Step 3
when the snapshot was recorded will be in a
released state when recalled.
Any clips that are running will not be
released when the snapshot is recalled. This
may mean that those clips are now running
on non-visible pages.

Current page of record- The state of clips on the current page of each
enabled modules
‘Record enabled’ module will be included in
the snapshot. For example if a Clip is active in
This is the default setting
Step 2 when the snapshot is recorded it will
also be active in Step 2 when recalled.
Any clips that are active on modules that
were ‘Record enabled’ when the snapshot
was recorded will be released.
Clips that are active on modules that were not
‘Record enabled’ will not be released.
Entire playback state

The state of all clip except ones being edited
are included in the snapshot irrespective of
whether the ‘record enable’ boxes are ticked.
I.E. clips on all pages plus clips that have
been run from the Playback control window.
All new clips created after the snapshot was
recorded will be released.
If a module is not ‘Record enabled’ the state
of all clips on it is stored. However the page
and clip assignment will not be recalled. This
may mean that some clips are now running
on non-visible pages.
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Tip:

Snapshots

Fader values are not stored in snapshots. Locked components are protected
from any changes by snapshots. If a clip is part of a snapshot and it is also
running on a module that will not be affected by the snapshot there can be
a conflict.
In this situation:

•

if the clip is active on the unaffected module, it is not changed

•

if the clip is inactive on the unaffected module, it is restored to the state
stored in the incoming snapshot (i.e.activated or released).

Recalling a Snapshot

To recall a Snapshot, click on the snapshot selector and choose the required
Snapshot from the popup menu.
Updating a Snapshot

To update a Snapshot:

Tip:

1.

Make sure the snapshot is active.

2.

Change the assignment and state of components and pages as
required.

3.

Click on the snapshot selector and select ‘Update (snapshot name)’
from the popup menu. Vista displays the ‘Update snapshot’ window.
The same options as described above, in the record a snapshot section,
are available.

You can also activate update and rename a snapshot in the Components
window.
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Organising and selecting Components
The Components Window
When you click the Components button on the toolbar, Vista displays the
Components window:

This is where you can select and organize your Groups, presets, Extracts,
Effects, Clips and Snapshots. The window is divided into different areas
that allow you to:

•

choose the type of component you want to work with – Groups,
Presets, Extracts, Effects, Favourites, Clips or Snapshots

•

choose a component and either activate it or modify it in some way

•

create tabs that let you group components into custom sets.

This screen provides quick access to all the elements used for programming
and playback of a show. To choose the component type you use the buttons
at the top of the left column:
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This button…

does this…

Groups

Displays all the groups you’ve recorded, in the right
column.

Extracts

Displays your Extracts.

Canned Effects

Displays your Effects

Favourites

Displays your Favourites.
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This button…

does this…

Clips

Displays your Clips.

Snapshots

Displays your Snapshots

Preset parameter Filter and Fade Time panel

If you are working with Presets the Parameter Filter bar and ‘Fade time For
Presets’ panel can be used to control any preset you store or use:

If you are recording a Preset the filter bar shows which parameters are
being recorded and which are not. You can click on any of the icons to
either include it or exclude it. Excluded parameters are greyed and have a
cross though the icon. For more information about presets and filters see
Creating presets on Page 52
If you are applying a preset that includes more than one parameter type
you can use the filter bar to filter out any parameters you don’t want to use.
For example you might have a Preset that includes Intensity, Position and
Colour but you only want to use the Colour part. In this case you would
click on all the filter bar icons except Colour before selecting the preset.
When you are applying presets from the Components window you can also
set a time for the Preset to fade in. For example you might be working in
the Live programmer tab and want to fade some lights into a colour or
position over several seconds. To do you use the Fade time For Presets
panel:

This button…

does this…

0–9&.

The numeric and decimal point keypad buttons. i.e.
press 2 .5 for a time of 2.5 seconds.

->

Moves the time to the selector column. You can store a
list of favourite times this way.

Clr

Clears the entry box.
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This button…

does this…

Del

Deletes the last number entered.

One-touch
mode

If this check box is ticked the numeric keypad changes
mode. This mode is useful for quickly activating
different presets in different times. Each time you
press a number it replaces the previous value. This
way you can press 5 then a preset to activate it over 5
secs. Then 2 followed by another preset to activate it
over 2 secs and so on. Two new buttons +10 and +50
are enabled in this mode.

/2

Designed for use in one touch mode. Halves the time.
i.e. 1 /2 gives a 0.5 second fade time.

*2

Designed for use in one touch mode. Doubles the time.
i.e. 6 *2 gives a 12 second fade time.

+10

Designed for use in one touch mode. Adds 10 secs to
the time. i.e. 1 +10 +10gives an 21 second fade time.

+50

Designed for use in one touch mode. Adds 50 secs to
the time. i.e. 1 +50 gives an 51 second fade time.

Changing the Components window Mode

The Components window has two modes. In ‘Apply’ mode clicking on a
component will activate it. In ‘Arrange’ mode clicking will only select the
component – you can then select an option such as rename, delete etc. To
change mode click on either the Arrange or Apply button
Components window tools

At the bottom of Components window on the left hand there are 7 button
that act on the component you select:
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This button…

does this…

New

Creates a new component of the selected type.

Edit

Opens the selected component for editing. Applies to
clips, presets and extracts.

Activate

Allows you to activate a component in the Organise
mode

Update

Updates the selected component. Applies to clips,
presets.

Rename

Allows you to rename a component.
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This button…

does this…

Delete

Allows you to delete a component.

Duplicate

Allows you to create a copy of a component with a
new name.

Organising Components
At the top of the Components window there is at least one tab marked ‘All’
and there may be others, depending on what component type is selected.
For example if Presets is selected there are several tabs entitled ‘Intensity,
Position, Colour etc’. The All tab always contains all the components of the
chosen type that you have created. The other tabs are filtered and contain
just the components that contain a matching parameter type. For example
The ‘Colour’ tab will show any component that contains colour information
– a preset, extract, effect etc. If a preset or any other component contains
information for more than one parameter it will automatically appear in
any corresponding tabs.
Likewise if you create a new component when you are in one of the
Intensity, Position, Colour, … pages it will automatically be filtered to just
store the corresponding information.
In Arrange mode you can drag and drop components from the All tab to
other tabs so you can arrange your components in a meaningful way. You
can also drag items into different columns or positions.
Tip:

You can also re-arrange components, in ‘Apply’ mode, by holding down
the Green modifier (Alt in Windows, Option on Mac) and dragging the
component.

Working with Component tabs
To add another tab, right-click in the area to the right of the existing tab
and choose the Add tab option. This creates a new tab along the top of the
Components window. To rename the tab, click on it and enter a title.
To set the filtering of any tabs you create:

1.

Set the filter bar to show some or all of the 6 parameter types

2.

Right-click on the tab and select ‘Set current mask as default’ form the
popup menu.
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Monitoring what is going on
When you click the Screens button on the toolbar and select the Output
option, Vista displays the Output window in icon view:

You use this screen to display the state of fixtures that are active – that is
fixtures that have one or more parameters that are being controlled by the
playbacks. The window is split vertically with multi-parameter fixtures
displayed in the top pane and conventional fixtures (i.e. dimmers only)
being shown in the lower pane.
Tip:

To close the Output window, click the small ‘X’ box in the top-right corner
of the screen’s title bar. You can also resize this window by clicking on the
bottom right corner and dragging to a suitable size.
If you have external monitors attached, you can move the Output window
to one of the by clicking on the title bar (blue area) and dragging. Use the
touchpad to move the cursor to the external screens.
The Output window includes a drop-down menu that displays the Output
information by, icon, text or source. The Output window set to Text view is
shown below:
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The text view shows the actual values of the parameters. If a parameter is
set to a preset value, the name of the preset will be displayed rather than
the value.
The Output window set to Source view is shown below:

The Source view shows the source of control for each of the parameters. For
example if a fixture’s colour settings have come from a clip named
‘Rainbow’, that name will be displayed in the Colour column for that
fixture.

Using the Output window
The Output window provides some additional options that let you finetune the display and help identify particular fixtures

Scroll down the list until you find the fixture you want.
Sorting the Fixture List

If you tick on the ‘Follow Selection’ checkbox, fixtures that are selected in
the Programmer Fixture window move to the top of the list in the selection
order. Click the reset button to put the fixture list back to ID order.
Setting the rate

You use the Rate slider to adjust how frequently the Output view updates.
Move the slider to the left to slow the update rate and to the right to
increase the update rate. On large shows with many fixtures and clips the
Output window can use considerable system resources if set to the fastest
refresh rate.

Chosen clip
To see what’s being controlled by a particular playback fader, press the
Choose button. The Output window then displays any information coming
from that clip in green.
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The Output window then displays any information coming from the
programmer in Blue.

Context Menu
If you right click in an active cell on the Output window, Vista displays a
pop-up menu:

Select

Chooses the playback that is currently controlling this feature.
Edit

Opens the clip that is currently controlling this feature in the Programmer.
Release

Releases the playback that is currently controlling this feature.
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Selecting fixtures
If you click in the ID or name cell of a fixture in the tracking view window,
Vista selects that fixture or adds it to the existing selection.

Using the DMX Window
When you first click the Screens button on the toolbar and select the DMX
option, Vista displays the DMX Output window:

You use this screen to display the output values of each and every DMX
channel. The main window is divided into cells representing the 512
channels available on each DMX output. The cells are black if there is no
output and change from dark to light blue as the output value increases. To
display another output simply click on one of the other Universe tabs at the
top of the display.
Tip:

If you have external monitors attached the DMX window can be moved to
one of these displays by using the ‘Move to next display’ softkey. This
button is normally assigned to F10 on a T4/T2.
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The DMX window includes a drop-down menu so you can view the DMX
information in a more detailed list view. The DMX window set to detailed
view is shown below:

The detailed view displays each channel on a separate line. In this view you
can see the Fixture Name, ID, Type, Parameter Type and value.

DMX window features
The DMX Output window provides some additional options so you can
fine-tune the display:

View

View options are detailed above – Normal or Detailed
Format

The format optional allows you to display output levels as either a
Percentage (0 – 100%) or as an 8-bit value, between 0 and 255
Fixed Width

If this box is not ticked the Output window will automatically resize as the
window is resized. For example if the window is made smaller, fewer cells
will be displayed across the screen. If the box is ticked the window will
always display the specified number of cells, across the screen, and it may
be necessary to use the horizontal scroll bar to see all the cells.
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Width

The value in this box sets the number of cells that displayed across the
screen. You can either type a number in this box or use the small up and
down arrows to adjust the value.
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Setting preferences
Using SMPTE/timecode
If you are going to be running the Vista in conjunction with a device that
generates SMPTE timecode, you can simulate the timecode so you can get
your show running in time without needing the actual timecode from the
other device.
To set up the timecode:
1.

Choose the SMPTE/timecode panel option from the Show menu. Vista
displays the timecode panel window:

2.

Set the Frame rate and check the Drop Frame option if applicable.

3.

Hit the Start button to start the timecode running and the Stop button
to stop it. The Time Code field shows the elapsed time, and hitting the
Reset buttons clears this field.

4.

To close the window, click the ‘X’ symbol in the top right corner.

Timecode dropouts
The Freewheeling time field is used to cope with errors in the SMPTE code
coming from an external device such as a Tape player. When Vista
encounters a SMPTE error it will simulate timecode for a period before
assuming the timecode has ended. This field sets the number of seconds
Vista will allow to pass while it simulates SMPTE until it relinquishes
control.
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Disabling all timecode

To disable timecode for all clips, choose the Disable All Timecode option
from the Vista menu. This can be useful is you want temporarily to stop
timecode from triggering your clips.

User preferences
There are a number of system settings that determine how the Vista
operates that you can change if you like. To set these preferences, choose
the user preferences option from the Show menu. Vista displays the User
Preferences screen with the ‘General ‘tab selected.
General preferences

This option…

does this…

Enable Pen-tip button

Switches on or off the button on the pen that
you use to display the ‘right-click’ pop-up
menu.

(n/a in PC version)
Auto-save interval

Sets the number of seconds that will pass
between each automatic save of your current
show. For instance, if you set this to 60, Vista
will do an auto-save every sixty seconds.
If you set this to zero, Vista does not do
automatic saves.
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This option…

does this…

Auto-save prompt

Sets whether or not Vista displays a prompt
asking you if you want to do an automatic
save. If this is off, Vista automatically saves in
the background at the interval specified in the
Auto-save interval field.

Audio Volume

Sets the Audio output level.

(n/a in PC version)
Maximise windows

Sets the behaviour of the overlay windows
(Output, DMX etc). With maximise set to ‘on’,
the windows open full-screen.

Sticky windows

Sets the behaviour of the buttons located above
the tablet when they are used to open the
Components, DMX and Output windows. If
‘Off’ you have to hold the down to keep the
window open; if ‘On’ the button toggles the
window open and closed.

Strike Macro
Minimum interval

Sets the minimum interval, in milliseconds,
between fixtures being struck. When multiple
fixtures are selected this setting creates a delay
between each fixture striking.

Release-all on page
change

Releases all running clips when you change the
current page/snapshot.

Serial Port

Sets the serial port configuration (I.E. 8N19600). Leave the field empty, or set it to
'disabled' to disable serial port control. Vista
supports the following baud rates:1200, 4800,
9600, 19200 & 56000. If you change this you
have to restart to make the change take effect.

Screensaver wait time

Time in minutes until the screensaver starts.
Set to 0 to disable screensaver.

n/a on PC version
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Network preferences
To set the networking preferences click the Network tab on the User
Preferences screen:

This option…

does this…

DHCP

Allows Vista to obtain an IP address and other
parameters from a DHCP server.

IP Address
(n/a in PC version)

Sets the IP address of the Vista console, e.g.
192.168.0.65

IP Net mask
(n/a in PC version)

Sets the subnet mask for the IP address, e.g.
255.255.255.0

IP Gateway
(n/a in PC version)

Sets default gateway for the Vista. Used when
the destination address belongs to someplace
outside the local subnet.

VNC Password
(n/a in PC version)

Sets the password required to connect to the
console via VNC.

WYSIWYG host
address

Sets the address where Vista will try to find a
WYSIWYG host. Should be on the same subnet
as the console, e.g. 192.168.0.10

Broadcast Artnet

When Broadcast Artnet is On any universe that
is not connected to an output (DMX port etc)
will be broadcast over ethernet.
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Programmer preferences
To set the editor preferences click the Programmer tab on the User
Preferences screen:
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This option…

does this…

Default colour
mechanism

Sets the default colour mechanism Vista uses
when managing lights with colour wheels and
colour mixers:
•

Automatic – uses the colour
wheel for Lee colours and
mixing for HSV

•

Prefer Mixer – uses colour
mixing unless you select a
colour wheel frame or colour

•

Prefer fixed - uses the fixture’s
colour wheel whenever
possible.

Crossfade HSV fast

Determines whether or not a crossfade goes
through the intervening hues (off) or jumps
directly to the specified colour (on).

Disable HSV
matching

Vista uses colour calibration data to help match
colours between different fixture types. The
data is only available for certain fixtures. Turn
this setting On to bypass the colour calibration.
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This option…

does this…

Programmer priority

Determines whether clips loaded in the
programmer have high or normal priority.
When set to ‘high’, any changes you make in
the programmer while a clip is playing will
override the normal playback.

Wheel Sensitivity

Specifies the number of turns of encoder
wheels needed to cover the full range of the
assigned parameter (a larger number results in
finer control) Normally set to 2.

Preview Fixtures

Determines whether the Programmer Fixture
window icons display Intensity, Colour,
Position and other settings.

Background click
deselects fixtures

When this is set to ‘on’, tapping on a blank
space in the Programmer Fixture window deselects all fixtures.

Step Label Format

Specifies the format of step labels in the
programmer. The ‘$’ symbol is replaced by the
step name, and the ‘#’ symbol is replaced by
the step number. For example, given a step
named ‘Sunrise’ numbered ‘1.1’, the format ‘[#]
$ ‘ results in the label ‘: [1.1] Sunrise’.

Split Step Creation

Specifies whether the new step is created to the
left or right when you split a step.

Default Step Name

Specifies the default name for steps created in
the programmer.

Default Step
Increment

Specifies the default increment between step
numbers. Normally set to 1.

Inhibit Inapplicable
Events

If enabled, Vista won’t create events that the
selected fixtures can’t perform. Inapplicable
controls will be disabled.

Hide Inapplicable
Events

If enabled, Vista hides events for parameters
that a fixture can’t perform. Note that this does
not affect event creation; see Inhibit
Inapplicable Events.

Auto blind Live Tab

Automatically sets the Programmer Live tab to
‘Blind’ whenever it is not selected. Useful when
reviewing clips that have been exported from
the Live Programmer.

Disabled Programmer If On, Super-playback intensity faders are fixed
Intensity Faders
at full when in programmer mode.
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This option…

does this…

Display Raw
channels in percent

Normally raw setting are shown as a value
between 0 and 255. Set this option on to show a
percentage (0 – 100%) instead.

Display values above
controls

Set this option on to display editable value
fields above the sliders in the Programmer
intensity, colour and beam palettes.

Clear uses Live Time

If On clearing the live programmer or a clip
under edit will release the clip over the time set
by the live time selector.
The release time will be no shorter than the
‘minimum fade-time’ preference – see below.

Minimum clear fadetime

Sets the minimum fade time for the live
programmer or a clip to release.. This value
can be overridden by the Live Time Selector

Don’t release clips
when closed

If on clips that are in the programmer but not
being played back will not be released when
closed.

Start Edit mode

Sets whether the programmer will open in
Normal or Free mode.

Clip preference

This property…
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does this…
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This property…

does this…

Name

Sets the default name for new clips.

Priority

Sets the default priority for new clips. A clip
set to High priority can’t be overridden by
normal or low priority clips.

HTP Intensity

Determines whether or not the intensity
overrides on the faders are calculated using
highest-takes-precedence.

Active HTP

Causes the intensities of a clip to activate as
soon as you move the playback fader from 0.

Go on Fader up

Moving the fader above zero will activate
(Go) the clip

Release on Fader down

Moving the fader to zero will release the clip

Ignore Release All

The clip will ignore the release all command.

Activate on flash

Activates (plays) a clip whenever you press
the flash button.

Deactivate on flash

Deactivates (releases) a clip whenever you
release the flash button.

Flash level

Scales the Clip intensity when using the clip’s
flash button.

Fade all attributes

Gives the Playback fader control of all
attributes. Moving the fader up or down will
cause Intensity, Position, Colour, etc to fade
in or out.

Auto-go when paged
in

Automatically activates the clip when it is
loaded to a playback fader by Page change.

Skip state in jumps

When playback jumps forwards, Vista
ignores any events that lie fully between the
old position and the destination.

Maintain state

The programmed state tracks forward
through subsequent steps until superseded or
released.

Release when
overriden

Releases clips when they are no longer
contributing to the output.
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This property…

does this…

Playback mode

Determines what happens when using Jump.
Normal – restores the tracked state on Jump.
Build – fades direct to destination excluding
information in steps that are bypassed
Video – fades via all events.

Default Crossfade
Time

The default time for Jumps & Overrides.

Default Step Duration

The default duration for new steps (in
milliseconds).

Default end-of-step
action

Sets the default action for steps – Halt or
Follow.

Fade-in time

The duration over which the clip fades-in
when it starts (in milliseconds).

Release (Fade-out) time

The duration over which the clip fades-out
when it is released (in milliseconds).

Playback rate %

Playback rate for the clip.

Information about your Vista software
The ‘About Vista’ window displays the following information:

•

Vista application version number

•

Fixture library version number

•

Firmware version number

•

console’s channel limit, as determined by the dongle.

If a show is loaded, this window also shows the application version
number in use when the show was last saved.

Setting Desklight & LCD Contrast settings
There are settings for the Desklight(s) intensity and the Intensity and
Contrast on the small blue LCDs. To set these preferences, choose the
Desklights and Contrast option from the Vista menu.
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Vista displays the Desklights and Contrast window:

Drag the sliders to set the required Intensity and Contrast.

Changing the console configuration
Vista automatically detects the console type and any wings you have
connected when the programme starts up. You can also change the console
configuration manually if you are working offline or want to add a virtual
console.
To do this select the ‘Change console configuration…’ option from the Vista
menu. Vista displays the console configuration window:

Tip:

You can also display the ‘Console configuration’ window at any time by
right-clicking in the Console window.
Select the console type that you want to add. New consoles appear in the
console window.
If you are using multiple consoles only one Grand master can be active.
You can set which console has the Grand Master by checking the ‘GM
enable’ checkbox at the top of the console window.
You can delete a console by clicking on the ‘Delete’ button at the top of the
console window.

Calibrating the Pen (consoles only)
Sometimes you may have to re-calibrate the pen. To begin calibration,
choose the Calibrate Pen option from the Vista menu and follow the onscreen prompts.
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Using the screensaver
Vista includes a screensaver that also turns off the backlighting on the
small blue LCDs. To start the screensaver manually, choose the Start
Screensaver option from the Vista menu. You can set the screensaver delay
time in the User Preferences, General tab.

Using another language
Vista includes a number of alternate languages. To change language,
choose the Change language option from the Vista menu.

Change the Fixture Library
Vista allows you to save alternate versions of the fixture library. For
example you can save a library that only includes the fixtures you have
patched. To change library, choose the Change library option from the
Vista menu.

External window utility
Occasionally shows may appear to lose windows that were on external
monitors. To reset these windows, choose the Recover External Windows
option from the Vista menu. The windows will be relocated to the main
tablet LCD where you can close or move them as required.

Date and time
Vista displays the time in the title bar of the Patch, Console, Programmer
and Components windows. If you move your cursor over the time it
converts to show the date. On T-series consoles you can set the date and
time by clicking on the time to open the ‘Set time and date ‘ window. On
PC systems the operating system software sets the date and time.
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Patch screen menus
View menu
This menu has one option, ‘Short Names’. Selecting this displays the
abbreviated versions of the fixture names. Select it again to display the full
names.

Edit menu

This option…

does this…

Undo (Ctrl+Z)

Cancels your last action.

Redo (Ctrl+Y)

Repeats your last action.

Delete (Del)

Deletes the selected fixtures.

Unpatch

Unpatches the selected fixture and moves it to
the fixture pool

Copy (Ctrl+C)

Copies the selected fixtures.

Paste (Ctrl+V)

Pastes a copy of the selected fixture(s).

Rename

Displays the Rename window so you can give
the selected fixture a name.

Renumber

Displays the Renumber window so you can
change a fixture’s ID number or set the starting
number of a group of selected fixtures.
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This option…

does this…

Multi-patch

Displays the Multiple patch window for adding
fixtures with the same ID.

Export patch…

Displays the Export patch window.

Import patch…

Displays the Import patch window.

Control menu

This option…

does this…
Strikes the selected fixtures.

Strike
Douses the selected fixtures.
Douse

170

Reset

Resets the selected fixtures to their default
settings.

Home

Sends the selected fixtures to their home
position.

Park

Parks the selected fixtures so they won’t move
from their current position.
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Programmer screen menus
Clip / Live menu

This option…

does this…

New blank clip

Creates a new clip, opening the timeline
window.

Export to new clip
(from Live tab only)

Exports the contents of the Live tab to a new
Clip.

Open Clip

Opens an existing Clip

Open Clip Blind..

Opens an existing Clip in Blind mode

Close

Closes the selected Clip.

Close all clips

Closes all open Clips

Clear (Live only)

Clears the Live programmer

Clear selected fixtures

Clears all settings from the selected fixtures

Update

Opens the update window so you can choose to
update either a clip and / or any presets in use

Relocate tracks

Opens the Relocate Tracks to new Clip window
so you can move all programming for fixtures in
that track to a new Clip – see Appendix

Store Live…

Opens the Store to Clip dialogue

(Shift + Enter)
Store Clip

Saves changes to the current clip.

Store Clip As...

Displays the Store Clip As window so you can
name and optionally assign a clip to a location
on the console.

(Ctrl+Shift+S)
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This option…

does this…

Store All

Saves all open clips.

Exit

Exits the Programmer window.

Edit menu

This option…

does this…

Undo (Ctrl+Z)

Cancels your last action.

Redo (Ctrl+Y)

Repeats your last action.

Cut (Ctrl+X)

Cuts the selected events.

Copy (Ctrl+C)

Copies the selected events.

Paste (Ctrl+V)

Pastes the selected events to the point on the
timeline marked by the left-hand yellow marker.

Paste Special

Displays the Paste Special window so you can
choose which attributes of the event you copied
to paste.

(Ctrl+Shift+V)
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Delete (Del)

Removes the selected event from the timeline.

Select All (Ctrl+A)

Selects every event on the timeline.

Select similar

Selects every event that has similar
characteristics (e.g. start and end points).

Clip Properties

Displays the Properties window so you can
make adjustments to the selected clip that
override the system preferences (see Clip
preferences)
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Fixtures menu

These options are duplicates of the icons on the toolbar. See Programmer
screen toolbar.

Step menu

This option…

does this…

Prev Step (Ctrl+Left)

Jumps to the start of the previous step on the
timeline.

Next Step
(Ctrl+Right)

Jumps to the start of the next step on the
timeline.

Insert step

Inserts a step at the point marked by the yellow
diamond markers.

Delete step (Ctrl+D)

Deletes the selected step.

Split at cursor

Splits the selected steps at the point marked by
the yellow diamond markers (see Splitting steps).

Vista User Guide, Version 1.13a

173

Programmer screen menus

Appendix 1, Menu & toolbar reference

This option…

does this…

Split at Playhead

Splits the selected steps at the point marked by
the green playhead marker line

Clear Contents

Clears everything in the currently selected step
(the grey area on the timeline scale).

Renumber Steps

Opens the Step renumbering dialogue box

Tools menu
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This option…

does this…

Insert Commands

Displays the Insert commands window. This
enables activate other clips or actions.

Insert ‘Mark’ Step

Displays the Insert Mark Step window. This
enables you to move fixtures when their
intensity is at zero so they’re in the right position
when they turn on.

Grab active (Ctrl+G)

Grabs the active attributes of any clips currently
playing (see Grabbing )

Grab full (Ctrl+F)

Grabs all the attributes of any clips currently
playing (see Grabbing )

Align start

Aligns the start points of the selected events.

Align end

Aligns the end points of the selected events.

Chain

If you have several events selected, this option
joins the beginning of the second to the end of
the first, and so on, so they play in sequence.
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This option…

does this…

Insert marker

Insert a marker on he timeline.

Remove markers

Removes any markers in the selected area of the
timeline.

Associate

If you select multiple events of any kind this
option combines them all into one so you can
make large-scale changes to the timeline on
multiple events.

UnTrack events
(step only)

Undo the effect of the selected events in the
following step. Equivalent to ‘Cue-only’

Trim unselected
events

Delete all events, that are not selected, in the
current step

Block state of current
step

Copy all tracked information to the current step

Unblock Clip

Removes any redundant programming from the
clip

Markers to Steps

Converts makers in an empty step to steps

Learn Timing

Opens the Learn Timing window so you can set
step start times by pressing the Go button at the
required time.

Highlight

Opens the Highlight window so that you can set
or modify the Highlight preset
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View menu

This option…

does this…

Timeline

Switches the programmer to the Timeline view

Fixture Chooser

Switches the programmer to the Fixture view

Step List View

Switches the bottom panel of the programmer to
the Step List view (see Managing steps in the Step
list view).

`
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Control panels

Displays the various palettes and windows.

Fixture arrangement

Opens the fixture arrangement sub-menu so you
can switch to a table or icon view and arrange
fixture icons

Normal

Resets the timeline view to the default zoom.

Fit to window

Displays the entire timeline in the window at
once.

Fit to step

Zooms the timeline window to show only the
current step.

Fit to selection

Zooms the timeline window to show only the
selected step.

Zoom in ( + )

Increases the magnification level of the timeline
window, decreasing the number of visible steps
but showing more detail.
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This option…

does this…

Zoom out ( - )

Decreases the magnification level of the timeline
window, increasing the number of steps visible
and decreasing the level of detail.

Timeline autozoom

Opens the autozoom sub-menu so you can set
the timeline to automatically zoom to either:
Whole step – fits the step in the window, or
Active part of step – shows all events in the step
but excludes blank space at the start or end.

Snap to grid

Turns on the snap function so that events will
automatically snap to the timeline grid.

Timeline Grid

Displays the Grid interval window so you can
define the width of the timeline grid in
milliseconds.

Set timeline origin

Sets the start point (zero seconds) of the timeline
to either the start of the selected step, selected
clip, or to the cursor point.

Show Audio Bar

Shows or hides the Audio bar on the timeline. To
move the audio bar along the timeline, hold the
yellow modifier (Ctrl) while dragging it.

Toolbars
Patch screen
This icon…

does this…
Ignites the lamp(s) in the selected fixture(s).
Switches the lamp(s) in the selected fixtures off.
Resets the selected fixtures to their factory
default settings. This is useful if a fixture has a
control problem and you need to get it ‘back to
normal’.
Puts the fixture back to its home position.
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This icon…

does this…
Parks the fixture permanently in whatever
setting it’s currently in. This is useful for
providing permanent fixtures for backstage,
orchestra pits and so on. Once you’ve parked a
fixture it will ignore any further instructions you
give it.
Deselects whatever is selected and Selects the
next fixture in this universe.
Selects the previous fixture in this universe.

Highlight

Switches the selected fixture on. This is a toggle
switch – while it’s selected, Vista switches on
fixtures as you select them.
Displays the Connect Universes screen so you
can attach external Ethernet-DMX interface
boxes. See Configuring external Ethernet-DMX
interfaces.

Programmer screen
This icon…

does this…
Displays the list of summary options (see
Using the summary views).
Cuts the selected events.
Copies the selected events
Pastes any cut or copied events at the point on
the timeline marked by the left-hand yellow
triangle marker.
Delete the selected events
Undo (Ctrl+Z)/Redo (Ctrl+Y)
Previous/Next fixture selection. Vista
remembers the last set of fixtures you selected;
you use these icons to toggle back and forth
between these selections.
De-selects all currently selected fixtures.
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This icon…

Toolbars

does this…
Selects every fixture.
Inverts the fixture selection (i.e. all selected
fixtures are de-selected and all de-selected
fixtures are selected).
Selects all the active fixtures (i.e. those in use
in the current clip).
Select all the fixtures that are programmed in
the current clip.
Align start/end. Align the start or end points
of the selected events.
Displays the Grab drop-down so you can grab
either active or full events of the clip currently
playing (see Grabbing ).
Displays the Effects window (see Using effects).
Displays the Sort window (see Selecting and
sorting fixtures in the timeline).
Displays the Active filter window.
Displays the Update (Clip / Preset) window
Toggles between the highlight modes. When
on the icon has a magenta background.
Steps forward or back through the steps on the
timeline.
Displays the list of actions available at the end
of a step: halt or follow on (see Setting the end
of step instructions).
Displays the list of fade path options (see
Setting the fade path).

[

]
Vista User Guide, Version 1.13a

Displays the start time of the selected event in
hours, minutes, seconds and hundredths of
seconds.
Displays the duration of the selected event.
Displays the end point of the selected event.
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This icon…

does this…

New Group

Creates a new fixture group containing all the
currently selected fixtures.

Update Group

Updates the current group to contain
whatever fixtures are selected.

Delete Group

Deletes the selected group.
Displays the list of available views.
Clears the Live tab or closes an open clip.

Clear / Close
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Appendix 2, Installing new software
Erase and reinstall the software on a T or I series console
Before you perform a clean install from a CD or USB storage device you
should back up all your show data (the contents of the /data/ directory) as
it will be completely erased during the installation process. To do this, you
can either manually export each show to a CD or USB storage device using
the Vista -> Export menu, or use FTP to remotely transfer your files from
the console. The procedure for using FTP is described below
To completely reinstall the operating system and all files on the hard drive:

Tip:

1.

Backup any required show data from the hard drive.

2.

Connect a bootable USB storage device containing the installer to a
free USB port or insert an installer CD into the T series consoles’ CD
ROM drive. Leave the armrest open.

3.

Shut down the console.

4.

Restart console. The console will boot from the either the CD or USB
device.

5.

Follow the installer prompts to perform a clean install (on a T series the
pen cannot be used - use the touchpad instead). Installation takes
approximately 10 minutes.

6.

When prompted click OK to finish. Leave the T series armrest open at
this stage and remove the CD when it is ejected. If you are using a USB
device remove it. The console will shutdown by itself.

7.

Restart the console, the CD ROM will close and Vista will start
normally and run the new software version.

This procedure completely reinstalls the operating system and all files on
the hard drive, which takes approximately 10 minutes to complete. All
show data on the hard drive will be lost!

Installing software updates
The Vista software consists of the following three components:

•

Application

•

Fixture Library

•

Drivers.

To view the current installed version of each component select ‘About
Vista’ from the Vista menu.
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If required, software update files can be downloaded from the Jands web
site. Burn the file(s) to a CD (standard data CD, ISO9660 format) using
common CD burn software or copy the files to a USB storage device or
upload the files to the console using FTP.
To upload software update files to the console through an Ethernet
connection from a computer:
1.

Select ‘User Preferences’ from the Vista menu and note the console’s IP
address.

2.

On the computer start an FTP client (eg. Internet Explorer 5.0, Fetch) to
the consoles IP address (eg. ftp://192.168.0.65/), username = vistaupdate, password = update.

3.

This will display the /vista/update directory. Copy the software
update file(s) *.tgz to this directory on the console.

Once the software update file(s) is on a CD, USB storage device or on the
console’s hard drive, apply the update to the console;

Tip:

4.

Select ‘Check For Updates’ from the Vista menu.

5.

Select ‘Update from CD’, ‘Update from USB’ or ‘Update from FTP
upload directory’.

6.

Open a *.tgz file.

7.

Tick the required software component(s) to update and follow the
prompts.

Installing updates does not overwrite the show data on the hard drive.

Connecting to the console via FTP
You can take advantage of the Vista’s built-in FTP server to move files from
a Mac or PC to the Vista or vice versa using FTP (File Transfer Protocol, a
common method of file transfer).

Hardware Setup
Connect the console and computer to an Ethernet hub or switch using a
standard Ethernet cable, or connect the two devices to each other using a
crossover Ethernet cable.

Vista Software Setup
Open the User Preferences from the Vista menu, select the General tab and
check the ‘IP Address’ setting. If the IP address is already set, make note of
the address and close the Preferences. If there’s no IP address or it’s set to
0.0.0.0, you’ll need to assign one. The address is four groups of numbers
from 0 to 255, all connected by periods. Typically, you’ll use an IP
addresses starting with 192.168 (e.g., 192.168.0.65).
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Computer Software Setup
Check that the computer’s TCP/IP properties are set to a different IP
address in the same subnet (192.168.0.100, for example). The subnet mask
should be, 255.255.255.0.
If necessary refer to your computers documentation for how to set the IP
address.

Using FTP
On the computer start an FTP client such as Filezilla, FTP Commander or
CuteFTP and open a connection to the consoles IP address (192.168.0.65).
The connection requires a username and password as follows:
Username: vista-user
Password user
If you use a graphical FTP client such as those mentioned above the
contents of the consoles Show Data directory and sub folders will be
displayed in a window such as this:.

Files can now be transferred to and from the Vista by dragging them
between the Vista ( ‘remote site’ window) and the PC ( ‘local site’ window).
Tip: If the console is not booting properly it maybe possible to copy files
using this method.

Vista User Guide, Version 1.13a

183

Connecting to the console via FTP

Appendix 3, Creating a bootable USB device

Appendix 3, Creating a bootable USB
device
Major upgrades, that require the console’s hard drive to be erased, can be
installed from a suitably formatted USB device. To create a USB FlashDrive
that can be used to reinstall the operating system and Vista software on a T
or I series console follow the steps below.

Creating a bootable USB drive
All I series consoles are supplied with a USB flashdrive that can be used to
boot the console and re-install the software.
If you want to replace the supplied unit you’ll need a 512MB or larger USB
Flash drive and it has to be converted into a Linux system disk. This
procedure will erase all data on the FLASH drive and format it.
Once the FLASH drive has been converted, or if you have the original USB
flashdrive supplied with your I3 you can use it for future updates. In this
case skip to step 7.
1.

Download the latest console ISO installer

2.

Open the console ISO image file. To do this, either:

•

Burn an ISO CD using the normal Vista ISO disk burn procedure.
Leave the CD in the drive and note the drive letter assigned to the CD
eg “D”.

Or,

•

Open the ISO image using a ISO file extractor programme such as
WinRAR.

3.

Copy syslinux.exe to a temporary location on the hard drive.

4.

Right-click on the USB Flash drive and selecting the “Format” option
from the popup menu. Take care that you have selected the Flash
drive. If you select your computers hard disk, by mistake, you could
erase it completely.

5.

Ensure the File System option is set to FAT32 before clicking the
“Start” button.

6.

Note the drive letter assigned to the Flash drive by Windows eg “E”.

7.

Open a command prompt and using the drive letters previously noted,
type the following:

[drive letter\path]:\syslinux –ma [Flash Drive letter]: –f
Example
184

Vista User Guide, Version 1.13a

Appendix 3, Creating a bootable USB device

d:\syslinux –ma E: -f
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for a CD as “D” drive,

or
c:\temp\syslinux –ma E: -f if you copied the syslinux.exe to
a temp directory on your hard drive.
8.

Copy the files to the FLASH Drive: To do this type the following at the
command prompt:

copy [drive letter\path]:\*.* [FLASH drive letter]:\
copy [drive letter\path]:\isolinux\kernel [FLASH drive
letter]:\
copy [drive letter\path]:\isolinux\initrd.gz [FLASH drive
letter]:\

For example:
copy D:\*.* E:\
copy D:\isolinux\kernel E:\
copy D:\isolinux\initrd.gz E:\

Tip

The files can also be copied using the Windows file manager direct from
the CD or WinRAR.

Note

Some of the files are large and can take some time to copy.
The FLASH Drive is now ready for use.

Troubleshooting
Note that the BIOS settings on older consoles may need to be changed to
allow them to boot from the USB FLASH Drive.
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Appendix 4, Using VNC on T & I series
consoles
VNC password
The default password for VNC connections is ‘password’ You can change
this in the Network tab of the User preferences window. For details see
Network preferences on page 161 :

Starting VNC
To start the VNC server on a Vista T series or I series console:
1.

Restart the console. When the red Boot Menu screen appears press any
key to stop at this window. Then use keyboard arrow keys to select a
startup option. Select ‘VNC’ to start VNC normally or select ‘VNC
1024x768’ to start VNC and set the screen resolution to 1024x768 pixels.

2.

Vista will automatically start the VNC server.

3.

Vista is now running the VNC server

Connecting to Vista using your Windows PC
The following procedure is for the VNC Viewer application from Real VNC
(http://www.realvnc.com/download.html). Other VNC clients for
windows work in a similar way:
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1.

Check that the Vista and your PC are on the same subnet. I.E. if the
Vista’s IP is 192.168.0.68, your PC should be 192.168.0.xxx (where xxx is
1-254 but not 68).

2.

Start the VNC client.

3.

In the ‘Connections Details’ window click the Options button, then the
Misc tab:

Vista User Guide, Version 1.13a

Appendix 4, Using VNC on T & I series consoles

Connecting to Vista using your Mac

4.

Tick the box marked ‘Shared Connection (do not disconnect other
viewers)’. Click OK to close the options window.

5.

In the ‘Connections Details’ window enter the Vista IP (i.e.
192.168.0.65).

6.

Click OK to open the login window.

7.

Enter your password and click OK (leave the username blank).

You should now be able to control the Vista.

Connecting to Vista using your Mac
The following procedure is for the Mac VNCViewer v2.01.
(http://homepage.mac.com/kedoin/VNC/VNCViewer/index.html).
Other VNC clients work in a similar way:
1.

Check that the Vista and your Mac are on the same subnet. I.E. if the
Vista’s IP is 192.168.0.68, your PC should be 192.168.0.xxx (where xxx is
1-254 but not 68)

2.

Start the VNC client.

3.

In the ‘Open Display’ window tick the box marked ‘Allow shared
desktop’:

4.

In the ‘Hostname: display’ window enter the Vista IP (i.e. 192.168.0.68).

5.

Clear the entry in the box to the right of the IP (or enter 0)

6.

Click OK.. VNC will open the login window

7.

Enter your password and click OK (leave the username blank).

You should now be able to control the Vista.
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Appendix 5, Using serial communication
to control clips
You can activate and control clips by sending text commands via the serial
port on the Vista T or I series consoles.

Connecting to the serial port
The cable that connects from the triggering device to the Vista should be a
standard serial cable (also called a null-modem cable, or serial printer
cable), not a serial cable extension. The important feature is that that pin2 at
one end needs to be connected to pin 3 at the other end and vice-versa).
Tip:

These steps do not need to be repeated unless the console software is
completely re-installed using a restore CD or you forget the password.

Enabling the serial port
The computer or other device sending the trigger commands and the Vista
must have their serial ports set to match each other. To set the Vista serial
port select ‘User preferences’ from the Vista menu and click on the
‘General’ tab:

The serial port setting must be entered, without spaces, as follows: Data
bits, parity, stop bits, rate (baud).
For example: 8N1-9600 (. 8 data bits, no parity, 1 stop bit, 9600 baud)
By default, the serial port preferences are set to disabled.
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Command Syntax
All commands should be sent to the Vista as single lines of text followed by
Return or Enter.
The supported commands are:

•

go

•

rego

•

pause

•

release

•

load

You can also send commands to set Fixture levels in the Programmer . The
Syntax is:

•

{fixture id(s)} @ {level}

Where fixture ids is any combination of number, +, > and minus and level
is a value between 0 and 100 or just f (or F) for full.

Clip / Show command examples
•

go clip 1

•

rego clip 24

•

pause MyVerySpecialClip

•

release clip37

•

load showname.vst

Fixture intensity examples
•

1@F - fixture 1 to full

•

1>10-5 @ 75 - fixture's 1,2,3,4,6,7,8,9 & 10 to 75%

•

1>10-3>7@f – fixtures 1,2,8,9&10 to 100%

Serial command acknowledgements
Vista does not echo characters sent to the serial port but does send
acknowledgements to confirm that commands have been received and
either been accepted or have failed. There are three response types:
Commands that are understood and could be executed.

Successful commands return the complete command appended with
“OK”. For example
“go clip: 1” it would return “go clip: 1 OK”.
Commands that are understood but could not be executed.

If the command is good but the object of that command is not know an
error message will be returned. For example, if there was no Clip: 100
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Unknown Commands

If the command is not understand, the message “ ILLEGAL COMMAND”
is returned.

Notes
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•

Make sure that there is an end of line character (return or enter) at the
end of each command.

•

Commands and clip names are *not* case sensitive.

•

Spaces before or after commands and clip names do not affect the
behaviour.
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Appendix 6, Automating playback based
on the Date and Time
You can set Vista to automatically playback clips, trigger snapshots and
more based on the date and time.

Setting up date and time events
To set up events that will be triggered based on the date and time, choose
the ‘Date/Time events panel…’ option from the Vista menu. Vista opens
the Date/Time Events window:

This option…

does this…

New Event

Opens the ‘New Event’ window where you can
set up an event to be triggered based on the date
and time.

Delete

Deletes the selected event.

Modify

Opens the selected event so that you can modify
it’s settings.

Duplicate

Duplicated the selected event

Checkbox

If the checkbox, beside an event, is NOT ticked
the event will not be activated.

Global Enable

You can disable all date and time evemts by unchecking this box..
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Disabling all date and time events

You can also disable all date and time events by choosing the Disable All
Time/Date Events option from the Vista menu. This can be useful is you
want temporarily to stop events being triggered.

Creating a New Event
Date / Time events can automatically control playback and other action s.
To create a new event:
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1.

Choose the New Event... option from the Date/Time Events window.
Vista opens the New Event window:

2.

Select the command to insert from the Action column:

This option…

does this…

Go, Back, Halt,
Assert, Skip Fwd,
Skip Back,
Release,

Acts on the clip as if you had pressed the
corresponding button on the playback controls
for that clip.

Flash

Equivalent to pressing the flash button on a
clip’s playback controls. You must also enter
either ‘on’ to flash or ‘’off’ to flash in the
Parameter box.

Inhibit

Inhibits (blinds) or un-inhibits the clip. You
must enter either ‘on’ or ‘off’ in the Parameter
box.

Rate

The Parameter field is a text field and only
allows valid input (e.g. numerical BPM value).

Release All

Releases All active clips. No other options are
available when this command is selected.

Timecode reset

Resets the timecode to 00:00:00:00.
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This option…

does this…

Timecode enable

Sets a clip to be activated by Timecode.

Jump

Allows you to Jump to a specific step within a
clip.

Snapshot

Loads the snapshot selected in the Parameter
box

3.

Select the Clip to be triggered from the Clip column.

4.

Enter an on or off command or step number, if applicable, in the
Parameter field.

5.

Type a Name for the Event in the Label / Description box.

6.

If you want this event to run on every day of the week click the
‘Everday’ button. Otherwise tick the necessary days. Click the ‘Clear
button to un-check all days.

7.

Set the time of day, ti trigger the event, in the Trigger Time box. The
time is displayed as a 12 hour AM/PM clock.

8.

If you want an event to repeat periodically, check the Repeat box and
specify the number of times to repeat and the Interval (in minutes),
between repetitions.

9.

If you want an event to only be activated after a certain date. check the
Start Date box and specify the date when the event should first be
triggered.

10.

If you want an event to not be activated after a certain date. check the
End Date box and specify the date when the event should last be
triggered.

11.

Click the OK button to save the event.
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Appendix 7, The touchpad and the pen
tablet
Using the touchpad
Like all pointing devices, the touchpad may take a short time to get used to.
However you will soon find that using this device is natural and intuitive.
Simply glide your finger across the surface of the pad to move the cursor
and tap your finger to ‘click’. It's easy!
Click

To click, lightly and quickly tap the surface of the pad once. Or, press the
left button once.
To double-click, double tap on the pad or click the left button twice.

Remember, the touchpad responds best to a very firm, crisp tap.
Right Click

To right-click for submenus, tap the tap zone in the upper right corner of
the touchpad or click the right button once.
Drag

To drag, draw, or highlight, double-tap rapidly and hold your finger down
on the second tap, then glide to move. You may also hold the left button as
you glide your finger.

Glide Extend

To drag further than the pad surface, lift and reposition your finger after
reaching the textured edge. GlideExtend will virtually eliminate the edge of
the pad while you drag. In other words, if you are dragging an item and
you hit the textured edge, GlideExtend will hold the drag for three seconds
while you reposition to complete the drag. To shut off GlideExtend earlier
than three seconds, simply tap or click a button.
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Scroll

To scroll, place your finger down the right edge of the touchpad and glide
up or down. This feature requires third party software on Macintosh
systems (see Macintosh advanced features section for USB version of Easy
Cat).

Working with the grip pen
This information is kindly provided by Wacom, the pen tablet manufacturer.
As you work with the pen-tablet, you can rest your hand lightly on the
display screen, just as if it were a drawing board or sheet of paper. Hold the
Grip Pen as you would a pencil. Make sure the side switch is in a
convenient location where you can press it with your thumb or forefinger,
but won’t accidentally press it while drawing.

Tip:

The Grip Pen should never be stored in a container where it will rest on its
tip or eraser. When the pen is not in use, place your pen in the pen holder
or lay it flat on your desk.

Tip switch / Pen Tip
The pen is activated as soon as it enters proximity, about 5 mm (0.2 in),
above the Interactive Pen Display screen. This allows you to position the
screen cursor or use the DuoSwitch without touching the pen tip to the
display screen.
When pressure is applied to the pen tip, the tip switch is turned on and the
pen simulates a mouse button click.
Eraser

To use the eraser, hold the Grip Pen upside down. When the eraser is
within proximity of the active area, the tablet reports the pen coordinates
and the pressure applied to the eraser.
The eraser is not implemented in Version 1 of the Vista software.
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DuoSwitch

The DuoSwitch can be used to perform the same click and double-click
functions as the tip switch. Toggle the DuoSwitch in either direction to
activate the upper or lower button functions.
Tip: If you do not care to use the side switch, you can remove if by
following the directions in Removing and installing the Duo Switch.

Using a pen
Pointing and Selecting

Move the Grip Pen above the pen tablet display screen to position the
screen cursor. The cursor jumps to the location where you place the pen
(absolute positioning). Press the pen tip on the display screen to make a
selection.
Clicking

Tap the display screen once with the pen tip, or touch the pen to the
display screen with enough pressure to generate a mouse click.
Double-Clicking

Press the upper side switch, or quickly tap the display screen twice in the
same place with the pen tip. Double-clicking is easier when the pen is
perpendicular to the tablet screen.
Dragging

Select an object, then slide the pen tip across the display screen to move the
object.
Erasing

Erasing is not currently supported in the Vista system.

Working with the Pen tablet
As you work with the pen tablet, you can rest your hand lightly on the
display screen, just as if it were a drawing board or sheet of paper.
Because the drawing surface will be a little higher than a normal desk,
consider adjusting the height of you desk or chair to assure comfortable use
of the device.
When working with the pen tablet, maintain a good posture at all times
and change your position if you feel any discomfort due to your work
position or the weight of the tablet.
The Interactive Pen Display should be positioned so you can view it
comfortably with a minimum of eyestrain.

196

Vista User Guide, Version 1.13a

Appendix 7, The touchpad and the pen tablet

Using a pen

Here are some other points to keep in mind:

•

Take short breaks between tasks to stretch and relax your muscles.

•

Use a gentle grip when working with the pen.

•

Alternate tasks throughout the day.

•

Minimize awkward postures and repetitive movements that cause
discomfort.

Working with On Screen Display Settings
The pen tablet display is equipped with an On Screen Display function. The
OSD function enables you to adjust and optimize a variety of display
settings at the touch of a button. The OSD controls are located above the
tablet.

Selection buttons
Use these buttons to select an option that can then be activated when you
press the Enter button.
After activating a selected option, press the + button to increase a selected
item value, and press the button to decrease it.
The basic process for working with the OSD is as follows:

Tip:

1.

Press the Menu button to open the OSD main menu.

2.

Use the + or - buttons to select an option. When the option you want to
adjust is highlighted, press the Enter button. The current settings and
adjustment sub-menu for that option will appear.

3.

Use the + or - buttons to adjust the option settings.

4.

When you have made your changes, press the Enter button to save. To
exit, press the Menu button.

All settings are automatically saved when the OSD menu closes. If you
make changes to the display appearance and cannot return to the original
settings, use the Reset Recall option to return The pen tablet to its original
factory defaults.
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When you open the On Screen Display (OSD), the following menu options
are displayed:

Caring for the Cintiq pen tablet
Keep the Grip Pen and the Cintiq LCD screen surface clean. Dust and dirt
particles can stick to the pen and cause wear to the display screen surface.
Regular cleaning will help prolong the life of your LCD screen surface and
pen. Keep Cintiq and the Grip Pen in a clean, dry place and avoid extremes
in temperature.
Room temperature is best. Cintiq and the Grip Pen are not made to come
apart (except where specifically indicated for removal and replacement of
the pen’s DuoSwitch). Taking apart the product will void your warranty.
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Removing and installing the Duo Switch

Caution - If the pen tip becomes sharp or angular, it may damage the
coating on the display screen. Please replace the pen tip if necessary.

Cleaning the Pen-Tablet
To clean the Grip Pen, use a soft cloth and mild detergent (such as
dishwashing liquid) diluted with water. Do not use paint thinner, benzine,
alcohol, or other solvents.
To clean the display screen, use an anti-static cloth or a slightly damp
cloth. When cleaning, apply only a fixture amount of pressure to the
display screen and do not make the surface wet. Do not use detergent to
clean the display screen; this may damage the coating on the screen. Please
note that damage of this kind is not covered by the manufacturer’s
warranty.

Replacing the Pen Tip
The pen tip will wear with normal use. When the pen tip gets too short,
you can replace it with one of the extra tips that came with the pen.

To remove the old tip:

Clasp it with a pair of tweezers, needle-nosed pliers, or similar instrument
and pull the old tip straight out of the pen.
To insert a new tip:

Slide it straight into the barrel of the pen. Firmly push the tip until it stops.
The new tip will slide into the correct position.
If the pen tip wears and becomes angular, it may damage the coating on the
Pen tablet display screen. To avoid this, periodic tip replacement is
recommended.
WARNING Prevent children from swallowing the pen tip or side switch.
The pen tip or side switch may accidentally be pulled out if children are
biting on them.

Removing and installing the Duo Switch
Some users prefer to remove the DuoSwitch when working with the Grip
Pen. For example, you may want to remove the switch in order to focus on
a drawing and eliminate any accidental clicks that would occur if you
unintentionally pressed on the switch. Note, however, that removing the
DuoSwitch also removes the button functionality it offers. For most users it
is unnecessary to remove the DuoSwitch.
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Important: Do not remove the switch by prying it from either end as this
may damage your Pen. NEVER adjust the trimmer capacitor that will be
visible when the switch is removed. When using the pen without the
DuoSwitch, always replace the original rubberized grip with the optional
grip in order to protect the trimmer capacitor.
To remove the DuoSwitch:
1.

Firmly clasp the DuoSwitch in the middle and pull out. Press in on the
rubberized grip in order to better grasp the switch.

2.

Remove the pen tip cone by turning it counterclockwise. Then pull the
grip forward over the pen tip.

3.

Install the optional grip by aligning the pen case rails with the grooves
inside the grip and pushing the grip over the pen tip. Then replace the
pen tip cone by turning it clockwise onto the pen.

To Install the DuoSwitch:

200

1.

Remove the pen tip cone by turning it counterclockwise. Then pull the
grip forward over the pen tip.

2.

Install the original grip (the one with the DuoSwitch access slot) by
aligning the pen case rails with the grooves inside the grip and
pushing the grip over the pen tip. When properly positioned, the
DuoSwitch access hole will reveal the trimmer capacitor. Then install
the pen tip cone by turning it clockwise onto the pen.
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3.

Precautions on using and handling the Pen-Tablet

Align the DuoSwitch into place, making sure to match the switch
position to the grip molding. Then gently press in on the DuoSwitch
until it snaps into place.

Precautions on using and handling the Pen-Tablet
Temperature and Humidity
Operating temperature and humidity 5˚ to 35˚C, 20 to 80% RH
Storage temperature and humidity -10˚ to 60˚C, 20 to 90% RH
CAUTION. Do not use or store the pen tablet where:

•

Temperature changes are severe or exceed specifications (e.g.,
outdoors or inside a vehicle).

•

The pen tablet and the Grip Pen are exposed to direct sunlight or heat
from an appliance.

•

The pen tablet and the Grip Pen are exposed to water or any other
kind of liquid.

CAUTION. Do not use The pen tablet in a dusty environment; this may
damage the unit
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Handling
WARNING: If the LCD screen has been damaged, DO NOT touch any
liquid that may be leaking from it; this liquid is an irritant. In case of
contact with skin, eyes, or mouth, rinse immediately with running water
for at least 15 minutes or more. If contact is made with the eyes or mouth,
also consult a physician.
WARNING: Prevent children from swallowing the pen tip or side
switch. The pen tip or side switch may accidentally be pulled out if
children are biting on them.
CAUTION: Do not disassemble the Grip Pen. This may cause the device
to malfunction. In this case, Wacom shall have no responsibility to repair or
replace the product.
CAUTION: Do not scratch the display screen. Avoid placing sharp objects
on the display screen surface.
CAUTION: Avoid intensive shock or vibration to the pen tablet or the
Grip Pen. Hitting or dropping the pen tablet display may damage the
display screen or other components.
CAUTION: Do not put heavy articles on the Interactive Pen Display or
push against it with a strong force; this may damage the display screen or
bend the stand.
CAUTION: If the pen tip becomes sharp or angular, it may damage the
coating on the display screen. Please replace the pen tip if necessary.
CAUTION: Do not use any organic solvent (e.g., alcohol) or even mild
detergent to clean the display screen. Use of these cleaners can damage the
coating on the screen. Please note that damage of this kind is not covered
by the manufacturer's warranty.
To clean the display screen, use an anti-static cloth or a slightly damp cloth.
When cleaning, apply only a fixture amount of pressure to the display
screen and do not make the surface wet.
To clean the pen tablet casing or Grip Pen, use a soft cloth with mild
detergent (such as dish washing liquid) diluted with water.
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Power
T4 / T2 / I3

E2 / S3

S1

M1

Power
Requirements:

100VAC to 240VAC +/- 10%, 50-60 Hz

USB
powered

Power
Consumption:

400 Watts
max

2.5 Watts
max

Power
Connector:

IEC 3-pin

40 Watts
max

20 Watts
max

USB

Service & Maintenance
With care Vista products will require little or no maintenance. However,
the internal battery (in the T and I series only)will need to be replaced on a
regular basis (see the following section).
If the front panel requires cleaning, wipe with a mild detergent on a damp
soft cloth.
The CD drive mechanism battery (in the T4 / T2 console only) is
mechanical and should always be treated with care. Never allow the entry
of fluids into the slot.
DO NOT spray liquids onto the front panel.
DO NOT use solvents for cleaning the front panel.
Warning: Do not allow the entry of liquids of any sort into the console
chassis.
The T4 / T2 CPU tray should be periodically cleaned to ensure dust does
not build up near the fans.

Battery replacement
The Vista T and I series consoles have an internal battery that is used to
maintain system BIOS settings. The battery should last approximately 5
years from the date the battery was made. If the console reports BIOS check
errors, please return the console to an authorised agent for battery
replacement.
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Installation
Vista consoles and control surfaces must be installed in a location that
allows adequate ventilation around the rear of the product. There must be
at least 150mm of free space around the rear and sides of the console when
in use. Failure to allow adequate ventilation may result in premature
shutdown of the console.
An external UPS may be connected if mains blackouts are anticipated.

T4 / T2 / I3 Shut down
Always use the correct procedure to shut the console down. Select
‘Shutdown’ from the console menu.

General Specifications
Inputs & Outputs
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Description
DMX 512 (1-4)

Type
5 pin Female AXR

Ethernet
(100BaseT)

RJ-45

SMPTE
(Audio)

3 pin Female AXR

MIDI In

5 pin Female DIN

MIDI
Thru/Out

5 pin Female DIN

Pin Outs
1
2
3
4
5
1
2
3
4
5
6
7
8
1
2
3
1
2
3
4
5
1
2
3
4
5

Function
Shield
Data –
Data +
Data – (DMX 4 only)
Data + (DMX 4 only)
Transmit +
Transmit –
Receive +
Unused
Unused
Receive –
Unused
Unused
Shield
LTC –
LTC +
NC
Shield
NC
RX+
RXD
NC
Shield
NC
TX+
TXD
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Description
COM (RS232)

Type
9 pin D

Trigger In

6.5mm Jack Socket

Trigger Out

6.5mm Jack Socket

Video 1
Video 2

15 pin High
Density D

USB

Type A

Audio Mic

3.5mm Jack socket

Audio Out

3.5mm Jack socket

Audio Line In

3.5mm Jack socket

Desk Lamp 1
Desk Lamp 2
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Pin Outs
1
2
3
4
5
6
7
8
9
Tip
Sleeve
Tip
Sleeve
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
1
2
3
4
Tip
Sleeve
Tip
Ring
Sleeve
Tip
Ring
Sleeve
1
2
3

Function
DCD
RXD
TXD
DTR
Gnd
DSR
RTS
CTS
RI
Trigger In
Ground
Trigger Out
Ground
Red
Green
Blue
NC
Ground
Red Ground
Green Ground
Blue Ground
Vcc
Sync Ground
NC
VD Data
Horizontal sync
Vertical sync
VD Clock
Vcc
Data –
Data +
Ground
Signal
Shield
Left
Right
Shield
Left
Right
Shield
Chassis
Lamp –
12V
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Index
A
About Vista window, 166
Activate on flash, 165
Active HTP, 165
adding
events to the timeline, 68
fixtures with same ID, 17
Advanced Properties, 22
aligning
start and end points, 61, 74
applying
saved sort methods, 116
applying extracts, 92
arranging extracts, 93
arranging the quickpicker, 56
ArtNet
Broadcast Mode, 29
compatible devices, 27
assigning
audio to a clip, 117
attributes
selecting events by, 96
audio
assigning to a clip, 117
Audio Volume, 160
Auto, 33
Auto blind Live Tab, 163
Auto-go when paged in, 165
automated playback, 191
Auto-save interval, 159
Auto-save prompt, 160

B
Background click deselects fixtures, 163
backup
shows, 6
backups
exporting shows (backing up), 7
battery, 203
beam, 44
setting, 43
blind, 95
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blocking
include all tracked events in a step’, 91
bottom pane of a layout, 34

C
calibrating the pen, 167
canned effect
applying, 100
chaining events, 74
changes history, 118
changing
colours, 124
console configuration, 167
fonts, 124
single steps, 90
universes, 15
Channels, 21
chase tab, 142
checking that your fixtures are working,
38
clip
assigning audio to, 117
block step, 91
creating, 68
ganging to synchronise playback, 118
grabbing, 95
modify steps, 80
moving around in, 66
moving events around, 69
moving tracks between, 117
playback control window, 120
playing, 66
preferences, 164
progress indicator, 67, 81
properties, 140
selection handles, 70
timeline and, 59
using commands within, 94, 192
view step list, 80
Clip pane, 120
clips, 59
cloning fixtures, 25
CMY, 42
colour
changing, 124
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setting, 41
colour wheel, 42
commands
within clips, 94, 192
components
assigning to controls, 134
organising, 148
Components window, 148
connecting to the console via FTP, 182
console
configuration, changing, 167
configuring the console, 48, 129, 133
layout, 126
modifier keys, 128
output, grabbing, 95
pages, 144
snapshots, 145
contrast, setting for desklights and LCDs,
166
Control menu, 170
controls
effects, 106
converting
markers to steps, 86
copying
the swing start or end setting, 103
using drag and drop to copy steps, 83
creating
a show, 5
clips, 68
extracts, 91
groups, 50, 54, 55
presets, 52
Crossfade HSV fast, 162
customising
preferences, 158
the Playback control window, 124

D
Date & Time events, 191
date and time, 168
Deactivate on flash, 165
Default colour mechanism, 162
Default Crossfade Time, 166
Default end-of-step action, 166
default settings, 159
Default Step Duration, 166
Default Step Increment, 163
Default Step Name, 163
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deleting
fixtures, 20
layout views, 34
shows, 8
desk lights, 3
Desklight & LCD Contrast settings, 166
Disabled Programmer Intensity Faders,
163
disconnecting
an interface box, 29
Display Raw channels in percent, 164
Display values above controls, 164
DMX window features, 156
DMX Window, using, 155
DMXinterface
configuring, 27
dousing a fixture, 23
dual gobo, 45
duplicating
layout views, 34

E
Edit menu, 169, 172
editing
extracts, 93
in the Playback control window, 124
editor
preferences, 161, 162
effects, 102
applying canned effects, 100
controlling, 106
merging, 104
modifying, 104
reviewing, 105
saving, 104
splitting, 104
swinging between two presets, 101
using, 100
Enable Pen-tip button, 159
Ethernet-DMX interface
changing settings of, 29
configuring, 27
connecting, 27
disconnecting, 29
setting the port, 27
event bars, 60, 61
events
aligning start and end points, 61, 74
chaining, 74
convert to raw, 75
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Index

fade path, 74
pre-determining event lengths, 80
selecting by attribute, 96
selection handles, 70
steps, 78
trim unselected, 91
expanding playbacks, 135
exporting shows, 7
external displays, 3
external window utility, 168
extracts
applying extracts, 92
arranging extracts, 93
creating and applying extracts, 91
creating extracts, 91
editing, 93

F
Fade all attributes, 165
fade path, setting, 74
Fade-in time, 166
fanning, 52
favourites
adding fixtures to, 15
feature
summarise by, 63
filters
choosing, 65
creating custom filters, 65
deleting, 65
fine mode, 48
Fixture, 21
Fixture Id, 21
fixture library, changing, 168
Fixture Name, 21
Fixture Type, 21
fixtures
adding a colour or gobo, 23
adding to groups, 50
adding to the patch panel, 11
arranging fixtures in a layout, 31
checking that your fixtures are working,
38
choosing, 10
choosing by manufacturer, 10
cloning, 25
controlling, 23
defining favourites, 15
deleting, 20
dousing, 23
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Fixtures screen, 30
hiding and ‘unhiding’ fixtures, 34
import patch from CSV, 26
parking, 23
patching, 10
properties, 20
putting into the pool, 18
rearranging on the patch panel, 15
renaming, 16
renumbering, 17
resetting, 23
selecting, 155
selecting subsets, 113
sending to home, 23
setting up your fixtures, 30
short names, 16
sorting, 113, 115
striking, 23
summarise by, 64
swapping, 19
swapping types, 18
with same ID, 17
Flash level, 165
focus, 44
fonts
changing, 124
framing, 46
Free, 33
frost, 44
FTP
connecting via, 182
function keys
assigning, 126

G
ganging, 114
clips to synchronise playback, 118
gels
manufacturer, 42
general tab, 140
generic fixture model, 1
gobo, 44
dual, 45
setting, 43
grabbing clips, 95
Grid, 33
grouping groups, 51, 55, 151
groups
adding fixtures to, 50
creating, 50, 54, 55
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grouping, 51, 55, 151

H
hardware, 126
Hide Inapplicable Events, 163
hiding
fixtures, 34
history, 118
home
setting a fixture to, 23
Horizontal Spacing, 33
HSV, 41
HTP Intensity, 165
hue, 41

I
IDs, 33
importing shows, 6
Inhibit Inapplicable Events, 163
inputs & outputs, 204
inserting
a ‘Mark’ step, 88
installation, 204
installing
software updates, 181
intensity
palette, 38
setting, 38
Intensity, 21
Invert pan, 21
Invert tilt, 21
IP Address, 161
IP Gateway, 161
IP Net mask, 161
iris, 44

J
jump
using the keyboard, 132

K
keypad
in the programmer, 99

L
labels
adding to the layout window, 35
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language, setting, 168
layout
adding labels, 35
arranging fixtures in, 31
bottom pane of, 34
different views, 31
layout view
arranging, 34
bottom pane display, 34
deleting, 34
duplicating, 34
layout window
adding labels to, 35
arranging fixtures, 35
grid, 35
LCDs
screensaver, 168
learn timing
adjusting step markers, 87
learning actions, 95
Lee swatchbook, 42
library, changing the fixture library, 168
Limit, 21
list view, 24
Live Time, 57
Live Time Window, 57
loading
existing shows, 5
Lock, 33

M
Maintain state, 165
managing steps in the Step list view, 80
manufacturer
choosing a fixture by, 10
gels, 42
mark step
inserting, 88
markers
adding to the timeline, 86
convert to steps, 86
removing, 86
Maximise windows, 160
menu
Control menu, 170
Edit menu, 169, 172
Patch screen menus, 169
Programmer screen menus, 171
Session menu, 171
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Step menu, 173
Tools menu, 174
View menu, 169, 176
menu reference, 169
merging
effects, 104
modifier keys, 128
modifying
effects, 104
monitoring, 152
monitoring active clips, 120
monitors
resetting windows, 168
move or copy steps, 82
moving
events around, 69
fixtures around the patch panel, 15
tracks to another clip, 117

N
Name, 33, 165
names
renaming fixtures, 16
short fixture names, 16

O
Offset, 22
organising
components, 148
Orientation, 21
output
DMX Window, 155
using the the output window, 153
output window
chosen clip, 153
context menu, 154
rate, 153
sorting the Fixture List, 153
outputs & inputs, 204

P
Page controls, 129
pages, 144
palettes
live time, 57
palettes, 36
common features of the palettes, 36
parameters
fine mode, 48
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park
fixtures, 23
password-protecting shows, 6
patch
importing a CSV file to, 26
viewing in different ways, 24
patch panel
adding the fixture to the patch panel, 11
moving fixtures around, 15
rearranging fixtures on, 15
patch screen, 23
menus, 169
toolbar, 177
patching
adding fixtures to the patch panel, 11
adding fixtures to the rig, 10
by manufacturer, 10
complete fixture list, 10
patching your rig, 9
pen, 194
calibrating, 167
Pen tablet module, 126
percentage
intensity, 40
playback
assigning components to controls, 134
status indication, 138
playback buttons
assigning functions, 135
group masters, 143
Playback Control Window, 120
Playback mode, 166
Playback rate %, 166
playbacks
expanding, 135
standard and split modes, 134
with faders, 129
without faders, 129
playbacks, updating, 54
pool
putting fixtures into the pool, 18
position
setting, 38, 39
power, 3
Prefer Fixed, 41
Prefer Mixer, 41
preferences
clip, 164
editor, 161, 162
general, 159
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setting, 158, 159
preferred mode, 41
Preheat, 21
presets
availability, 56
presets
creating, 52
labels, 56
quick picker, 56
presets
live time, 57
presets
swinging between, 101
presets, updating, 97
Preview Fixtures, 163
Priority, 165
prism, 44
programmer
storing to a clip, 75
Programmer priority, 163
Programmer screen menus, 171
Programmer screen toolbar, 178
programmer, using the keypad, 99
progress indicator, 67, 81
properties
fixtures, 20
setting clip properties, 140

Q
Quick Picker, 56
quickpicker
arranging, 56

R
raw
beams and gobos, 47
colour, 43
convert events to, 75
setting raw intensity and position
values, 40
setting transparent, 47
reinstall software, 181
Release (Fade-out) time, 166
Release all, 5
Release when overriden, 165
Release-all on page change, 160
remote control, 186
removing
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markers, 86
renaming
fixtures, 16
renumbering
fixtures, 17
resetting windows on external monitors,
168
rest
fixtures, 23
Restore Defaults, 33
reviewing effects, 105
RGB, 42
right-click
using the LR button, 128
rotation, 46

S
saturation, 41
saving
copies of shows, 6
effects, 104
password-protecting, 6
shows, 5
sort configurations, 116
sort methods, 116
screensaver, 168
Screensaver wait time, 160
selecting
events by attribute, 96
subsets of fixtures, 113
selection handles, 70
serial control, 188
Serial Port, 160
service & maintenance, 203
Session menu, 171
set timing window, using, 73
setting
language, 168
setting
colour, 41
preferences, 158
setting clip properties, 140
setting intensity and position, 38
setting preferences, 159
setting up
fixtures, 30
short names
for fixtures, 16
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show
backup, 6
creating a show, 5
deleting, 8
exporting shows (backing up), 7
importing shows, 6
loading existing shows, 5
password-protecting, 6
saving, 5
saving copies of, 6
Show Grid, 33
shutters, 46
Skip state in jumps, 165
slider
intensity values, 39
SMPTE, 158, 159
snapshots, 145
software updates, 181, 184
installing, 181
software version, 166
sort configurations
saving, 116
sort methods
applying, 116
saving, 116
sorting
fixtures, 115
fixtures in the timeline, 113
the Fixture List, 153
specifications, 204
split modes, 134
Split Step Creation, 163
splitting
effects, 104
splitting steps, 85
standard mode, 134
Step Label Format, 163
Step menu, 173
Step pane, 121
steps
block, 91
chaning single steps, 90
end of, 79
inserting a mark step, 88
managing in list view, 80
move or copy, 82
pre-determining event lengths, 80
setting the ‘end of step’ instructions, 79
splitting steps, 85
step list view, 80
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using drag and drop to copy steps, 83
working with, 78
Sticky windows, 160
storing
from the live programmer, 75
modulating effects, 101
swinging effects, 101
Strike Macro Minimum interval, 160
striking a fixture, 23
Subdivisions, 33
subsets of fixtures, 113
subsets of fixtures, selecting, 113
summary
by feature, 63
by fixture type, 64
no summary view, 64
summary views, 62
Super Playbacks controls, 130
Swap pan/tilt, 21
swapping
fixture types, 18, 19
swing
making an effect swing, 103
swing start or end setting, copying, 103
swinging
between presets, 101
Symmetrical, 22
synchronise playback by ganging clips,
118

T
table view, 24
technical information, 203
time and date, 168
timecode, 158, 159
timecode tab, 142
timeline
about, 59
adding events to, 68
adding markers to the timeline, 86
aligning start and end points, 61, 74
end of event commands, 79
event bars, 60, 61
fade path, 74
learn timing, 87
moving events around, 69
steps, 78
zooming in and out, 67
timing
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adjustments, 72
using the set timing window, 73
toolbar
Patch screen, 177
Programmer screen, 178
Toolbar, 177
toolbar reference, 169
Tools menu, 174
touchpad, 194
tracks
mvoing between clips, 117
transformers, 22
transparent
raw setting, 47
trigger clip, 188
trim
remove unselected events’, 91
tutorials, 110

U
universes
changing, 15
update software, 181, 184
updating
live playbacks, 54
presets, 97
USB interfaces, 27
user preferences, 158
user preferences, setting, 159
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using effects, 100

V
version of software, 166
Vertical Spacing, 33
view
the rig, 24
using different views, 31
View menu, 169, 176
viewing
patch in different ways, 24
views
list view, 24
table view, 24
vnc, 186
VNC Password, 161

W
Wheel Sensitivity, 163
windows
resetting on external monitors, 168
WYSIWYG host address, 161

Z
zoom, 44
Zoom, 33
zooming in and out, 67
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